This documentation, which includes embedded help systems and electronically distributed materials, (hereinafter referred to as the “Documentation”) is for your informational purposes only and is subject to change or withdrawal by CA at any time.

This Documentation may not be copied, transferred, reproduced, disclosed, modified or duplicated, in whole or in part, without the prior written consent of CA. This Documentation is confidential and proprietary information of CA and may not be disclosed by you or used for any purpose other than as may be permitted in (i) a separate agreement between you and CA governing your use of the CA software to which the Documentation relates; or (ii) a separate confidentiality agreement between you and CA.

Notwithstanding the foregoing, if you are a licensed user of the software product(s) addressed in the Documentation, you may print or otherwise make available a reasonable number of copies of the Documentation for internal use by you and your employees in connection with that software, provided that all CA copyright notices and legends are affixed to each reproduced copy.

The right to print or otherwise make available copies of the Documentation is limited to the period during which the applicable license for such software remains in full force and effect. Should the license terminate for any reason, it is your responsibility to certify in writing to CA that all copies and partial copies of the Documentation have been returned to CA or destroyed.

TO THE EXTENT PERMITTED BY APPLICABLE LAW, CA PROVIDES THIS DOCUMENTATION “AS IS” WITHOUT WARRANTY OF ANY KIND, INCLUDING WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR NONINFRINGEMENT. IN NO EVENT WILL CA BE LIABLE TO YOU OR ANY THIRD PARTY FOR ANY LOSS OR DAMAGE, DIRECT OR INDIRECT, FROM THE USE OF THIS DOCUMENTATION, INCLUDING WITHOUT LIMITATION, LOST PROFITS, LOST INVESTMENT, BUSINESS INTERRUPTION, GOODWILL, OR LOST DATA, EVEN IF CA IS EXPRESSLY ADVISED IN ADVANCE OF THE POSSIBILITY OF SUCH LOSS OR DAMAGE.

The use of any software product referenced in the Documentation is governed by the applicable license agreement and such license agreement is not modified in any way by the terms of this notice.

The manufacturer of this Documentation is CA.

Provided with “Restricted Rights.” Use, duplication or disclosure by the United States Government is subject to the restrictions set forth in FAR Sections 12.212, 52.227-14, and 52.227-19(c)(1) - (2) and DFARS Section 252.227-7014(b)(3), as applicable, or their successors.

Copyright © 2011 CA. All rights reserved. All trademarks, trade names, service marks, and logos referenced herein belong to their respective companies.
This document references the following CA Technologies products:

- CA ERwin® Data Modeler Standard Edition
- CA ERwin® Data Modeler Workgroup Edition
Contact CA Technologies

Understanding your Support

Review support maintenance programs and offerings.

Registering for Support

Access the CA Support online registration site to register for product support.

Accessing Technical Support

For your convenience, CA Technologies provides easy access to "One Stop" support for all editions of CA ERwin Data Modeler, and includes the following:

- Online and telephone contact information for technical assistance and customer services
- Information about user communities and forums
- Product and documentation downloads
- CA Support policies and guidelines
- Other helpful resources appropriate for your product

For information about other Home Office, Small Business, and Enterprise CA Technologies products, visit http://ca.com/support.

Provide Feedback

If you have comments or questions about CA Technologies product documentation, you can send a message to techpubs@ca.com.

If you would like to provide feedback about CA Technologies product documentation, complete our short customer survey, which is also available on the CA Support website, found at http://ca.com/docs.

CA ERwin Data Modeler News and Events

Visit www.erwin.com to get up-to-date news, announcements, and events. View video demos and read up on customer success stories and articles by industry experts.
# Contents

## Chapter 1: Overview and Installation

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database Design Overview</td>
<td>11</td>
</tr>
<tr>
<td>Overview</td>
<td>11</td>
</tr>
<tr>
<td>Before You Install</td>
<td>12</td>
</tr>
<tr>
<td>Install CA ERwin Data Modeler</td>
<td>13</td>
</tr>
<tr>
<td>License Information</td>
<td>14</td>
</tr>
</tbody>
</table>

## Chapter 2: Basic Concepts and Features

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Application Development Cycle</td>
<td>15</td>
</tr>
<tr>
<td>Basic Data Modeling Concepts</td>
<td>15</td>
</tr>
<tr>
<td>Model Types</td>
<td>16</td>
</tr>
<tr>
<td>Entities</td>
<td>17</td>
</tr>
<tr>
<td>Tables</td>
<td>18</td>
</tr>
<tr>
<td>Attributes and Columns</td>
<td>19</td>
</tr>
<tr>
<td>Primary Key and Non-Keys</td>
<td>20</td>
</tr>
<tr>
<td>Foreign Key</td>
<td>20</td>
</tr>
<tr>
<td>Relationships</td>
<td>21</td>
</tr>
<tr>
<td>Create a Model</td>
<td>23</td>
</tr>
<tr>
<td>Name Your Model</td>
<td>23</td>
</tr>
<tr>
<td>Add Entities</td>
<td>24</td>
</tr>
<tr>
<td>Edit an Entity Name</td>
<td>24</td>
</tr>
<tr>
<td>Add Attributes</td>
<td>25</td>
</tr>
<tr>
<td>Create Relationships</td>
<td>25</td>
</tr>
<tr>
<td>Save Your Model</td>
<td>26</td>
</tr>
<tr>
<td>Enhance Your Data Model</td>
<td>27</td>
</tr>
<tr>
<td>Graphic Features</td>
<td>27</td>
</tr>
<tr>
<td>Objects Can Inherit Color</td>
<td>28</td>
</tr>
<tr>
<td>The Theme Editor</td>
<td>29</td>
</tr>
<tr>
<td>Add an Annotation</td>
<td>36</td>
</tr>
<tr>
<td>Resize a Box</td>
<td>37</td>
</tr>
<tr>
<td>Object Arrangement</td>
<td>37</td>
</tr>
<tr>
<td>Drawing Objects</td>
<td>39</td>
</tr>
<tr>
<td>Add Drawing Objects to a Data Model</td>
<td>39</td>
</tr>
<tr>
<td>Print a Model</td>
<td>42</td>
</tr>
<tr>
<td>Specify General Page Setup Options</td>
<td>43</td>
</tr>
<tr>
<td>Save Your Page Setup Selections</td>
<td>44</td>
</tr>
</tbody>
</table>
Chapter 3: Understanding the Workplace

Toolbars .................................................. 49
  Alignment Toolbar ........................................ 50
  Display Toolbar ............................................ 50
  Database Toolbar .......................................... 51
  Drawing Toolbar ........................................... 51
  Formatting Toolbar ........................................ 52
  Layout Toolbar ............................................. 52
  Model Manager Toolbar ................................... 53
  The ERwin Toolbox ........................................ 54
  The Standard Toolbar ...................................... 54
  Transformations Toolbar ................................... 54
  Zoom Toolbar .............................................. 55

Workplace Panes ........................................... 55
  Model Explorer ............................................ 57
  Action Log ................................................. 66
  Advisories Pane ........................................... 77
  Overview Pane ............................................ 77
  Bulk Editor Pane .......................................... 78

Property Editors ........................................... 84
  Property Editor Navigation Grid .......................... 84
  Property Editor Toolbar ................................... 84
  Property Editor Tabs and Options ........................ 85
  Property Inheritance Features for Modeling Objects .... 86

Chapter 4: Working with Data Models

Domains .................................................. 89
  Domain Editor ............................................. 90
  Inherited and Non-inherited Domain Properties .......... 91
  Attributes and Columns in Domains ........................ 91
  Drag a Domain from the Model Explorer to Your Model ........................................... 91
  Creating New Domains ..................................... 91
  Assign a Data Type to a Domain ........................... 94
  Domain Icons ............................................. 95
  Assign or Change a Domain Icon ........................... 95

Relationships ............................................. 96
  Entity Relationships ....................................... 96
Other Relationship Types ........................................................................................................ 97
Relationship Creation .................................................................................................................. 98
Relationship Lines ...................................................................................................................... 98
Relationship Editor ...................................................................................................................... 98
Verb Phrases .................................................................................................................................. 99
Views .......................................................................................................................................... 101
Methods for Adding a View to a Model .................................................................................... 102
Display Levels .............................................................................................................................. 102
Logical Display Levels .............................................................................................................. 102
Physical Display Levels ............................................................................................................ 104
Subject Areas ............................................................................................................................... 105
Subject Area Members ................................................................................................................ 105
Subject Areas in the Logical/Physical Model ........................................................................... 106
The Subject Area Editor ............................................................................................................. 106
Create a New Subject Area in the Subject Area Editor ............................................................ 106
Subject Areas in the Model Explorer ....................................................................................... 109
Index Tables ............................................................................................................................... 109
Types of Indexes ......................................................................................................................... 110
Unique and Non-Unique Indexes ............................................................................................... 110
The Table Index Editor ............................................................................................................. 112
Create an Index in the Table Index Editor ................................................................................ 112
Find and Replace ....................................................................................................................... 114
Forward Engineering ................................................................................................................... 115
Preview Schema Generation ...................................................................................................... 116
Change Schema Generation Options ....................................................................................... 117
Generate the Schema .................................................................................................................. 119
Save the Script File .................................................................................................................... 120
Generate Alter Scripts ................................................................................................................ 120

Chapter 5: Working with Data Design Features .................................................................. 121
Reverse Engineering .................................................................................................................. 121
Database Connection Overview ............................................................................................... 122
Template Selection .................................................................................................................... 123
Options for Reverse Engineering ............................................................................................ 123
Set Model Type, Template, and Database For Reverse Engineer ........................................... 124
Set Options for Reverse Engineer ........................................................................................... 125
How to Use the Metadata Integration Wizard .......................................................................... 127
Set Options for Import from External Format ........................................................................... 128
Set Options for Export to External Format .............................................................................. 130
Complete Compare ................................................................................................................... 131
The Complete Compare Wizard .............................................................................................. 132
How Model Selection Works ................................................................. 132
Load a Model as Read-Only ................................................................. 134
Allow Demand Loading ................................................................. 134
Type Selection Compare Levels ......................................................... 135
Refine the Criteria for Object Comparison ........................................ 137
Filter By Owner Name ......................................................................... 138
Advanced Options ................................................................................. 139
Resolve Differences .............................................................................. 142
Resolve Differences Dialog ................................................................. 143
Comparison Results .............................................................................. 148
Resolve Actions ...................................................................................... 148
Save a Complete Compare Snapshot .................................................... 149
Generate an Alter Script ......................................................................... 151
Save Your Models .................................................................................. 152
Additional Complete Compare Functionality ........................................... 152

Chapter 6: Report on Your Data Model 157
The Query Tool ...................................................................................... 157
Create a Query ......................................................................................... 158
Open a Query .......................................................................................... 158
Save a Query ........................................................................................... 159
Execute a Query ....................................................................................... 159
Execute a Query Against a Database ..................................................... 160
Execute a Query Against ERwin ODBC ................................................ 160
Use Crystal Reports With CA ERwin Data Modeler .................................. 161
Using the Bulk Editor to Create a Report ................................................ 162
Generate a Diagram Picture ..................................................................... 165

Chapter 7: Working with Design Layers 167
Design Layers .......................................................................................... 167
Design Layer Hierarchy .......................................................................... 168
New Design Layers .................................................................................. 170
Transformations ......................................................................................... 176
Preserve Model History ............................................................................ 191

Chapter 8: Naming and Datatype Standards 195
The Model Naming Options Dialog ......................................................... 195
The Naming Standards Editor ................................................................... 196
Object Name Syntax .................................................................................. 197
Object Names Glossary ............................................................................ 197
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save a Naming Standards File</td>
<td>197</td>
</tr>
<tr>
<td>Check Name Compliance in a Model</td>
<td>198</td>
</tr>
<tr>
<td>Name Hardening Wizard</td>
<td>199</td>
</tr>
<tr>
<td>Override Name Inheritance</td>
<td>201</td>
</tr>
<tr>
<td>Unharden Object Names</td>
<td>202</td>
</tr>
<tr>
<td>Data Type Standards</td>
<td>202</td>
</tr>
<tr>
<td>The Datatype Standards Editor</td>
<td>203</td>
</tr>
<tr>
<td>Create a Data Type Mapping List</td>
<td>203</td>
</tr>
<tr>
<td>Save a Data Type Mapping File (.dsm)</td>
<td>204</td>
</tr>
<tr>
<td>The Model Datatype Options Dialog</td>
<td>204</td>
</tr>
<tr>
<td>Attach a Data Type Standards File to a Model</td>
<td>205</td>
</tr>
<tr>
<td>Data Type Standards Reuse</td>
<td>205</td>
</tr>
</tbody>
</table>

**Appendix A: Third-Party Acknowledgements**  

**Appendix B: Supported Metadata Integration Bridges**  

Table of Supported Bridges  

**Index**
Chapter 1: Overview and Installation

This section contains the following topics:

- Database Design Overview (see page 11)
- Overview (see page 11)
- Before You Install (see page 12)
- Install CA ERwin Data Modeler (see page 13)
- License Information (see page 14)

Database Design Overview

Welcome to CA ERwin Data Modeler (CA ERwin DM), the database design tool that raises the level of data quality in transactional and data warehouse systems. It provides the tools to design and implement databases for transactional business, E-commerce, and data warehousing applications.

You can create and maintain graphical models that represent databases, data warehouses, and enterprise data models. CA ERwin DM provides a modeling platform where corporate data requirements and related database designs can be defined, managed, and implemented across a wide variety of database platforms.

A Windows-based graphical user interface is combined with powerful entity-relationship (ER) diagramming tools, custom editors to define physical database objects, a Model Explorer for a text-based view of model objects, and support for leading SQL and desktop databases.

You can also use CA ERwin DM to streamline the application development process, by allowing different groups (Standards Administrators, Business Analysts, Data Modelers, and so on) to perform work independently, while collaborating and synchronizing. In this way, different groups can simultaneously work on various parts of a model or different model types.

Overview

CA ERwin DM combines a Windows-based graphical user interface with entity-relationship (ER) diagramming tools, and numerous innovative features. These features allow you to easily create and maintain your relational database and the logical and physical models that describe it. CA ERwin DM works by providing a design solution that helps you create a visual blueprint (a data model) for your organization.
Before You Install

CA ERwin DM is much more than a drawing tool. It not only helps you design a logical data model, which captures business rules and requirements, but it also supports the design of a corresponding physical data model for your target server. This enables you to forward engineer this physical data model and automatically generate physical database structures to your system catalog.

CA ERwin DM supports reverse engineering of existing databases and provides both a physical and logical/physical data model so you can maintain an existing database, or migrate from your current target server to a different one.

The Complete Compare technology automates model and database synchronization by letting you compare the model with the database, displaying, and analyzing the differences. This enables you to selectively move the differences into the model or generate them into the database.

Before You Install

Review the hardware and software requirements and the list of supported target databases in the Release Notes before you begin the installation.

Administrative Privileges Required for Installation

Because the installation process for CA ERwin Data Modeler writes to the registry and system folders, the person installing, upgrading, or removing CA ERwin Data Modeler must have Administrative privileges. If you run an installation without Administrative privileges, all files may not be installed or upgraded, and users will encounter problems when running the software.
Install CA ERwin Data Modeler

The Installation Wizard makes it easy for you to install, change, or remove CA ERwin Data Modeler.

To install CA ERwin Data Modeler

1. Insert the installation DVD or double-click the file you downloaded from the online CA product page.
   The Installation Wizard opens.

2. Follow the prompts in the wizard to proceed. If you install from the DVD, you are prompted to select the applications you wish to change or install. Click Next.
   A License Agreement opens for you to review.

3. Select the option to accept the terms as described in the License Agreement. Click Next.
   The wizard asks a series of questions you must answer, including:
   - Customer Information
   - Destination folder for the CA ERwin DM files

4. On the Custom Setup Type screen, review the program features that will be installed. You can also evaluate the space needed to install each feature.
   Click Next to continue and then click Install to start the installation.
   The program files are copied.

If you have not already licensed CA ERwin Data Modeler, you can license the program when the install process is complete. Follow the on-screen prompts to open the License Verification dialog and enter the license key provided with the product CD.
License Information

When you launch CA ERwin Data Modeler r8 for the first time, the Community Edition of this product opens. If you have purchased an entitlement for one of the other available editions, you must generate the license in order to use that edition.

Follow this process to obtain your license:

1. Click Licensing on the Help menu.
   The Licensing dialog opens displaying the MAC addresses discovered on your machine.
2. Select the appropriate MAC address, ensuring you do not use the MAC address of an adapter located in a docking station or an external hard drive, and click Close.
3. Contact CA ERwin Data Modeler support with your MAC address to receive your permanent license files.
4. Copy your license files locally on your machine as follows:
   - **For Windows XP**
     ```plaintext
     C:\Documents and Settings\<user name>\Local Settings\Application Data\CA\ERwin Data Modeler\8.0
     ```
   - **Important!** Ensure hidden files and folders display in Windows Explorer or you will be unable to locate this directory. If you cannot locate this directory in Windows Explorer, select Folder Options on the Tools menu and click the View tab. In Files and Folders under Advanced settings, select the Show hidden files and folders option. Click the Apply to All Folders button, click Apply, and click OK.
   - **For Windows 7**
     ```plaintext
     C:\Users\<user name>\AppData\Local\CA\ERwin Data Modeler\8.0
     ```

   **Note:** If you need assistance with licensing, you can open an issue online at the CA ERwin Data Modeler support site.
Chapter 2: Basic Concepts and Features

This section contains the following topics:

- The Application Development Cycle (see page 15)
- Basic Data Modeling Concepts (see page 15)
- Create a Model (see page 23)
- Enhance Your Data Model (see page 27)
- Print a Model (see page 42)

The Application Development Cycle

Most data modeling solutions begin with the gathering of business rules and creating logical constructs and continues to the physical design phase followed by the implementation of a database that supports one or more applications. CA ERwin DM supports this iterative process by supporting multiple platforms, reuse of objects, and the ability to synchronize changes between data models across the enterprise.

Basic Data Modeling Concepts

Before creating or working with data models, there are some basic data modeling concepts that you must be familiar with. These concepts include:

- Model Types
- Entities
- Tables
- Attributes and Columns
- Primary Key
- Relationships
- Foreign Key
Model Types

Multiple model types allow data modelers or data analysts to work with the models best suited for their needs. The following model types are available:

Logical

A conceptual model that contains objects such as entities, attributes, and key groups.

Physical

A database-specific model that contains objects such as tables, columns, and data types.

Logical/Physical

A single model that includes both the logical and physical models.
Entities

An entity is a logical object that represents a person, place, or thing about which an organization maintains information.

In the following diagram, the logical data model has the following entities:

- CUSTOMER
- EMPLOYEE
- MOVIE
- MOVIE COPY
- MOVIE RENTAL RECORD
- PAYMENT
- STORE
Tables

In the logical model, an entity usually corresponds to a table in the physical model. In the physical model, a graphic box represents a table in which data is stored in the database.

**Customer Table in ERwin**

```
CUSTOMER
  cust_no
  name
  address
```

**Customer Table in the database**

<table>
<thead>
<tr>
<th>cust_no</th>
<th>name</th>
<th>address</th>
</tr>
</thead>
<tbody>
<tr>
<td>1234</td>
<td>Brown</td>
<td>6 Main St.</td>
</tr>
<tr>
<td>2345</td>
<td>Jones</td>
<td>128</td>
</tr>
<tr>
<td>3456</td>
<td>Smith</td>
<td>77</td>
</tr>
</tbody>
</table>

Types of Entities/Tables

Two types of entities/tables can be drawn in a data model:

**Independent Entity**

An entity whose instances can be uniquely identified without determining its relationship to another entity. It is represented as a box with square corners.

**Dependent Entity**

An entity whose instances cannot be uniquely identified without determining its relationship to another entity or entities. It is represented as a box with rounded corners.
When you add an entity, the entity type is determined based on the relationship in which it is involved. For example, when you initially place an entity in a model, it is represented as an independent entity. When you connect the entity to another entity using a relationship, it is determined if the entity is independent or dependent based on the relationship type.

**Attributes and Columns**

After you have discovered the people, places, and events that define the entities in your model, you can begin to define the attributes for each entity.

Attributes collect information about an entity and columns collect information about a table. Logical attributes usually correspond to physical columns in a table.

For example, after you create the CUSTOMER entity, you can begin to define the individual pieces of information you want to track for each customer, including Name, Address, and Phone Number. In the logical model, each of these pieces of information is saved as an attribute of the CUSTOMER entity. In the physical model, attributes equate to columns in a table.

**Note:** A row of data is inserted in a table when a record is added to the database directly or through an application.

After you create an entity or table, you can add attributes and columns, respectively.

Many easy methods for creating and modifying the properties of these objects are provided. The most basic method is to add the name directly in the Diagram Window. You can also use a domain to add attributes and columns.
**Primary Key and Non-Keys**

Entities and tables are drawn as a box with a horizontal line near the top of the box.

The area above the horizontal line is known as the *key area* because that is where the entity's primary key resides. The *primary key* can be comprised of one or more attributes that *uniquely* identify the entity.

The area below the horizontal line is known as the *non-key area* because that is where all other attributes reside.

**Note:** A foreign key may appear in either the primary key or the non-key area of an entity or table. For more information about foreign keys, see *Foreign Key* (see page 20).

**Foreign Key**

When you create a relationship between entities, the primary key attributes of the parent entity are automatically migrated to the child entity. The designator (FK) indicates the name of the migrated key attribute, also known as a foreign key. This migration occurs automatically in the physical model.
If the foreign key attribute has the same name as an owned attribute in the child entity, the two instances are automatically unified into one attribute because it assumes that they are the same attribute. The process of combining or unifying identical attributes in an entity is called unification.

**Note:** The foreign keys display in the model by default, designated by (FK). If you do not see this designation, open the Diagram Editor (click Diagrams in the Diagram menu), and do the following depending on whether you are working in a logical or physical model:

**Logical model**

Click the Entity tab, and ensure the options Display Logical Foreign Key (FK) Designator and Display Migrated Attributes are selected.

**Physical model**

Click the Table tab, and ensure the option Display Physical Foreign Key (FK) Designator is selected.

### Relationships

An important object in a data model is the *relationship*, which is represented by the solid or dashed line that connects two entities or two tables. A relationship line connects a parent and a child entity or table. Usually, a symbol appears at the child-end of the relationship line. The symbol changes based on the diagram notation that you select.
Types of Relationships

Relationships are important because the type of relationship determines how a primary key of the parent entity or table migrates to the child entity or table as a foreign key. There are two basic types of relationships:

Identifying Relationship

An identifying relationship is represented by a solid line and through it the primary key of the parent migrates to the primary key area of the child entity or table.

Non-Identifying Relationship

A non-identifying relationship is represented by a dashed line and through it the primary key of the parent migrates to the non-key area of the child entity or table.

In an identifying relationship, the foreign key migrates above the line and becomes part of the primary key of the child entity (see Foreign Key (see page 20) for more information). In a non-identifying relationship, the foreign key migrates below the line and becomes a non-key attribute in the child entity. A dashed line represents a non-identifying relationship.

Note: If you want a non-key to migrate instead of the primary key, you can use the alternate key migration option. For more information, see the online help.
Create a Model

Now that you have a basic understanding of the workplace and the concepts associated with data modeling, you can begin creating a model.

To create a model
1. Click New on the File menu.
   The Create Model - Select Template dialog opens.
2. Click Logical/Physical in the New Model Type group box, and select a template and target database. Click OK.
   A new model is created and opens in the workspace.

Name Your Model

When you create a new data model, you should also create a name, or title, for the model. This name is used throughout the Design Layer features to identify the model by name. If you do not change it, by default “model_n” displays for all models. For example, the first model is named “model_1”, the second model is named “model_2”, and so on.

To name your model
1. Click Model Properties on the Model menu.
   The Model Editor opens.
2. Enter the name you want to give the model on the General tab. You can also add the author's name in the Author field.
3. Click Close.
   The information you entered is saved and the Model Editor closes.

Note: You can also enable Modeling Features using the Model Editor.
Add Entities

In the logical model, you can add entities using the ERwin toolbox.

To add entities
1. Click the Entity tool in the toolbox.
   The cursor changes from an arrow to the entity symbol.
2. Click anywhere in the Diagram Window to place the first entity. By default, this entity is named E/1.
   Repeat Steps 1 and 2 to create as many entities as needed; they are named E/2, E/3 and so on.
3. Click Save As on the File menu to save your model.
   The Save As dialog opens.
4. Enter a name for the model and click Save.
   The model is saved with the .erwin file extension, and the Save As dialog closes.

Note: The entities that you created in the Diagram Window also appear in the Model Explorer and Action Log because all three areas of the workplace are automatically synchronized.

Edit an Entity Name

You can edit an entity name by typing directly in the Diagram Window.

To edit an entity name
1. In the Diagram Window, click on the entity named E/1. Wait briefly, then click again.
   An edit box appears around the name.
2. Enter CUSTOMER over the default entity name and click once outside of the edit box.
   The entity is renamed.

Note: You can also edit an entity name in the Model Explorer when you select and right-click the entity name.
**Add Attributes**

You can add attributes to the entities directly in the Diagram Window.

**To add attributes**

1. In the Diagram Window, click an entity box and press Tab.
   
   An edit box opens below the entity name with the default name, **attribute_name**.

   ![Attribute Box](image)

   2. Enter the attribute name directly over the default name and click outside of the edit box.

   The attribute is added.

   **Note:** To add another primary key, before clicking outside the edit box, press Enter and the edit box opens above the line in the entity. To add a non-key, press Tab and the edit box opens below the line in the entity.

**Create Relationships**

In the following exercise, we will add two relationships:

- An identifying relationship between a parent and child entity
- A non-identifying relationship between the entities ORDER and PRODUCT

**To create relationships**

1. Click the Identifying Relationship tool in the ERwin toolbox.

   The cursor changes from the arrow symbol to the identifying relationship symbol.

2. Click the parent entity to begin setting an identifying relationship between the parent and child entity in the Diagram Window.

3. Click the child entity.

   A highlighted relationship line connects the two entities.

   **Note:** The relationship line is temporarily highlighted to make it easier to view the relationship. The relationship line is highlighted as you create it, or any time you select it.
When finished, your model should look similar to the following example:

4. Click the Non-identifying relationship tool in the toolbox.

   The cursor changes from the arrow symbol to the non-identifying relationship symbol.

5. Click the parent entity and then click the child entity to add a non-identifying relationship between them.

   When finished, your model should look similar to the following example:

**Save Your Model**

To save the changes you made to your model, click Save on the File menu. You can open the file again later for editing.
Enhance Your Data Model

When you design a data model, you can use many of the drawing and display features to enhance its appearance and make it easier to view and understand.

To prepare a diagram for analysis and presentation, you can:

- Enlarge the font size for all entity names so that they are easier to read.
- Change the color of all foreign keys to red, so that they are distinguishable from other attributes or columns.
- Use different fonts and colors to identify new objects from old objects in your model.
- Resize one or more entity boxes
- Align two or more entity boxes

Graphic Features

A diagram has several types of graphic elements that you can enhance with color. For example, you can individually specify text, fill, and line sizes and colors for entities, attributes and relationships, or use themes to define the default display of certain objects by diagram, or by model.

In addition to these graphic elements, there are many object types that you can change globally such as Foreign Keys, Entity Names, and Owned Keys.
Objects Can Inherit Color

The color of an object can be related to the color it inherits from other objects in the diagram. For example, you can choose to have a foreign key attribute or column, inherit its font and color from its parent primary key or relationship.

You can also change the color of foreign key columns or attributes so that you can easily identify them from owned primary key columns or attributes.
The Theme Editor

You use options in the Theme Editor to set formatting and display options for objects in your model. You can create a custom Theme and apply it to selected diagrams on your model, or use the Default Theme supplied with the program.

You can open the Theme Editor in any of these ways:

- From the General Tab on the Diagram Editor
- When you click Themes on the View menu
- From the Model Explorer

CA ERwin Data Modeler ships with two themes—Default and Classic. The Default Theme has the new “r8 look” and the Classic Theme has the “r7 look.” These cannot be edited, but you can create new themes.

You can override settings defined in a Theme, in the Style tab of the individual editors.
Enhance Your Data Model

**Formatting Options in the Theme Editor**

You use the Theme Editor to define the default theme for various ERwin objects. The Theme Editor displays tabs for each object and it depends on the model type that you select. In a logical/physical model, you can switch from the logical model to the physical model to change the settings for each side of the model.

The Theme Editor has the following options:

**Name**
- Specifies the name of the Theme.

**Default Font**
- Specifies the default font for the selected Theme. Click to change the font style options.

**Diagram Fill**
- Specifies the default fill color for the diagrams in the selected Theme. Click to change the fill style options.

**Entity Font**
- Specifies the default font for the entities in the selected Theme in a logical model. Click to change the font style options.

**Table Font**
- Specifies the default font for the tables in the selected Theme in a physical model. Click to change the font style options.

**Entity Fill**
- Specifies the default fill color for the entities in the selected Theme in a logical model. Click to change the fill style options.

**Table Fill**
- Specifies the default fill color for the tables in the selected Theme in a physical model. Click to change the fill style options.

**Attribute Font**
- Specifies the default font for the attributes in the selected Theme in a logical model. Click to change the font style options.

**Column Font**
- Specifies the default font for the columns in the selected Theme in a physical model. Click to change the font style options.

**FK Attribute Font**
- Specifies the default font for the foreign key attributes in the selected Theme in a logical model. Click to change the font style options.
FK Column Font

Specifies the default font for the foreign key columns in the selected Theme in a physical model. Click \( \text{Font} \) to change the font style options.

FK Attribute Color

Specifies the default color for the foreign key attributes in the selected Theme in a logical model. Click \( \text{Color} \) to change the color options.

FK Column Color

Specifies the default color for the foreign key columns in the selected Theme in a physical model. Click \( \text{Color} \) to change the color options.

The Theme Editor includes the following tabs:

- **Defaults**
  
  Define the font and color for the background window and the overall default for objects on the diagram window.

- **Entity**
  
  Define font, fill, and outline options for entity names and definitions in a logical model.

- **Attribute**
  
  Define fonts and colors options for owned and foreign key attributes in a logical model.

- **Table**
  
  Define font, fill, and outline options for table names and definitions in a physical model.

- **Column**
  
  Define fonts and colors options for owned and foreign key columns in a physical model.

- **Key**
  
  Define the key display preference, the Alternate Key (AK) Attribute font, and the Inversion Entry (IE) Attribute font.

- **View**
  
  Define the font, fill, and outline options for the name and definition for a view. Define display fonts for an owned attribute and expression.

- **Materialized Query Table (DB2 only)**
  
  Define the font, fill, and outline options for the name and definition for a materialized query table. Define display fonts for an owned attribute, expression, Alternate Key (AK) Attribute, and Inversion Entry (IE) Attribute.

- **Relationship**
Enhance Your Data Model

Define style inheritance options, and the font, color, and line style for relationships.

**Subtype Symbol**
- Define style inheritance options, and the font, color, and line style for subtypes.

**Annotation/Shape**
- Define formatting options such as font, fill, line, and outline for annotations/shapes.

**Where Used**
- Displays what is affected by the selected Theme. The display can include a diagram name, subject areas, individual modeling objects, and drawing objects.

**Definition**
- Lets you enter definition text to associate with the selected Theme.

**UDP**
- Lets you create a UDP to associate with the selected Theme.
Create a New Theme

You use the Theme Editor to create your own theme that sets the preferences for displaying objects in your model. When you create a new theme, you can choose to apply it to any diagram by selecting this theme from the Theme Editor when you are working in that diagram.

You use the Defaults tab to set the preferences for font and fill colors for all objects in your model. When you select a Theme for your model, all objects in your model inherit these values.

**Note:** The options and tabs change depending on the model type (logical or physical) with which you are working.

**To create a new theme**

1. Click Themes on the View menu.
   - The Theme Editor opens.
2. Click New on the toolbar to create a new theme and work with the following options:
   - **Name**
     - Specifies the name of the theme. Enter the theme name in this field.
   - **Default Font**
     - Specifies the default font. Click \[ \] to define the font style.
   - **Diagram Fill**
     - Specifies the default fill color for diagrams. Click \[ \] to define the fill style.
   - **Entity (or Table) Font**
     - Specifies the default font for the entities (or tables). Click \[ \] to define the font style.
   - **Entity (or Table) Fill**
     - Specifies the default fill color for the entities (or tables). Click \[ \] to define the fill style.
   - **Attribute (or Column) Font**
     - Specifies the default font for the attributes (or columns). Click \[ \] to define the font style.
   - **FK Attribute (or Column) Font**
     - Specifies the default font for the foreign key attributes or columns. Click \[ \] to define the font style.
   - **FK Attribute (or Column) Color**
3. Click the Defaults tab and work with the following options:

   **Font Settings**
   Specifies the default font. Click \( \text{A} \) to define the general font style.

   **Fill Settings**
   Specifies the default color for the objects in the diagram. Click \( \text{C} \) to define the general fill style.

   **Line Settings**
   Specifies the default line style. Click \( \text{L} \) to define the general line style.

   **Outline Settings**
   Specifies the default outline style for the model. Click \( \text{O} \) to define the general outline style.

   **Diagram Fill**
   Specifies the default background color for the diagrams in your model. Click \( \text{F} \) to define the general fill style.

4. Work with the options on the other tabs to define display options for specific objects, such as views, relationships, and subtype symbols, or define UDPs or theme definition.

5. Click Close.

The theme is created and the Theme Editor closes.
Set Font and Fill Preferences for Objects

You use the Defaults tab to set the default preferences for font and fill colors for all objects in your model. When you select a Theme for your model, all objects in your model inherit these values.

To set the default font and fill preferences for objects
1. Click Themes on the View menu.
   The Theme Editor opens.
2. Select the Theme for which you want to set the default values, and click the Defaults tab.
3. Work with the following options:
   - **Font Settings**
     Specifies the default font. Click to change the general font style options.
   - **Fill Settings**
     Specifies the default color for the objects in the diagram. Click to change the general fill style options.
   - **Line Settings**
     Specifies the default line style. Click to change the general line style options.
   - **Outline Settings**
     Specifies the default outline style for the model. Click to change the general outline style options.
   - **Diagram Fill**
     Specifies the default background color for the diagrams in your model. Click to change the general fill style options.
4. Click Close.
   The changes are saved and the Theme Editor closes.
Using a Model to Import Styles

You can maintain and share global formatting templates by creating a Theme in one model and importing it into another model. This process uses the CA ERwin Data Modeler Link Model Source wizard to import the Theme into a second model.

Use this process to maintain a global style template and import a Theme into another model:

■ Create a new source model to contain the Theme you want to use as a template for other models.
■ Use the Theme editor to create a new Theme and define your formatting styles. Save your source model.
■ Open the model in which you want to import the Theme.
■ Click Tools, Link Model Source to open the Link Model Source wizard. Select your global style template model as the source model and click Finish. It is not necessary to change any of the other defaults in the wizard.
■ The objects from the source model are ready for import into your open model. The Complete Compare Resolve Differences dialog opens, where you can review and import the Theme to your target model.
■ Click Finish.

Add an Annotation

You can add annotations to a diagram to identify or clarify model elements. Annotations can include any text you choose including diagram version numbers, notes, titles, and captions.

To add an annotation

1. Click the Annotation tool on the ERwin Toolbox.
   The cursor changes from the arrow symbol to the annotation symbol.
2. Click the diagram window where you want the annotation to appear.
   An annotation text area is created.
3. Type the annotation text that you want to appear, and click the diagram window outside the annotation area.

   The annotation is added.

4. (Optional) To add consecutive multiple annotations, press the CTRL key before you click the Annotation icon.

   When you click again in the diagram window, another annotation is created. If you add annotations this way, you first create multiple empty text areas and then must return to each text area to enter the text.

   **Note:** To align multiple annotations, use the Alignment toolbar.

---

**Resize a Box**

To enhance the appearance of your data model, you can make all of the entity, table, or view boxes uniform in size. You can also emphasize one or two boxes by making them larger than the others, or resize any box to meet your presentation requirements.

**To resize a box**

1. Use the Select tool, and click near the border of the box that you want to resize.

   The resize handles appear.

2. Move the Select tool until you see the cursor shape change into a two-sided arrow.

   Hold down the mouse button and grab the resize handle. Move the cursor to adjust the height or width of the box.

   Release the mouse button when you are satisfied with the new dimensions of the box.

   The box is resized.

---

**Object Arrangement**

Some of the automatic layout features help you arrange objects in your diagram. The alignment toolbar helps you quickly align the object boxes along the top, bottom, or sides of the boxes.

The alignment toolbar includes tools to evenly space a set of objects horizontally or vertically.
**Adjust the Object Spacing on the Diagram Window**

Use the alignment feature to quickly adjust object alignment on the diagram window.

**To adjust the object spacing on the diagram window**

1. Select at least three of the objects that you want to align on the diagram window.
2. Select one of the following on the Alignment toolbar:

   - **Align Top**
     Aligns the objects to the top of the diagram.

   - **Align Bottom**
     Aligns the objects to the bottom of the diagram.

   - **Align Centers**
     Aligns the centers of the objects.

   - **Align Left**
     Aligns the objects to the left side of the diagram.

   - **Align Right**
     Aligns the objects to the right side of the diagram.

   - **Align Middle**
     Aligns the objects to the middle of the diagram.

Objects display on the diagram aligned as you selected.

**Group and Ungroup Objects**

You can group objects to easily maintain and manage your models. For example, you may want to group all the entities that you work with by category. When you create groups, it also helps ensure that single entities will not be inadvertently moved.

**Note:** To adjust alignment within the group, you must first ungroup the objects.

**To group and ungroup objects**

1. Select the objects that you want to group using the Select tool on the ERwin Toolbox.
2. Click Group on the Diagram menu.
   You can now move the group around the model as single object.
3. To return the group to individual movable objects, select the group and then click Ungroup on the Diagram menu.
   You can now individually move each object.
Drawing Objects

You can enhance a model by using the Drawing toolbar to create the following objects:

- Rectangle
- Rounded Rectangle
- Ellipse
- Pentagon
- Hexagon
- Octagon
- Triangle
- Down Triangle
- Left Triangle
- Right Triangle
- Diamond
- Parallelogram
- Star
- Cross
- Line
- Connector

When you create a drawing object an annotation area is included for you to include any annotations within the object. Double-click the drawing object to open the Shape Editor and define its properties.

Add Drawing Objects to a Data Model

You can add drawing objects to a data model to enhance it or to provide meaningful annotations.

To add drawing objects to a data model

1. Open the model to which you want to add a drawing object. Click the shape icon on the Drawing toolbar, and draw the shape around one or more entities.
   
   The shape is drawn around the chosen objects.

2. Click the drop-down arrow of the Background Color tool on the Formatting toolbar.

   The drop-down color palette displays the Theme colors and Available colors.
3. Choose any color to apply to the background of the shape. The color is applied to the background of the selected objects.

4. Double-click on a drawing object you created. The Shape Editor opens.

5. Click the Text tab and enter your annotation in the text box.
6. Click Close.

7. Click the Text Color button on the Formatting toolbar and select a color for the text.

   You can see the annotation in the drawing object with the annotation text color applied.

   The following is an example of how you can use drawing objects to enhance your data model:

8. Click Save on the File menu.

   Your work is saved.
Print a Model

You can print your model to your default printer. Before you print, you can customize options for the printed output.

To print a model

1. Click Print on the File menu.
   The Print dialog opens.
2. Select from the following options on the Print dialog:
   - **Printer**
     Specifies the destination printer. Select a printer name from the drop-down menu. Select Print to file to save the print output to a file instead of a printer.
   - **Print range**
     Print all pages of the model, or a range of pages.
   - **Copies**
     Prints one or more copies of each selected page. You can also select to collate the copies.
   - **Print what**
     Print the current diagram (the open diagram from which you opened the print dialog), or current selection or all diagrams currently open.
   - **Print order**
     Specifies the direction taken for the print output. For example, if you have a large model that prints on multiple pages, you can select "Over, then down" to create a printout with a horizontal orientation. Or, select "Down, then over" to create a printout with a vertical orientation.

3. Click Preview to view your output page by page, before starting the print job.

   **Note:** The page preview that is displayed takes into account the page margins that you set in the Page Setup Editor. This means that what you see in the Preview page is what will be printed.

   Click Zoom In to zoom the diagram to the size of the paper. Click Zoom Out to zoom the diagram to a size that can be fit in the Preview window.

   To print immediately, click Print; otherwise click Close to go back to the Print dialog.

4. Click **Page Setup** (see page 43) to customize print options such as page size, orientation, zoom, border, color, header, footer, and margin.

5. Click Print to print the model to the specified printer.
Specify General Page Setup Options

The Page Setup Editor gives you access to formatting options for printing such as page size, orientation, zoom level, borders, colors, headers, footers, and margins.

**Note:** When you choose to print all diagrams, the page settings in the Page Setup Editor always take precedence over the page settings of the diagrams.

**To set the page settings for printing a model**

1. Click Page Setup on the File menu. You can also select Page Setup to edit the page settings from within the Print dialog.

   The Page Setup Editor opens.

2. Click the General tab and work with the following options:

   **Page Size**
   
   Specifies the page size for the print job. Select a page size from the drop-down menu.
   
   **Note:** The page type you specify must be supported by a paper type available at your printer. For example, if you specify A4 as the page size, you must have A4 paper loaded in your printer for the print job to complete.

   **Orientation**
   
   Specifies the page orientation. Select Portrait or Landscape from the drop-down menu.

   **Zoom Level**
   
   Specifies the zoom level used in the printout. Enter a number in the text box or click the arrow to increase or decrease the zoom level.

   **Print Border**
   
   Specifies to print the diagram with a border.

   **Print In Color**
   
   Specifies to print the diagram using color. Clear the check box to print in black and white, even if color choices were made in the diagram.

3. Click the Margins tab and work with the following options:

   **Header/Footer**
   
   Specifies elements that appear in the header and footer of your printout. Click in the text box, then click an item on the Header/Footer toolbar to add an element. See Add a Page Header or Footer (see page 45) for more information about setting the header and footer.

   **Margins**
Specifies the margin (in inches) for the top, left, right, bottom, header, and footer margins.

4. (Optional) Select the Keep synchronized with current diagram check box to ensure that the page settings in the Page Setup dialog and that of the diagram remain in sync whenever changes are made.

5. (Optional) Click Load from Diagram to retrieve the page settings from the diagram. Click Save to Diagram to save the page settings to the diagram.

6. Click Close.

**Save Your Page Setup Selections**

You can save your page setup selections with your diagram and recall them the next time you print your model.

**To save your page setup selections**

1. Click Print on the File menu to open the Print dialog.

2. Click the Page Setup button.
   
   The Page Setup Editor opens.

3. Select options for printing, then click Save to Diagram.
   
   Your selections are saved with the diagram. Click the Load from Diagram button to recall your saved settings, or refresh the editor with your saved settings.
Change Page Margins for Printing

By default, the entire page is used for printing. Before you print, you can set separate page margins for the current diagram.

To change the page margins

1. Click Page Setup on the File menu.
   The Page Setup Editor opens.
2. Click the Margins tab and enter a new value (in inches) in any of the margin text boxes:
   - Top Margin
   - Header Margin
   - Left Margin
   - Right Margin
   - Footer Margin
   - Bottom Margin
   **Note:** To enter a fraction, place the cursor after the decimal point and enter the decimal equivalent.
3. Click Close to save your settings, or Cancel to cancel your selections.

Add a Page Header or Footer

You can add a customized header or footer (or both) to all the pages when you print a model. For example, you can print the Model Name, Subject Area Name, and Diagram Name at the top of every page, and the page number, date, and time at the bottom of every page.

**Note:** If you manually enter incremental information in the Header or Footer text box (for example, page number, date, and so on), you cannot automatically update the text.
A toolbar is provided to make it easy for you to quickly add the following elements:

- Current Page
- Page Count
- File Name
- Subject Area Name
- Diagram Name
- Time
- Date

**To add a page header or footer**

1. Click Page Setup on the File menu.
   The Page Setup Editor opens.

2. Click the Margins tab and work with the following options in the Header or Footer text box:
   - Click in the Header or Footer text box to specify in which area you want to insert the customized text.
   - Click the appropriate Header/Footer button to automatically insert information, or use the keyboard to insert other information (for example, your name).

A preview of your selection displays beneath the text box.

For example, if you selected file name and E/R diagram for the header, and date and time for the footer, then the preview would be as follows:

```
Header:
%File% -- %Diagram%

Footer:
%Date%, %Time%

```
3. Work with the following related options in the editor:
   ■ Indicate page margins (in inches) for the header or footer.
   ■ Select the "Keep synchronized with Current Diagram" check box to associate your selections with the current diagram.
   ■ Click the Load from Diagram button to reset any changed settings to the settings last saved to the diagram.
   ■ Click the Save to Diagram button to save the current selections with the diagram for future use.
4. Click Close to save your settings, or Cancel to cancel your selections.

**Set Print Defaults at the Diagram Level**

You can set print defaults at the diagram level in the Page Setup and Page Setup Margins tabs in the Diagram Editor. Your settings populate the options displayed on the General and Margins tab in the Page Setup Editor that you can open from the Print dialog.

**To set print defaults at the diagram level**

1. Click Diagrams on the Diagram menu.
   **Note:** You can also open the ER Diagram Editor from a shortcut menu when you right-click a blank area in the workplace, or from the object name in the Model Explorer.
   The ER Diagram Editor opens.
2. Click the Page Setup tab to change formatting options for printing, such as page size, orientation, zoom level, borders, and colors.
3. Click the Page Setup Margins tab to change formatting options for headers, footers, and margins.
4. Click Close to save your changes and close the ER Diagram Editor.
Chapter 3: Understanding the Workplace

This section contains the following topics:

- **Toolbars** (see page 49)
- **Workplace Panes** (see page 55)
- **Property Editors** (see page 84)

**Toolbars**

There are many task-oriented toolbars that help you quickly perform popular tasks. When you pass your cursor over the toolbar button, a brief description of the button (tooltip) appears. When you click the toolbar button, the appropriate dialog opens or the task is performed.

All of the toolbars are dockable; this means that you can drag them to any location in the workplace and they dock along the edge of the window. Alternatively, you can let them float freely in the window if you prefer.

Depending on your preferences, all of the toolbars can be shown or hidden. On the View menu, the Toolbars option lists all of the toolbars. Select a toolbar to make it visible or hide it in the workplace. In the following example, all toolbars are selected and will display in the workplace:
Alignment Toolbar

The appearance of your data model is important to you and the others who use it. There are many features that help you enhance the appearance of your model. You may already be familiar with some of the automatic layout features that help you arrange objects in your diagram.

A toolbar is provided that can help you quickly align the object boxes along the top, bottom, or sides of the boxes.

The tools on the Alignment Toolbar help you quickly arrange model objects.

You can select multiple diagram objects, and space them to your preference.

Display Toolbar

Use the Display toolbar to dynamically change the object display levels in your diagram. You can also specify whether to display the logical or physical model, or select a subject area to view.
Options include:

- Table display level
- Primary key display level
- Column display level
- Keys display level
- Definition display level
- Subject area selector
- Logical/Physical selector

**Database Toolbar**

All of the database tasks you can perform in your model are conveniently located on the Database toolbar. Available options depend on whether you are working in a logical or physical model.

Options include:

- Forward engineer schema generation (physical model only)
- Reverse engineer from script or database
- Complete Compare
- Target database (physical model only)
- Forward engineer check model (physical model only)

**Drawing Toolbar**

You can enhance a model using the Drawing toolbar to create different drawing objects. The tools work like many other popular point-and-click drawing applications. Just click a tool, click in the diagram window, and drag the mouse until the object is the right size.
Formatting Toolbar

You can use the Formatting toolbar to change the font or color of objects on the Diagram Window. The toolbar lists all the fonts that are available on your workstation. It also has separate buttons to modify the color of the text, object, and outline color. One of the benefits of this toolbar is that you can use the options to quickly apply formatting to individual attributes without having to add another theme, or alter an existing theme.

Options include:

- Font style
- Font size
- Bold text
- Italic text
- Underline text
- Strikethrough text
- Text color
- Background color
- Line/outline color
- Line weight
- Line pattern
- Line ends

Layout Toolbar

Use the Layout toolbar to arrange the layout of your diagram, redraw relationship lines, or reset sizing.
Options include:

- Circular
- Hierarchical
- Orthogonal
- Symmetric
- Tree
- Reset relationship paths
- Reset object sizing

Model Manager Toolbar

The CA ERwin Model Manager toolbar lets you perform administrative and workgroup-related tasks in the CA ERwin Data Modeler Workgroup Edition (CA ERwin WE). A description of each toolbar button displays when you pause your cursor over it.

**Note:** Options on the toolbar become active only after you make a connection to the mart.

Options include:

- Open a model in the mart
- Save a model to the mart
- Lock/Unlock a model in the mart
- Open the Library Manager to manage mart libraries
- Open the Submodel Manager to manage mart submodels
- Merge a CA ERwin Data Modeler model in the mart
- Refresh a model in the mart
- Review changes against a mart
- Open the Version Manager to display model differences
- Connect to a mart
- Open the Security Manager to set mart permissions
**The ERwin Toolbox**

The toolbox is the primary set of tools for drawing and editing a data model. In the Toolbox, use the Select tool to move objects and resize entity and table boxes. The cursor changes shape for each task so that you know what action is performed.

You have the option to resize any box to meet your presentation requirements. For example, you may want all of the entity, table, or view boxes to be uniform in size, or emphasize one or two boxes by making them larger than the others.

The toolbox changes based on the model type (logical or physical) and the notation (IDEF1X, IE, or DM).

For more information about the IDEF1X, IE, and DM notation, see the online help.

**The Standard Toolbar**

The Standard toolbar is located near the top of the diagram window, and contains a group of buttons that you can use to perform common tasks. Each toolbar button is a shortcut you can use instead of selecting a menu option. The availability of the toolbar varies, depending on the object you have selected and whether you are working on the logical or physical model.

When you pass your cursor over a toolbar button, you will see a brief description of the button. When you click it, the appropriate dialog opens or the task is performed automatically.

**Transformations Toolbar**

The Transformations toolbar lets you manage transformations of Supertype Subtype Identity and Many-to-Many relationships, vertical and horizontal partitioning, and two table roll up and roll down.
Options include:
- Many-to-Many
- Supertype/Subtype Identity
- Supertype/Subtype roll up
- Supertype/Subtype roll down
- Vertical partition
- Horizontal partition
- Two table roll down
- Two table roll up
- Resolve all transformations

**Zoom Toolbar**

Use the Zoom toolbar to manage zoom levels in your diagram.

Options include:
- Zoom out
- Zoom in
- Zoom normal
- Fit model
- Fit selection

**Workplace Panes**

Each of the following panes within the workplace is dockable and floatable, and where applicable, contains its own toolbar:
- Explorer Pane (Model Explorer)
- Action Log Pane
- Advisories Pane
- Overview Pane
- Bulk Editor Pane
Workplace Panes

Each pane provides two options for how it displays:

Auto Hide

Activates auto hide. The pane becomes a tab in the application. When auto hide is activated, the pane is not visible in the workplace unless you hover your mouse over the tab of the hidden pane. When you do this, the pane is temporarily restored to allow you to work in the pane. When your mouse leaves the pane, it becomes auto-hidden once again. To turn off auto hide, mouse over the tab to restore the pane, and then click the pushpin.

Close

Closes the pane. To open the pane again, select the appropriate pane on the View, Windows menu.

Pane grouping functionality is provided to assist you with arranging panes in the workplace. Dockable panes can dock to other dockable panes so that they combine to create multiple tabs in a single dockable pane, or pane group. Similarly, tabs on dockable panes can be undocked / ungrouped and floated or docked to the top level frame window as individual dockable panes. When two or more panes are docked together in a tab group, the tab selection interface displays at the bottom. When panes are not grouped, the tab selection interface is not shown. When tabs are grouped, the title bar on top of the pane changes to the title bar of the currently active tab.

To dock panes together into a pane group, simply drag and drop one pane over another. To undock, drag the tab of the pane you want to undock and drop it in the workplace.
Model Explorer

The Model Explorer provides an organized, hierarchical, text-based view of your data model and its contents. It provides an easy method for creating objects. The Model Explorer lets you to create, display, navigate, and modify your model using the Model or Subject Area view.

The Model Explorer has two panes, Model and Subject Area. You can switch to a different pane by clicking the tab at the bottom of the Model Explorer:

All of the objects in your model are listed in the Model Explorer, but display differently based on which pane is active.

- The Model pane includes every object in your model including subject areas and domains. This is the default view.
- The Subject Areas pane displays model objects sorted by subject area.

Dynamic Changes

Just as you can work on a graphical view of a model in the Diagram Window, you can perform the same tasks from the Model Explorer using a text-based view of a model. When you make changes to an object in the Model Explorer, the graphical view of the model is immediately updated with the same change.
For example, if you rename a table in the Model Explorer, the new table name replaces the existing table name in the Diagram Window and the relevant editors. Similarly, if you make a change to the diagram or in an editor, you immediately see the change in the Model Explorer.

The Model Explorer Tasks

In addition to navigating, the Model Explorer provides a whole range of useful features that help you easily create and modify your data model such as:

- Create new objects
- Go to objects in the Diagram Window
- Open editors to view or change object properties
- Delete objects
- Rename objects

**Note:** To work with the Model Explorer, click Explorer Pane on the View, Windows menu, to open the Model Explorer.

The Model Explorer Shortcut Menu

When you right-click on an object in the Model Explorer, a shortcut menu displays that lists the options available for that object, similar to the following example:

![Shortcut Menu Example]

To control the topological display of Domains, right-click on a Domain and select how you want to sort the Domains.

![Domains Sort Options]

You can also delete an object or invoke the property editor for the object. If semantics do not allow the deletion of an object (such as a Primary Key object), then the Delete menu item on the shortcut menu does not appear.

If you want to create a new object, and additional information is required to complete the creation of that object (such as a Relationship), a dialog box appears in which you must enter the information required.
The Model Explorer Toolbar

The Model Explorer contains a toolbar to help you navigate your object editing, launch property editors, delete objects, and invoke online help.

New Objects

Just as you can create a new entity, table, or relationship using the Toolbox, you can quickly create a new object in the Model Explorer.

To create a new object, right-click on any object and choose New from the shortcut menu. For some objects, such as a domain, you can drag the object from the Model Explorer onto the Diagram Window to create a new attribute or column.

Rename Objects

Every object in your model is represented in the Model Explorer by its name. Just as you can rename an object using on-diagram editing in the Diagram Window, you can rename an object directly in the Model Explorer.

To rename objects
1. Click the object name, and then click again.
   An edit box opens around the object name.
2. Enter the new object name directly in the edit box.
   The new name of that object appears throughout the Model Explorer and the model.

Note: Any unique name rules that you select for your model are enforced when you rename an object in the Model Explorer.
Select Unique Name Rules

Unique name rules are a set of options that define how to respond when you have a duplicate entity or table name in the data model.

To select unique name rules
1. Click Model Naming Options on the Actions menu.
   The Model Naming Options dialog opens.
2. Click the Duplicate Names tab and set preferences for duplicate names.
3. Click OK.
   Your changes are saved and the Model Naming Options dialog closes.

The Go to Diagram Option

When you right-click an entity, table, or view in the Model Explorer and click the Go To Diagram option from the shortcut menu, you can quickly display that object in the Diagram Window.

Object Properties

Each object in a data model has many properties. The easiest way to add or modify object properties is in the object property editor.

Using the Model Explorer, you can open the property editor for that object type. You can do this in one of two ways:

- Right-click on the object and click Properties.
- Select the object and click the Property Editor button from the Model Explorer toolbar.

When the Property Editor opens, you can accept or change the default properties. When you close the editor, the properties are saved with the object.

Note: For bulk editing of object properties, you can use the Bulk Editor.

Regardless of the method you choose to add or edit an object or its properties, the Model Explorer and the data model are always in sync. While you are still in the design phase, the names of objects in your model may change frequently.

Note: Object properties also migrate through relationship lines. In other words, objects can inherit properties from their parent objects.
Object Moving, Copying, and Deleting

Just as you can move, copy, and delete attributes and columns in the Diagram Window, you can also move, copy, and delete most objects in the Model Explorer.

After you move, copy, or delete an object, all of the instances in the model that reference that object are automatically updated.

Add a Domain in the Model Explorer

In the Model Explorer, the Model view lists all of the domains for the current model, which include all of the default domains as well as any that you created.

To add a domain in the Model Explorer
1. Right-click a domain type (blob, string, number, and so on) and click New.
   An edit box opens with a default domain name.
   Note: The selected domain type is assigned as the parent.
2. Enter a name for the domain in the text box and press Enter.
   The new domain appears according to the sort order that you specify (either alphabetically or hierarchically). To switch the sort order of the Domains from hierarchical to alphabetical, right-click the Domains folder in the Model view, and select the sort option that you prefer.

Note: For more information about domains, see Working with Data Models (see page 89).

Add a Model Source in the Model Explorer

When you work with design layers, it may be important to link a model with its model source so that you can identify the historical parent of a model. After you link a data model to its source, you can synchronize the two models to selectively apply changes to one or the other.

To add a model source in the Model Explorer
1. Right-click the Model Sources Folder and click New on the shortcut menu.
   The Add Model Source wizard opens.
2. Follow the steps in the Add Model Source wizard to finish adding the model source.
3. Click Add to complete the process and close the wizard.

The source objects are added to your target model, and models are linked. As you continue to work with the models, all the changes you apply to the model and the model source are tracked.

**Note:** For more information about adding model sources, see [Working with Design Layers](#) (see page 167).

**Model View**

The primary purpose of the Model view is model exploration and to function as an alternative launching point for object and property editors. It lists all of the object types that appear in the current data model based on the model type and the target server.

For example, if the model type is Logical, the Model Explorer does not include physical objects such as a view. Similarly, if the model type is Physical, the Model Explorer does not include logical objects. If the target server is Oracle, then additional objects specific to Oracle display, such as Clusters.

Other objects that do not display are:
- Minor objects that are handled completely by the editors of the parent object. For example, a Valid Value object is created, deleted, and edited by the Validation Rule Editor.
- An object that represents configuration information that is stored by a CA ERwin Data Modeler process, and is not actual model data, such as a Complete Compare Option Set.

**Subject Area View**

The Subject Area pane displays model objects sorted by subject area. You can expand each subject area to see a list of the members as well as any stored displays, which appear in folders below the Subject Area to which they belong.

The purpose of the Subject Area view is to provide a filtered view of the model so that unnecessary tree information is minimized. You can create subject areas to divide the model into smaller manageable parts, which is especially helpful when you are working with large models.
At the top of the Model Explorer is a drop-down list where you can select the subject area that you need. When you select the subject area, the contents of the tree control in the Model Explorer filters so that only those objects that are contained within the selected subject area are shown.
For example, you see that tables are categorized as tables, and views categorized as views, unlike the display of subject area objects in the Model tab view. Relationships are filtered to show only those visible on the diagram if both endpoints are present in the subject area. You can expand the tree for the subject area to see the subject area members.

**Note:** Global objects that do not relate to the selected subject area are not displayed, such as subject area objects or model source objects.

### Create a New Subject Area

You can create a new subject area using the Subject Area Editor.

**To create a new subject area**

1. Click Subject Areas on the Model menu.
   
   The Subject Area Editor opens.
2. Click the New button.
   
   A new subject area with the default name is added to the Navigation Grid. You can change the name directly in the Name cell.
3. Work with the following options:
   
   **Name**
   
   Displays the subject area name. You can change the name directly in this field.

   **Auto-populate**
   
   Specifies to automatically populate the selected subject area with all model objects.
4. Click the General tab and specify common properties for the selected subject area.
5. Click the Members tab and specify the members of the selected subject area.
6. (Optional) Click the Definition tab to enter definition text.
7. (Optional) Click the UDP tab to add subject area user-defined properties.
8. Click Close.

   A new subject area is created and the Subject Area Editor closes.
**Action Log**

The Action Log works in real time so you can make modeling decisions during your current session rather than having to wait until you save the model to review changes. The Action Log lets you determine the best way to work.

**Note:** If the Action Log pane does not display in the workplace, click Action Log Pane on the View, Windows menu.

As you work on the graphical view of a model in the Diagram Window, you can view the transaction information in the Action Log. As you make changes to your model, the Action Log is updated in real time. For example, if you create an entity in your model, the Action Log reflects this change.

Changes are only viewable in the Action Log during your *current modeling session*. Each new session begins with an empty Action Log. When you close the model, the Action Log clears. Before closing your model, you can generate a report that lets you view all the changes made during the current session.

The type of objects that appear in the Action Log is based on the display mode you are using. If you are working with a logical model, then only logical objects appear. If you are working with a physical model, then only physical objects appear.

The Action Log lets you search for every transaction and filter by type of change so that you can easily find a specific transaction or a set of transactions. This feature is particularly helpful when working with large models.

**Action Log Panes**

The Action Log has two panes, Details and Summary, with corresponding tabs. Select the Details tab to see every change (*transaction*) made to a model, or select the Summary tab to see the net result of changes made to a model.

**Note:** A *transaction* is a single unit of work that is not divisible into smaller components. The Action Log lets you navigate through the transaction tree using the Details pane or the Summary pane.

**Details Pane**

The Details pane shows all the changes you make to a model during the current session. The Details pane is the default view when you launch the program. Changes appear in the Details pane with the most recent transaction at the top of the tree, and the first transaction at the bottom of the tree. You can either expand or collapse each transaction.
The toolbar on the Details pane lets you reverse a transaction, find a transaction, view property details, and undo and redo to a selected transaction while working in the current session.

Summary Pane

The Summary pane displays the net result of changes made to the model during the current session. It provides a filtered view of all the actions you perform on the model during the current session so that unnecessary tree information is minimized, which is especially helpful when you are working with large models.

The Session Summary node is the top-level node in the tree. All changes you make to the model at the object level and property level appear below the Session Summary node in the tree.
The Summary pane is similar to the Details pane except for the following differences:

- While the top-level nodes in the Details pane are transactions, the Summary pane has only one top-level node with changes appearing below it.
- The Extended Find and Filter feature is only available in the Summary pane.
- The Reverse, Undo to Selected Transaction, and Redo to Selected Transaction options are not available in the Summary pane.

**Action Log Tasks**

In addition to viewing the detail and summary transactions, the Action Log provides a range of useful features that help you easily perform the following actions:

- Locate text within a transaction, object, or property using the Find feature.
- Use the Extended Find and Filter feature to locate, filter, and report on the results of your search. This feature is available only in the Summary pane.
- View old and new details relating to a property transaction using the Property Details feature.
- Reverse a transaction. This feature is available only in the Details pane.
- Undo a group of sequential transactions. This feature is available only in the Details pane.
- Redo a group of sequential transactions. This feature is available only in the Details pane.

**Action Log Shortcut Menu**

When you right-click an object in the Details pane the Action Log shortcut menu opens. This shortcut menu lists the options available based on the actions you performed prior to opening the shortcut menu. These options include:

- Undo to this point (or Redo to this point)
- Reverse
- Collapse (or Expand)
- Expand Transaction
- Collapse Transaction

**Note:** A shortcut menu is not available on the Summary pane.
Locate Text Using the Find Feature

The Action Log Find dialog lets you search for specific text at the transaction level, object level, or property level. This option is available on both the Details and Summary panes.

![Find Dialog]

By default, the search includes the entire tree, starting from the current selection point. If there is no current selection point, then the top of the tree is used as the starting point. If the search did not start at the top node, the search wraps to the beginning of the tree after reaching the end.

To locate text using the Find feature

1. Click Find on the Action Log toolbar.
   The Find dialog opens.
2. Enter the text you want to search for in the Find what text box.
3. (Optional) Select the Transaction, Object, or Property check box to narrow your search.
   
   **Note:** Since there are no transaction nodes in the Summary pane, the Transaction search option is not applicable to that pane.
4. (Optional) Select one of the following check boxes to refine your search:
   
   **Match case**
   Specifies to search on case-sensitive text.
   
   **Match whole word**
   Specifies to search for the entire text string.
   
   **Search up**
   Specifies to search for the text from the bottom up.
5. Click Find Next.
   The next occurrence of text displays.
6. Click Cancel when you are finished searching.
   The Find dialog closes.
**Action Log Metamodel Filter**

The Action Log captures all changes made to a model during a modeling session. The longer the session, the larger the log becomes. You can specify to filter out object types and property types, which affects the way modeling events are displayed in the Action Log. These objects are not removed from the Action Log, they are only filtered from the view. The Metamodel Filter button is always present on the Action Log toolbar. You can display a category list of objects and properties.

The Save button in the Action Log Metamodel Filter dialog saves the settings to a file called `ActionLog.config` in the following directory:

```
C:\Documents and Settings\user\Local Settings\Application Data\CA\ERwin Data Modeler\8.0.
```

This file can be copied to another machine to use the same filter settings.

**Select Object and Property Types Displayed in the Action Log**

You can select the object types and property types you want to see displayed in the Action Log.

**To select the object and property types displayed in the Action Log**

1. Click the Metamodel Filter button on the Action Log Toolbar.
   The Action Log Metamodel Filter dialog opens.
2. By default, all objects and properties are selected initially. Select Clear All to clear all of the objects and properties or clear only the objects and properties you choose to view.
   The object and property types selected are displayed in the Action Log for all future transactions.

**Use Extended Find and Filter**

The Extended Find and Filter feature lets you set find and filter criteria and view property changes. This feature is available only on the Summary pane of the Action Log.

To open the Extended Find and Filter dialog, click the Extended Find/Filter button on Action Log toolbar.
When the Extended Find and Filter dialog opens, it provides a snapshot of the Summary pane and lets you filter the information that displays so you can easily find the information you want.

**To use the **Extended Find and Filter** option**

1. Click Extended Find and Filter on the Action Log toolbar in the Summary pane.  
   The Extended Find and Filter dialog opens.

2. Click Find on the toolbar. 
   The Find Criteria dialog opens.

3. Select the Properties, Categories, and Classes that you want to find. These options let you filter the information that displays.

4. Click Find to start the search. 
   The Find Criteria dialog closes.

5. Click the Find Next button on the Extended Find and Filter toolbar to find the next occurrence of the search item.

6. Click Close. 
   The Extended Find and Filter dialog closes.
View Property Details

When you want to view the old and new properties for a property transaction, use the Property Details feature.

To view property details

1. Select a property node.

   - Note: You may need to expand the transactions in the Details pane or Summary pane before you can select the property node.

2. Click the Property Details button.

   The Property Change Details dialog opens, showing the original value of the property along with the current value of the property.

3. Click Close when you are finished.

Undo a Transaction

To undo the last change that you made to your model, use the Undo button on the Toolbar or click Undo on the Edit menu. This feature undoes one change at a time, and is reflected in the Action Log by a dimmed transaction.
Redo a Transaction

To redo a transaction that you made to your model, use the Redo button on the Toolbar or click Redo on the Edit menu. This feature restores one change at a time.

Reverse a Transaction

The Reverse feature in the Action Log lets you perform an opposite action on most entries that appear during the current modeling session. When you reverse a transaction, the model reflects the changes made to the Action Log. This feature is only available on the Details pane, and does not sequentially reverse actions.

For example, if the Details pane displays Created [Entity] object:'Entity_5'(id=5) and you select the transaction and click Reverse, a Delete on Entity_5 is implied.

Depending on how complex your model is, when using the Reverse feature, an attempt is made to restore the model to its best state. Use the Activity Log to determine whether your transaction has been properly reversed.

**Important!** Reverse applies to the entire transaction even if you select only the object or property level node.

**To reverse a transaction**

1. Click the Details tab in the Action Log.
2. Select a node in the tree containing an action that you want to reverse, and click Reverse on the Action Log toolbar.
   
   The opposite action occurs.

   **Note:** You cannot perform a reverse action on the topmost node in the tree. Use the Undo feature instead. You also cannot reverse the transaction in which the model was created - this transaction is marked with the pin icon.

Undo and Redo to Selected Transaction

The Undo to Selected Transaction feature in the Action Log lets you undo an entire range, or a sequential group, of transactions at the same time. Conversely, the Redo to Selected Transaction feature lets you restore a sequential group of transactions.

**Note:** To undo to a selected transaction or redo to a selected transaction, you must be in the Details pane in the Action Log.
As you create transactions on your model, each one moves the previous transaction down the tree in the Action Log, with the first transaction always appearing at the bottom of the tree. When you want to undo a range of consecutive transactions, the transactions above, including the one you select are undone. To redo a range of transactions, the transactions below, including the one you select are redone.

**Important!** After performing an undo to selected transaction, you will not be able to redo these transactions once you perform a new action, since the new action clears the redo stack.

### Undo a Group of Sequential Transactions

When using the Undo to a Selected Transaction feature, the transactions are undone in sequential order, starting with the transaction you select and ending with the latest transaction at the top of the tree.

**To undo a group of sequential transactions**

**Note:** For this exercise, you need to create transactions in the model so that you can undo them.

1. Open a data model.
2. Create an entity named Customer and add the following attributes:
   - Street Address
   - City
   - State
   - ZIP Code

   The transactions are recorded in the Action Log.
3. (Optional) In the Action Log, expand all the transactions by clicking the plus sign next to each one.
4. Right-click the Create Attribute transaction that is second from the bottom of the tree.

   A shortcut menu opens.
5. Click Undo to this point.

   **Note:** Instead of right-clicking the transaction and opening the shortcut menu, select the transaction and then click the Undo to a Selected Transaction button on the Action Log toolbar to perform the same action.

   All the transactions from the one you selected up to the top of the Action Log tree are dimmed, and are removed from the model in the Diagram Window.

**Important!** Do not close your model yet. Closing your model now will end the current session of the Activity Log and you will not be able to redo the transactions you just undid.
Redo a Group of Consecutive Transactions

When using the Redo to a Selected Transaction feature, the transactions are restored in sequential order starting with the transaction you select and moving down the tree until all dimmed transactions are restored.

To redo a group of consecutive transactions

1. Right-click the transaction that is the starting point for the redo action in the Action Log tree, Details pane.
   
The shortcut menu opens.

   **Note:** Instead of right-clicking the transaction and opening the shortcut menu, select the transaction and then click the Redo to a Selected Transaction button on the Action Log toolbar to perform the same action.

2. Click Redo to this point.
   
   All the transactions that were previously undone are now restored in the Action Log as well as in the model in the Diagram Window.

3. Save your model.

Undo/Reverse Comparison

You can undo or reverse changes you make to your model. The following table summarizes the differences between the three available features, and suggests when it is appropriate to use each one:

<table>
<thead>
<tr>
<th>Feature</th>
<th>Toolbar</th>
<th>When to Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo</td>
<td>Standard toolbar</td>
<td>When you want to undo the last, single action you took. This feature is similar to the Microsoft Windows undo feature; it lets you undo the last action taken.</td>
</tr>
<tr>
<td>Reverse</td>
<td>Action Log toolbar</td>
<td>When you want to perform an opposite action that is not the last action you took in the current modeling session. This feature applies to the entire transaction even if you select only the object or property level node. You can use the Undo button to undo a reverse action made in error. For some transactions, you can also reverse a reverse action. Note that you cannot perform a sequential reverse using this feature.</td>
</tr>
</tbody>
</table>
### Workplace Panes

<table>
<thead>
<tr>
<th>Feature</th>
<th>Toolbar</th>
<th>When to Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo to selected transaction/Undo to this point</td>
<td>Action Log toolbar</td>
<td>When you want to undo sequential transactions performed in the current modeling session. This feature lets you undo a range, or sequential grouping, of transactions at one time. You can perform a redo to selected transaction to the same group of transactions or a smaller set of the consecutive transactions in the group. You can use this feature at any time during the current modeling session.</td>
</tr>
</tbody>
</table>

#### Generate an Activity Summary Log

To save the information from your Action Log, use the Activity Summary option. This option generates a report that shows an activity summary of your current modeling session. This report can be helpful since the Activity Log is cleared every time you close your model.

**To generate an Action Summary Log**

1. Click Options on the Tools menu. The Options dialog opens.
2. Click the General tab.
3. Enter the full path in the Activity Summary section of the dialog where you want to save the report.
   (Optional) If you select the Generate on model close check box, a report is generated automatically each time before you close the model.
4. Click OK. The Options dialog closes.

**Note:** The generated report is saved in comma-delimited format (.csv) so that it can be viewed easily in other applications such as Microsoft Excel.

#### Generate a Session Activity Report

You can generate a Session Activity report to view a list of objects created and deleted, and objects and properties that were changed.

**To generate a Session Activity report**

1. Click Pinned Reports, Session Activity.rpt on the Tools menu. The report is generated and opens in the CA ERwin Report Viewer.
2. (Optional) Export or print the report.
3. Click Exit on the File menu to close CA ERwin Report Viewer and return to the diagram.
Advisories Pane

The Advisories pane is a dockable, floatable window in the main workplace. This pane automatically appears when you start the program.

The Advisories pane displays messages associated with actions you perform when working with your model. Each message on this pane shows you when a change or edit you make to a property is valid and alerts you when the action you have taken violates a modeling rule. When alerted, you can immediately correct your action instead of searching for the transaction at some later time.

In addition to viewing the valid and violation messages, you can obtain details about a specific action that generated the message. For example, if you set a property, the Advisories pane shows a “Set Property” message. Click the Details button on the Advisories toolbar to display the Advisories Details dialog and get more information about the property. This feature is particularly useful when you are working with a large model and you need clarification about that particular action.

Overview Pane

The Overview pane provides a smaller, targeted view of the current diagram in the workplace and changes dynamically as you make changes to the current diagram. You can also use the Overview pane to change the view of the current diagram in the workplace by adjusting the overview area or zooming in or out.
Bulk Editor Pane

The Bulk Editor is provided so you can edit a small set of properties over a large number of objects. Changes and updates are immediately committed as you make them, field by field.

The Bulk Editor includes a Bulk Editor Wizard for specifying the data to edit and saving those selections as option sets for use with the model in a future editing session, or shared by all models. Because the Bulk Editor is empty the first time you invoke it in a session, the Bulk Editor Wizard is automatically opened so you can make your object and property type selections. Thereafter, the Bulk Editor is displayed as a modeless grid on a tab page on the CA ERwin Data Modeler main window that shows your selected object instances as rows and your selected properties as columns. You can resize, rearrange, or float the Bulk Editor within the CA ERwin Data Modeler application. Objects are identified by a fully qualified name in the Name column, which is non-editable. A read-only Type column is next to the Name column that displays the object type. You can click the button on the Bulk Editor toolbar at any time to open the Bulk Editor Wizard to change the object instances and properties that appear in the Bulk Editor.

During a session, opening the Bulk Editor or the Bulk Editor Wizard displays the same settings and data as the last time it was shown. These settings are stored independently for each model. This is necessary since different models can have different DBMS targets and contents, so selections of object types, properties, and object instances can be different across models. The configuration settings are stored in the registry, so each user retains their own Bulk Editor settings.
Using the Bulk Editor

The Bulk Editor occupies a pane similar to the Model Explorer or Action Log. Any pane on the CA ERwin Data Modeler main window can be resized, rearranged, or floated above or beside the application. The following illustration shows the Bulk Editor pane beside the application:

For more room to expand each column in the Bulk Editor, simply float the Bulk Editor over the application:
The following describes the basic tasks you can perform in the Bulk Editor:

**Sorting**

Sort is provided by clicking on the column headers in the grid. The columns are resizable. By default the names are sorted in alphabetic order within the *Type* column. When you click on the *Type* column header, the order you specify in the Bulk Editor Wizard is used (alphabetical or reverse order). Because stable sort is used, if you first sort by the *Name* column, then by the *Type* column, the sort order within the *Name* column is preserved within each type. The data in the *Name* column is used in a sort if all other columns are equal.

The sort order is persisted along with the other Bulk Editor settings. To reapply the sort order when reopening the Bulk Editor in a new session, the sequence in which the column sorts were applied must also be saved, so that stable sorts can be reapplied in the same sequence. The same consideration applies within a session when new objects are added to the Bulk Editor, or when the names of existing objects are changed. New objects are placed at the bottom of the grid, and when a name changes for an existing object, its row position does not change. You need to resort all of the rows to change their order. Their row position is determined by resorting all of the rows.

**Editing**

Copy and paste of row data to and from spreadsheet programs, such as Microsoft Excel, is supported. When you attempt to paste cells into the Bulk Editor, CA ERwin Data Modeler checks to ensure that the data types of the pasted cells match the required data type for each property.

You can also copy data from an individual cell, either as text or as a special internal format. The internal format contains property type information so that the value can be pasted exactly into other rows of the grid. Text, whether copied from the Bulk Editor or another application, can be pasted into specific cells pointed to by the mouse. Validation is performed to determine whether the text can be interpreted as data that CA ERwin Data Modeler can accept.

Paste of data into a reference property must use the Bulk Editor internal property format. The text format cannot be used because the name of a reference object cannot be unique.

**Important!** You can only edit the UDP values of UDPs that use either the *String* or *Number* data type in the Bulk Editor. Bulk editing of UDP values that use either the *Date* or *List* data type is not currently supported. Editing of UDP values for UDPs that use *Date* or *List* is only supported using the *User Defined Properties - Logical* or *User Defined Properties - Physical* dialogs.

**Viewing**
The Bulk Editor reacts to any object or property change, whether from the Model Explorer, the diagram, or a dialog. For example, while the Bulk Editor does not have its own Find and Replace dialog, when you use the find and replace feature in CA ERwin Data Modeler, the view in the Bulk Editor is updated once you select the object located within the Find and Replace dialog. When you create a new object, that object becomes the focus of the Bulk Editor.

**Reporting**

You can create your own report of objects and properties in your model using the Bulk Editor. After you have selected the objects and properties in the Bulk Editor Wizard, and also defined user settings and the order in which you want them to display in the Bulk Editor, you can select and copy all row data into another program, such as Microsoft Excel or Word. After copying the data, save or print the file for sharing or documentation purposes.

**Toolbar Features**

To make working with the Bulk Editor easier, you can use the following features on the Bulk Editor toolbar:

- **Previous**
  Navigates to the previous row.

- **Next**
  Navigates to the next row.

- **Undo**
  Specifies to undo the last action.

- **Redo**
  Specifies to redo the last action.

- **Import model updates from .csv file**
  Specifies to import model updates from a .csv file.

- **Save selected rows to .csv file**
  Specifies to save model updates to a .csv file.

- **Copy**
  Copies the selected rows from the Bulk Editor to the clipboard.

- **Paste**
  Pastes rows from the clipboard into the Bulk Editor.

- **Bulk Editor Wizard**
Opens the Bulk Editor Wizard. The Bulk Editor Wizard lets you specify the contents of the Bulk Editor for the current editing session.

Invoke the Bulk Editor Wizard to change object or property selections

Delete

Deletes the selected item from the model.

Edit

Opens the editor for the selected object so you can edit its properties.

Help

Opens the CA ERwin Data Modeler online help application.

Enter filter text

Lets you filter a very large list of objects to more quickly locate a specific object. Any text typed into this field is matched against every cell of the grid. If there is a match on any cell in a row, then that row is shown. If there is no match in any cell of a row, the rows are hidden. Removing the filter text from this field reveals all rows again.
Bulk Editor Wizard

The first time you attempt to open the Bulk Editor in a modeling session it is empty, so the Bulk Editor Wizard automatically opens so you can select the object and property types to work with in the Bulk Editor. Upon subsequent use of the Bulk Editor, you can click the button on the Bulk Editor toolbar to open the Bulk Editor Wizard.

The Bulk Editor Wizard contains the following pages:

**Overview**

Describes the Bulk Editor Wizard and provides a brief explanation for each of the wizard pages. You can select the *Show Object Types on Startup* check box to bypass this page the next time you open the wizard. During a modeling session, the wizard reopens to the same page and has the same settings as its last use in the same model.

**Object Types**

Lets you select the types of objects to use in the Bulk Editor. Selected objects are displayed as rows in the Bulk Editor. The names displayed here are consistent with what is displayed in the Model Explorer. Using this page you can save your selections as an option set, or you can select an existing option set to populate your selections. Narrow this list using the options on the **Object Instances** page. This list of selected object types determines which types of objects are eligible for inclusion in this editing session.

**Property Types**

Lets you select the properties to edit for each object. Selected properties are displayed as columns in the Bulk Editor. The property name is the column heading. Using this page you can save your selections as an option set, or you can select an existing option set to populate your selections.

**Object Instances**

Lets you select the objects from the model to use in the Bulk Editor. This page lists all of the instances of the object types you selected on the **Object Types** page as high level nodes in the selection tree. The names displayed here are consistent with what is displayed in the Model Explorer.

**Display Order**

Lets you specify how to arrange rows for the object types and columns for the properties. The order you specify is how the items display in the Bulk Editor.

**User Settings**

Lets you manage optional behavior of the Bulk Editor.
Property Editors

In a physical model in CA ERwin Data Modeler, you use the physical property editors to work with the relational modeling features of your selected target database. For example, when modeling in Microsoft SQL Server 2008, you can create all the objects and properties for that physical database using the editors provided on the Model menu or in the Model Explorer. The editors are designed with common features that enable you to quickly create and maintain modeling objects.

Editors share these common features:

- Navigation Grid
- Navigation toolbar
- Common tabs and options

Property Editor Navigation Grid

The Navigation Grid in the upper portion of the editor lists all objects of this type in the model, and provides access to frequently used properties. Properties relevant to the object display in separate cells, each with a text entry area, check box, or drop-down control for selecting available values.

You can adjust the amount of space allocated to the Navigation Grid by moving the splitter bar up or down. Columns within the Navigation Grid can be readjusted to be narrower or wider.

Property Editor Toolbar

You can quickly access features for each editor on the toolbar. The toolbar includes the following options:

- **Previous**
  
  Position the editor on the previous object in the Navigation Grid.

- **Next**
  
  Position the editor on the next object in the Navigation Grid.
**Sort**

Sort the objects by alphabetic or reverse alphabetic order. Other sort options may be available on some types of objects.

**New**

Create a new object. It becomes the current object in the editor.

**Delete**

Delete the selected object.

**DB Sync**

Open the DB Sync wizard, where you can perform a database-level compare of objects in the current model with matching objects in another model or database.

**Help**

Access online help for the editor. Help is editor-specific and includes short definitions of all the available properties.

**Note:** These are the basic options available for all editors. Depending on the physical object and target server, some editors will contain additional options on the toolbar.

---

**Property Editor Tabs and Options**

All property editors include tabs in the lower portion of the editor that include specific features relevant to the editor. Other options enable you to undo and redo actions, and display details about an action.
General Tab
Provides the main features and options for the object. When you click a displayed option, such as a drop-down list, additional features display that allow you to enter free text, or select the relevant value.

<Target Server> Tab
Provides advanced options that are specific to the target server of the physical model.

Common Tabs
Provides additional functionality relevant to the object. For example, many editors allow you to enter definitions or notes. Most editors allow you to create User-Defined Properties. Others let you view where an object is used within the model in a Where Used tab. Other tabs are displayed when a link to a related editor is relevant. For example, in databases that allow modeling of security features, a Privilege tab displays that enables you to work with privileges.

Undo/Redo/Details
Provides icons you can click to undo the last action or redo the previous action within the editor. Click the Details button to open the Advisory Message Dialog that displays details about the action.

Property Inheritance Features for Modeling Objects

When you are working in a property editor in either a logical or physical model, buttons are provided where valid that let you manage whether a property value can be inherited, overridden, or hardened. The following visual cues appear where this option is valid:

- **Inherit**
  Specifies to inherit the property value from the parent.

- **Override**
  Specifies to override inheritance for the property value.

- **Harden**
  Specifies to harden the property name.

**Example: Property with Inherit and Override Options**

![Logical Data Type](image)

<table>
<thead>
<tr>
<th>Logical Data Type</th>
<th>Inherit</th>
<th>Override</th>
</tr>
</thead>
<tbody>
<tr>
<td>CHAR(18)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Example: Property with Inherit, Override, and Harden Options

You can also use the toolbar option to open the Reset Properties dialog to select from a list of properties that can have their values reset. This dialog provides a convenient way to reset many properties at once, rather than by a single field in a property editor.

Example: Reset property inheritance using the toolbar in a property editor

Example: Reset Properties dialog for resetting domain properties
Domains

A domain is a model object that you can use to assign properties quickly to an attribute or column. By using domains, you promote consistency because you can reuse a domain as many times as you like in a single or multiple data models.

Domains also reduce the time spent on development and maintenance. If you change the domain, all attributes or columns associated with the domain also change.
Domains

Domain Editor

The Domain Editor lists all the domains for the data model. You can arrange them hierarchically or alphabetically. The Model Explorer has the same list as the Domain Editor and can also be sorted in hierarchical or alphabetic order.

You can create and modify both physical and logical domains using the Domain Editor. Some of the domain properties include:

- Domain name and column name
- Column data type, permission, default value, and valid value
- Domain comment or note and column comment or name
- User defined property
- User notes

Note: The tabs and options in the editor change based on whether the model is logical, physical, or logical/physical. You also cannot change the properties of the standard domains (<default>, Blob, Datetime, Number, and String).
Inherited and Non-inherited Domain Properties

Domains have two types of properties:

- **Non-inheritable properties** do not migrate to child domains or attributes and columns associated with the domain because they are properties of the domain itself.
- **Inheritable properties** do migrate to child domains and to the attributes and columns associated with the domain.

The inheritable and non-inheritable domain name properties appear on the General tab. They also appear on the target database tab (for example, SQL Server) in a physical model.

Attributes and Columns in Domains

When you drag-and-drop a domain from the Model Explorer onto an entity or table, you can add a new attribute to an entity or a new column to a table. The new attribute or column inherits all the inheritable properties, including its name, from the domain.

Drag a Domain from the Model Explorer to Your Model

Use drag-and-drop to add a domain directly from the Model Explorer to an entity or table in your model.

**To drag a domain from the Model Explorer to your model**

1. Expand the list of domains in the Model Explorer and click the domain that you want to add to your model.
2. Drag and drop the domain onto the entity or table in your model.
   - The domain is added as an attribute or column.
   - **Note:** Depending on the Unique Naming rules that apply to the data model, you may be prompted to rename each attribute or column that you add because the domain's name is automatically assigned to each new attribute or column.

Creating New Domains

You can work with features in the Domain Editor to create a new domain in addition to the default domains supplied with CA ERwin Data Modeler. You can use the Domain Editor to create a domain while you are in a logical model (logical edit mode) or a physical model (physical edit mode), but the editor’s options change depending on the edit mode.
Add a Domain in the Logical Edit Mode

The Domain Editor lets you define properties for columns; you can create a domain and attach it to any number of columns instead of defining properties for each column individually. You can work with features in the Domain Editor to add a domain to the logical model.

To add a domain in the logical edit mode

1. Click Domains on the Model menu.
   
   The Domain Editor opens.

2. Click the New button on the toolbar.
   
   A new domain with a default name is added to the Navigation Grid. It is placed in the list in alphabetical order.

3. Work with the following options in the Navigation Grid:

   **Name**
   
   Displays the name of the domain in the logical model. When you add a new domain, a default name is automatically assigned. You can change the domain name in this field using in-place editing.

   **Note:** Duplicate domain names are not allowed.

   **Domain Parent**
   
   Displays the current parent domain. You can change the domain using the drop-down list.

   **Logical Data Type**
   
   Specifies the logical data type for the domain. You can change the data type using the drop-down list. The drop-down list contains the data types related to the current domain.

   **Logical Only**
   
   Specifies whether the domain should only appear in the logical model. Select this check box if you want the selected domain to appear in the logical model only. Clear this check box if you want the selected domain in the physical model. If you are working with a logical-only model and select this check box, when you derive a new physical-only model, the selected domain does not appear in the new model.

   **Note:** When you select or clear the check box in the Navigation Grid, your selection is automatically reflected in the Logical Only check box in the General tab.

4. Work with the other tabs in the editor to further define the domain properties.

5. Click Close.

   The domain is added to the logical model and the Domain Editor closes.
Add a Domain in the Physical Edit Mode

You can work with features in the Domain Editor to add a domain to the physical model.

To add a domain in the physical edit mode

1. Click Domains on the Model menu.
   The Domain Editor opens.
2. Click the New button on the toolbar.
   A new domain with a default name is added to the Navigation Grid. It is placed in the list in alphabetical order.
3. Work with the following options in the Navigation Grid:
   **Physical Name**
   Displays the name of the domain in the physical model. When you add a new domain, a default name is automatically assigned. You can change the domain name in this field using in-place editing.
   **Domain Parent**
   Displays the current parent domain. You can change the domain using the drop-down list.
**Physical Data Type**

Specifies the physical data type for the domain. You can change the data type using the drop-down list. The drop-down list contains the data types related to the current domain.

**Anchored to Type**

Specifies whether the domain is anchored to a column or a variable. This column is enabled only for a DB2 LUW user defined data type.

**Schema**

Specifies the schema associated with the domain.

**Distinct Type**

Specifies whether the domain is of distinct type.

**Physical Only**

Specifies whether the domain should only appear in the physical model. Select this check box if you want the selected domain to appear in the physical model only. Clear this check box if you want the selected domain in the logical model.

**Note:** When you select or clear the check box in the Navigation Grid, your selection is automatically reflected in the Physical Only check box in the General tab.

4. Work with the other tabs in the editor to further define the domain properties.

5. Click Close.

The domain is added to the physical model and the Domain Editor closes.

**Assign a Data Type to a Domain**

A data type is a domain property and defines the physical properties of a column in a database such as length (number of characters), type (alpha or numeric), and precision (decimal). You can also define a logical data type, which usually corresponds to a physical data type.
By default, a new domain is assigned the same data type as its parent domain. You can change it at any time. The available data types for the current model always appear in the drop-down selection in fields where the data type is defined in the Domain Editor.

To assign a data type to a domain
1. Click Domains on the Model menu.  
The Domain Editor opens.
2. Select the domain in the Navigation Grid for which you want to assign a data type. Use the Enter filter text box to filter a large list to quickly locate the domain.
3. Select a new data type for the domain using the drop-down list in the Logical Data Type column (logical edit mode) or the Physical Data Type column (physical edit mode) in the Navigation Grid.
4. Click Close.  
The data type is assigned to the domain and the Domain Editor closes.

Domain Icons

In the Model Explorer and in the Domain Editor, a unique icon represents each domain. A default icon is used for new domains, but you can choose a different icon to represent the domains you create.

Assign or Change a Domain Icon

You can assign any image (.bmp file) as the icon for the non-inheritable property of the domain itself. You can assign the same image or select a different image that the attributes or columns associated with the domain can inherit.

Note: You can change the domain icon only in the logical model.

To assign or change the domain icon
1. Click Domains on the Model menu.  
The Domain Editor opens.
2. Select the domain in the Navigation Grid that you want to work with and click the General tab.
3. Specify the image to use in the Image drop-down or click the New button to open the Image Editor and create a new one.
4. Click Close.  
The icon is assigned to the selected domain.
Relationships

In a data model, a relationship shows an association between two entities or tables. A relationship is represented as a solid or dashed line that connects two entities or two tables. Depending on the notation you choose, the symbols at either end of the line can change.

If you prefer to work in the Model Explorer, you can see the parent and child relationships for each entity and table in the Model Explorer. Double-click any of the relationship folders to open the Relationship Editor.

Entity Relationships

The following diagram shows the relationship between the CUSTOMER entity and the MOVIE RENTAL RECORD entity using Integration DEFINition (IDEF1X) notation:

The following Entity-Relationship data model uses entities and relationships to represent the logical structures that will eventually become the physical tables in a database. A box is used with a horizontal line to depict an entity and solid or dashed connecting lines to depict a relationship between two entities.
Other Relationship Types

In addition to identifying and non-identifying relationships, you can also create these relationships:

- **Identifying relationship**
  - CUSTOMER → ORDER

- **Non-identifying relationship**
  - CUSTOMER → PAYMENT

- **Recursive relationship**
  - EMPLOYEE

- **Many-to-many relationship**
  - ORDER → PRODUCT

- **Supertype/Subtype relationship**
  - PAYMENT
    - CHECK
    - CREDIT
Relationships

Relationship Creation

You can create relationships in multiple ways. The easiest way to create a relationship is to use the Relationship tool in the Toolbox. Depending on the model type (logical or physical) and the diagram notation, the relationship tools in the toolbar vary.

Before you create a relationship, consider whether you want the foreign keys to migrate to the primary key area or the non-key area of the entity or table.

Relationship Lines

After you create a relationship line or rearrange existing lines, the line position is saved so that routine modeling tasks, such as switching between logical and physical models with the same display level, do not result in a rearrangement of any of the relationship lines.

When you click a relationship line, the line is highlighted with a shadow. This lets you see the selected line more clearly.

You can format relationship lines in the current diagram by clicking Relationships on the Model menu, selecting the relationship to format in the Navigation Grid, and working with the options on the Style tab.

You can set default formatting for all relationship lines in the model by clicking Themes on the View menu and working with the options on the Relationship tab.

You can also choose to automatically layout the currently selected relationship line by right-clicking the line and selecting Reset Relationship Path from the shortcut menu.

Relationship Editor

After you create a relationship, you can double-click the relationship line to open the Relationship Editor. You can edit many of the relationship’s properties including:

- Parent and child verb phrases
- Relationship definition
- Rolename
- Referential Integrity
- Cardinality
Verb Phrases

A verb phrase describes how two entities are related. You can create two types of verb phrases:

- **Parent-to-child** verb phrases describe how the parent is related to the child. In the first example below, the verb phrase states “A STORE rents A MOVIE.”

- **Child-to-parent** verb phrases describe how a child entity is related to a parent entity. In the second example below, the verb phrase states “A MOVIE is rented from A STORE.”

![Diagram of parent-to-child relationship between STORE and MOVIE entities]

![Diagram of child-to-parent relationship between MOVIE and STORE entities]

**Note:** You can enter parent and child verb phrases using on-diagram editing.

Foreign Key Migration and Unification

When you create a relationship between entities, the primary key attributes of the parent entity are automatically migrated to the child entity. The designator (FK) indicates the name of the migrated key attribute, also known as a foreign key. This migration occurs automatically in the physical model.

If the foreign key attribute has the same name as an owned attribute in the child entity, the two instances are automatically unified into one attribute because it assumes that they are the same attribute. The process of combining or unifying identical attributes in an entity is called unification.
**Rolenames**

Sometimes, unification is not the acceptable behavior. You may want to maintain a distinction between multiple attributes with the same name in an entity because each serves a different purpose. In this situation, you can assign a rolename, which is similar to an alias that you assign to a foreign key.
Views

In a physical model, you can create a view, which is a SQL query that is permanently stored in the database under assigned names. Typically, a view is used to present specific database information for a target audience. In the following example, the accounting department of a video store chain presumably uses the CUSTOMER INVOICE view to generate a billing invoice.

A view is really a virtual table; a view table (box) and relationship line are both drawn with dashed-lines.

In the physical model, you can use view tools in the toolbox to draw the view table and connect the view relationship to a source table. Behind the scenes, the SQL query is written for the view, which you can view and edit in the View Editor.

You can use views in SQL to perform the following tasks:

- Create a customized presentation of the data stored in the database.
- Restrict access to data, allowing different users access to only certain rows or columns of a table.
- Simplify database access by creating customized structures tailored to the needs of individual users. A user can write a simple query on a view rather than a complex query on the actual database tables.
Methods for Adding a View to a Model

You can add a view using any of the following methods:

- Click the View Table button on the Toolbox, and then click in the diagram window.
- Reverse engineer an existing database.
- Copy a view from one model and paste it into another model.
- Right-click the Views folder in the Model Explorer and choose New.

Display Levels

Two sets of display levels are provided, one for the logical model and one for the physical model.

These display levels are useful for showing different types of information in a data model, particularly when different people and groups use the data model for their specific job in the development process.

Logical Display Levels

The Logical Display levels are as follows:

**Entity**

Displays the name of each entity in a data model inside an entity box. No other information displays for the entity.

**Attribute**

Displays the attributes for each entity in a data model, with the primary key attributes above the line and the non-key attributes below the line in an entity box.
Primary Key

Displays the primary key attributes (those found above the line in an entity box) for each entity in a data model. The attributes below the line are hidden, but display when you switch back to the Attribute Display Level and you can also see them in the Attribute Editor.

Keys

Displays primary key attributes above the line and does not display any non-key attributes below the line in an entity box. Entity boxes have two attribute boxes; the upper populated with the PK attributes and the lower populated with the attributes belonging to all key types except PK.

Definition

Displays the definition for each entity in a data model.

Icon

Displays the bitmap, if you have assigned one to the entity. You can assign a different bitmap to each entity in the Icon tab of the Entity Editor.

The following diagram uses the same entities and illustrates each of the logical display levels:
Physical Display Levels

The Physical Display levels are as follows:

**Table**
Displays the name of each table in a data model inside a box. No other information displays for the table.

**Column**
Displays the columns for each table in a data model, with the primary key columns above the line and the non-key columns below the line in a box.

**Primary Key**
Displays the primary key columns (those found above the line in a table box) for each table in a data model. The columns below the line are hidden, but display when you switch back to the Column Display Level and you can also see them in the Table Column Editor.

**Keys**
Displays primary key columns above the line and does not display any non-key columns below the line in a table box. Table boxes have two column boxes; the upper populated with the PK columns and the lower populated with the columns belonging to all key types except PK.

**Comment**
Displays the comment for each table in a data model.

**Icon**
Displays the bitmap, if you have assigned one to the table. You can assign a different bitmap to each entity in the Icon tab of the Table Editor.

**Physical Order**
Displays the order in which each column appears in the corresponding table.
Subject Areas

A subject area is a subset of objects taken from the whole pool of objects in your diagram.

It is important to understand that the subject areas are not copies of the data model, but are dynamic subsets of the data model. In other words, if you add members to a subject area those objects are added to the current subject area.

If you add an attribute or column to an existing entity or table, the new object is added to every subject area in which the entity or table is a member.

Subject Area Members

An object that is included in a subject area is referred to as a member of a subject area. A member can also belong to one or more other subject areas in the same data model.
Subject Areas

Subject Areas in the Logical/Physical Model

For every subject area in a Logical/Physical model, a corresponding subject area is automatically created for the other model type. So, if you create a Customer subject area in logical model, a Customer subject area is also created in the physical model.

The Subject Area Editor

In the Subject Area Editor, you can perform these tasks:

- Create a new subject area
- Add members to a subject area
- Create a definition for a subject area
- Define user-defined properties
- Modify the properties of a subject area
- Delete a subject area

Create a New Subject Area in the Subject Area Editor

You can use the features in the Subject Area Editor to create a new subject area.

To create a new subject area

1. Click Subject Areas on the Model menu.
   The Subject Area Editor opens.
2. Click the New button on the toolbar.
   A new subject area is added to the Navigation Grid with a default name.
3. Work with the following options:

   **Name**
   Specifies the subject area name. You can change the name of the subject area in this field.

   **Auto-populate**
   Specifies to populate the new subject area with the objects of the current model.

4. Click the General tab and work with the following options:

   **Common Properties**
   Lets you specify the subject area author name and whether to filter dangling relationships from schema generation.

   **Optional Theme**
   Lets you specify the theme to apply to the subject area. The theme defines formatting styles to use, which include text font, diagram fill, and colors for subject area objects such as tables and relationships.

5. Click the Members tab and use the arrows to manually include the objects in the new subject area.

6. (Optional) Click the Definition tab to enter definition text to describe the subject area for documentation purposes.

7. (Optional) Click the UDP tab to specify any user-defined properties.

8. Click OK.

   The Subject Area Editor closes, and the new subject area appears in the Diagram Window.
Spanning Neighborhoods

A quick way to add members to a subject area in the Subject Area Editor is to click the button on the Available Objects toolbar to move selected objects and neighboring objects to Included Objects. This opens the Spanning Neighborhood dialog.

In the Spanning Neighborhood dialog, you can specify the level of ancestors and descendants you want to automatically include in the subject area. Ancestors are the parents and grandparents of an entity. Descendants are the children and grandchildren of an entity.
Subject Areas in the Model Explorer

The Model Explorer provides a quick view of the subject areas in the data model. You can view them in the following ways:

- In the Model pane, you can see the Subject Areas along with all of the other data model objects.
- In the Subject Area pane, you can view all of the subject areas at a glance.

Index Tables

Just as an index in a book helps you quickly find information by listing all the pages where a particular topic is discussed, an index in a database table points to all the rows where a particular column value is stored.

An index table helps to quickly locate a record in a database by pointing to a specific column and row in a table. So, for example, to locate a customer in the database, an index on the CUSTOMER table references the Customer Number (account number).

You can use indexes in two ways:

- To sequentially access the indexed file.
- To directly access individual records in the indexed file based on a given value for the indexed field.
Types of Indexes

The following types of indexes are supported:

**Primary Key (PK) Index**

A primary key index is an index for the primary key columns in a particular table.

You can have only one primary key index for each table, although each index can include multiple columns.

A primary key index is unique, so the indexed columns cannot have duplicate values nor can they be null (empty). For example, a customer phone number must be unique in order to locate a particular customer record.

A primary key index for each table that has one or more primary key columns is automatically created.

**Foreign Key (FK) Index**

A foreign key index is an index for one or more foreign key columns in a particular table. A foreign key index is automatically created for each set of foreign key columns that migrate through a relationship.

**Alternate Key (AK) Index**

A unique index that provides an alternative unique index in addition to the primary key index. For example, to locate a customer quickly, the primary key index may include only the customer account number. As an alternative, the alternate key index may include the customer phone number column, which must be a unique number associated with a customer record.

**Inversion Entry (IE) Index**

A non-unique, or inversion entry index lets you quickly access records using values that are not unique, such as EMPLOYEE last name. Duplicate values in the inversion entry index are allowed.

In a Logical/Physical model, if you create an index in the physical model, the corresponding key group in the logical model is automatically created. A key group is a logical modeling tool that identifies relationships between entities that are implemented as foreign keys. You can also use key groups to identify potential primary keys or alternate keys for use in the physical model.

**Unique and Non-Unique Indexes**

Imagine a database for a video rental chain. It probably has hundreds of thousands of customer records. However, when it is time to check out a video, it is important for each customer record to be quickly located for better customer service.

If the video store clerk knows the customer account number, the customer’s record is found quickly because the Primary Key index references a unique customer number.
Often the customer account number is not available. But, a customer record is found quickly if the video store database has another *unique index* that points to the Customer Last Name and Customer Phone columns.

Alternatively, the video store may also want to look up a customer record by last name, even though the search may produce multiple records.

In this case, a *non-unique index* may be created on the CUSTOMER table that points to the Customer Last Name column alone.
The Table Index Editor

In the physical model, you can use the Table Index Editor to perform the following tasks:

- Create, rename, or delete an index
- View the indexes for a table
- View the properties of an index
- Use the Members tab to view all the available columns in the table and those columns already assigned to the index

Depending on the target database, other index properties may be available.

**Note:** By default, the Primary Key index is automatically created. It is unique and includes all primary key columns.

Create an Index in the Table Index Editor

Only one Primary Key index can apply to a table, although you can create multiple AK (unique) or IE (non-unique) indexes. You use the Table Index Editor to work with table indexes in a physical model.

**To create an index in the Index Editor**

1. Right-click a table in the diagram and click Index Properties.
   The Table Index Editor opens.
2. Click the New button on the toolbar.
   A new index is added to the Navigation Grid with a default name, which you can accept or change.
3. Work with the following options:

   **Show FK Indexes**
   
   Specifies to display FK (foreign key) indexes in the Navigation Grid. Select the check box to enable this option.

   **Physical Name**
   
   Specifies the physical name of the table index. You can change the physical name of the table index in this field.

   **Type**
   
   Displays key designation of the table index.

   **Is Unique**
   
   Specifies if the table index is unique or non-unique. Select the check box if it is a unique index.

   **Physical Only**
   
   Specifies whether the table index should be suppressed from a logical model and appear in a physical model only.

   **Generate**
   
   Generates SQL during forward engineering. Clear the check box if you do not want to generate SQL.

   **Note:** Depending on your target server, there can be more options.

4. Click the Members tab to specify table index members.

5. Click the General tab to define any additional table index properties.

6. Click the Options tab to further define the table index.

7. (Optional) Click the Comment tab and enter any comments that you want to associate with the table index.

8. (Optional) Click the Where Used tab to view where the table index is used in the model.

9. (Optional) Click the UDP tab to work with user-defined properties for the table index.

10. (Optional) Click the Notes tab to view history information and view or edit user notes.

11. Click Close.

    The table index is created and the Table Index Editor closes.
Find and Replace

You can use the Find and Replace feature to globally search for anything that is exposed in the model (including all string properties) and optionally replace with the text specified. You can use features such as matching case, wild cards, and search direction. This gives modelers the ability to make changes across large models to ensure consistent metadata.

Note: The Find and Replace feature does not replace Find functionality already implemented elsewhere in the program (such as the Model Explorer, Action Log, Bulk Editor, or Complete Compare).

To use the Find and Replace option
1. Click Find on the Edit menu.
   The Find and Replace dialog opens.
2. Enter the text you want to find and select from the following options:
   - **Match Case**
     Searches text based on case. When cleared, the case is ignored to determine match.
   - **Match whole word**
     Searches for the entire text string to determine match.
   - **Match against expanded values**
     When selected, macros are expanded first then the match is determined on the expanded value. Table and view names are macros by default, unless they are specifically overridden.
   - **Wildcard**
     Selects DOS or SQL wildcards to determine match. For example, use the asterisk (*) wildcard to search for a string of characters ("c*r" finds "customer" and "car").
   - **Search direction**
     Selects which direction within the model to search the text-- forward or backward. The default is Forward.

Select the Replace check box if you want to replace the text found, and click Find to start the search.

If the text is found, it appears below in the Found object and property pane. You can click Replace to replace the text found with the new text in the Replace field.

Note: You can also directly edit the text in the Found object and property pane if the property is not marked as Read-only. If you edit the text in the property pane and click Replace, then the text in the property pane is used as the replacement text and not the text in the Replace with field.
If the search text is not located, a message states that no matches were found.

3. Click Find Next to repeat the last search you specified and find the next occurrence of the text.

The next occurrence is selected. The search terminates when it reaches the end of the model. You will be prompted that there are no more matches and if you like to restart the search from the beginning of the model.

**Forward Engineering**

Forward engineering is a process that generates the physical database schema from the data model. Use the Forward Engineering feature to design and create your database *without* writing a single SQL CREATE TABLE or CREATE INDEX statement.

When you generate a schema, you can choose to generate:

- Tables
- Triggers
- Stored procedures
- Indexes
- Constraints
- Physical storage objects
- Other database features supported by your target DBMS

Using forward engineering, you can choose to generate a script file, which you can use to update the database using a database administration tool, or you can directly connect to the database catalog. Either way, most of the work is done for you by generating the script for your target server.
Before you forward engineer, you can view the schema, which is a text-based representation of the database objects that will be created in the database from the script. The data definition language (DDL) specific to the target database is used to write the script. Each time you add an object or property to your data model, the script file is automatically updated to reflect the change to the data model.

**Preview Schema Generation**

You can preview the schema generation of a model before executing the forward engineering process.

**To preview schema generation**

1. Click Open on the File menu, and choose a logical/physical model you previously saved.
2. Use the Logical/Physical Selector to switch to the physical model.
3. Click Forward Engineer, Schema on the Actions menu.
   The Forward Engineer Schema Generation dialog opens.
4. Click Preview.
   The Schema Generation Preview dialog opens, similar to the following example:

![Schema Generation Preview](image)

The Preview Schema screen is similar to a text editor.
5. Edit the schema by typing directly in the editor or use the toolbar at the top of the editor to perform other common text processing functions.

6. Click the Save button to save your changes, or click Generate to generate the schema. Click Close to close the Preview window.

You are returned to the Forward Engineer Schema Generation dialog.

**Change Schema Generation Options**

You can view and set schema generation options by category. The target server you select determines the options that appear in the editor.

**To change the schema generation options**

1. Select Forward Engineer, Schema from the Actions menu.

The Schema Generation Editor opens. The left panel lists all the categories and the right panel lists all the options for the selected category.
2. Make your selections in the right panel of the Options tab, or click the Summary tab to view the default options.

3. Click OK when you are finished.

   The Schema Generation Editor closes.

**Additional Schema Generation Options**

A full range of options is available for generating a schema. Use these additional options for refining your output:

**Check Model**

Creates a Model Validation report before you forward engineer your model. The report checks for corrupt objects and reports other errors associated with correct forward engineering. To run the report, click Forward Engineer, Check Model on the Actions menu.

**Using Option Sets**

Lets you save the selections you make in the Options tab to an external XML file, or you can save the selections with the model. Click Save As to save your current option set. You can also share option sets with other users. If you want to use an option set you created earlier, click Open to select the XML file.
Filtering Tables

Lets you filter out selected tables for the schema generation when you click the Filter button. By default, all tables in your model are included in the schema generation. A selection dialog opens that lets you move selected tables out of the list of tables included in the schema generation.

Setting an Owner Override

Lets you set a global name override, or a name override for other physical objects relevant to your target server, such as tables, views, and triggers.

Generate the Schema

You can preview your schema as many times as you want. When you are satisfied with the content of the schema, you can generate it to your target server.

To generate the schema

1. Start the schema generation process using one of these methods:
   - From the Preview dialog, click Generate.
   - From the main Forward Engineer Schema Generation dialog, click Generate.
   The <database> Connection dialog opens.
2. Enter the required connection criteria. Click Connect.
   The schema generation process begins.
   As the schema is generated, you receive status information. When you select the Stop If Failure check box in the dialog, you can choose to Continue or Abort the generation.

   ![Generate Database Schema dialog]

   Note: To fix an error found during generation, click Abort and then return to the Schema Preview dialog, where you can find and correct the source of the error.
Save the Script File

You can save or print your script file. You may want to save the script as a report that contains all the queries, and success or failure messages for your schema.

To save the script file
2. Enter a file name in the File Name box, and click Save.
3. Click OK.
   The Forward Engineer Schema Generation dialog closes.

Generate Alter Scripts

The Schema Generation functionality includes the capability to quickly generate alter scripts. When you make changes to your physical model you can synchronize them with your database or script file.

This process describes how you utilize the alter scripts functionality:
- In your changed model, click Forward Engineer, Alter Script on the Actions menu to open the Alter Script Schema Generation dialog.
- Click Preview to review the changes to your schema, and then click Generate to generate the alter script to your database.

  Note: If you are not connected to your target server, you are prompted to make the connection before the schema generation starts.

Alter script (see page 151) functionality is also included in the Resolve Differences dialog of the Complete Compare Wizard (see page 132).
Chapter 5: Working with Data Design Features

This section contains the following topics:

Reverse Engineering (see page 121)
How to Use the Metadata Integration Wizard (see page 127)
Complete Compare (see page 131)

Reverse Engineering

You can create a data model by *reverse engineering*, which is a process that takes advantage of an existing database to speed the design of a new data model and the subsequent delivery of new systems. The process of reverse engineering saves considerable time because the work of creating a new data model directly from the database is done for you.

When you have an existing database from which you want to create a data model, you can reverse engineer the database schema, which is converted into a graphical representation of the database structures in a new model.

The following diagram illustrates the reverse engineering process:
Information in your database or script file is captured, including:

- Tables
- Columns
- Relationships
- Triggers
- Stored procedures
- Validation rules
- Physical storage properties

Database Connection Overview

CA ERwin Data Modeler provides a gateway to your physical database using the Database Connection dialog. You use this dialog to enter connection criteria. Once the connection is established, you work directly with the physical catalog as you use CA ERwin Data Modeler modeling tools.

Review the basic requirements for establishing database connection before you attempt to connect to a database.

- Verify that the database you plan to work with is supported by CA ERwin Data Modeler. The current list of supported databases and versions appears in the CA ERwin Data Modeler Release Notes, and in the ERwin Data Modeler - Target Server dialog.

- Select the database and version in the ERwin Data Modeler - Target Server dialog. Click Target Database on the Actions menu in the physical model view to open this dialog. The database that you select in this dialog is used to display connection parameters on the <Database> Connection dialog.

- Install the appropriate client database software on the machine you want to connect from (and which is running CA ERwin Data Modeler). You must use a direct physical connection to the database, not a gateway or proxy connection.

- If your target server is SQL Server, Oracle, or Teradata, you can use Windows Authentication to connect. Before you use this connection option, check with your Database Administrator to be sure Windows Authentication is set up for your Windows account.

- Verify your User Name and Password information if you plan to use the database connection option.

- Know other details about database parameters/values needed to connect, for example, the server and database name, the connection string, the alternate catalog, and so on as is appropriate for your target server.
**Template Selection**

Whether you reverse engineer from a script or directly from a database, you can select a Physical or a Logical/Physical template. When you select a template, consider the design layer hierarchy and where the data model that you create by reverse engineering fits in the hierarchy. For example, you may want to begin with a physical model and then derive other models from that source. Or, you may want to reverse engineer a logical/physical model and split that model into separate logical and physical models. You can then use either model as a source for other models in the design layer hierarchy.

**Options for Reverse Engineering**

Additional steps in reverse engineering involve:

- Choosing the database objects and properties that you want to import
- Selecting physical database options
- Specifying whether you want to infer primary keys or relationships from indexes
- Setting case conversion options

The options and the object list vary depending on the database or SQL file that you intend to reverse engineer.
Set Model Type, Template, and Database For Reverse Engineer

The first step to reverse engineer a database or script file is to indicate the model type, template, and database. These choices affect the options that are displayed on the Reverse Engineer - Set Options dialog.

To set model type, template, and database for reverse engineer

1. Click Reverse Engineer on the Actions menu. 
   The Reverse Engineer - Select Template dialog opens.
2. Work with the following options:

   **New Model Type**
   Specifies the model type for your new model. You can choose physical-only, or logical/physical.

   **Create Using Template**
   Specifies the template for your new model. This field has the following options:

   **Remove**
   Removes a selected template from the list. You cannot delete the default template file.

   **Browse File System**
   Browses your file system to select the template that you want to use for the new model.

   **Browse ERwin MM**
   Opens the Open dialog where you can select the template that you want to use for the new model.

   **Target Database**
   Specifies the target SQL or Desktop DBMS and version for the new model.

3. Click Next.
   The Reverse Engineer - Set Options dialog opens, where you select options for reverse engineering specific objects and properties.
Set Options for Reverse Engineer

After you select the model type, template, and database, you set options to reverse engineer specific objects.

To set options for reverse engineer

1. Click Reverse Engineer on the Actions menu.
   The Reverse Engineer - Select Template dialog opens.

2. Select the new model type, template, and target database, then click Next.
   The Reverse Engineer - Set Options dialog opens.

3. Work with the following options:

   Reverse Engineer From
   Select to reverse engineer from a database or script file. If you choose script file, click Browse to select the file.

   Items to Reverse Engineer
   Displays the default option set, which includes all the objects and properties for the selected target server. You can create and save a new option set based on your requirements. Select or clear an object or property from the object tree to include or exclude it from the reverse engineer.

   Reverse Engineer System Objects
   Select to reverse engineer system and user tables, or only user tables. This field is only available when you reverse engineer from a database.

   Table/Views In Owner:
   Select to reverse engineer tables and views by ownership. This field is only available when you reverse engineer from a database. This field has the following options:

   All
   Reverse engineer all tables and views in the database, regardless of the owner.

   Current
   Reverse engineer only those tables or views owned by the current user as entered in the <Database> Connection dialog.

   Owners (comma separated)
   Filter the tables or views that are reverse engineered to the tables or views owned by the owner name or names (separated by commas) specified in this box.

In
Opens the Filter By Table Container dialog to select one or more TABLESPACEs or databases that you want to reverse engineer.

Infer

Indicate if you want to infer primary keys and relationships during reverse engineer. This field includes the following options:

Primary Keys

Infer primary key columns for tables based on defined indexes.

Relations

Infer relationships between tables based on either primary key column names or defined indexes, based on the Indexes and Names options.

Indexes

Infer relationships from the table indexes. When you click this button, the relationship between two tables is inferred only if the primary key columns of the parent table are in an index in the child table.

Names

Infer relationships from the primary key column names. When you click this button, a relationship is inferred between two tables if all of the primary key columns of the parent are in the child table.

Note: If the target database or DDL script file supports primary key and foreign key declarations, you do not need to use the Primary Keys, Relations, Indexes, or Names options.

Case Conversion of Physical Names

Select a choice for case conversion of physical names. You can convert names to lower or upper case, or select 'None' to preserve the case exactly as it appears in the script file or database.

Case Conversion of Logical Names

Select a choice for case conversion of logical names. You can convert names to lower or upper case, or select 'None' to preserve the case exactly as it appears in the script file or database. Select 'Mixed' to preserve mixed-case logical names.

Include Generated Triggers

Specify whether or not ERwin-generated triggers are loaded during the reverse engineer process. This option is linked to the "Automatically Create RI Triggers" setting in the Model Properties dialog, RI Default tabs. When you choose to Automatically create RI triggers, the triggers are treated as model objects and can be forward-engineered into a model, database, or script file. You can include or exclude these triggers when you reverse engineer.

4. Click Next.
The database or script is processed and appears as a new model in the main workspace.

**Note:** When you reverse engineer from a database, you are prompted to connect to the database. If processing errors occur, a dialog displays that allows you to evaluate, display details for, and save the error message.

### How to Use the Metadata Integration Wizard

You can load a wide variety of models generated by other sources into a data model. Technology from Meta Integration Technology, Inc. is embedded with CA ERwin Data Modeler to provide integration capabilities with about 100 industry-leading metadata products in the form of a wizard.

There is a different wizard depending on what you need to do. To convert data from another application into a format supported by CA ERwin Data Modeler, use the Import from External Format wizard. To convert data from a CA ERwin Data Modeler model to a format supported by another application, use the Export to External Format wizard.

You use the Import from External Format wizard to do the following:

- Select the source data and other configuration parameters for the import in the Source page.
- Select the import configuration parameters for the data model data in the Destination page.
- Click the Finish button to complete the import process.

You use the Export to External Format wizard to do the following:

- Select the source data and other configuration parameters for the export in the Source page.
- Select the export data and configuration parameters for the export in the Destination page.
- Click the Finish button to complete the export process.

When you invoke either wizard for the first time, all fields are populated with default values. When you invoke either wizard again, the fields are populated with the values you entered previously.

For a list of supported bridges, see [Supported Metadata Integration Bridges](#) (see page 211).
Set Options for Import from External Format

Set the options and parameters you require in the Import from External Format wizard to convert data from another application into a format supported by CA ERwin DM.

1. Select Import, From External Format on the File menu to open the Import From External Format wizard at the Overview page.
2. Read through the overview information if necessary. You can clear the check box so that when you launch the wizard, it starts at the Source page instead of the Overview page.
3. Work with the following fields on the Source page:
   - **Type**
     Select a source type from which you want to import from the dropdown. This list is populated with the currently available bridges.
   - **Location**
     Specify the location of the source file that you want to import. You can either enter the file name and location in the box, or click the button to open the Open dialog to search for and select the file. If you do not have a file and location specified, the page is invalid and the Finish button is disabled.
   - **Validation**
     Specify the type of validation that you want to perform on the import from the drop down list.
   - **Parameters**
     Edit the parameter values for the selected model source type within the grid as needed. You click on a parameter and then enter a value in the Value column. Required parameters have a red flag. If you do not enter a value for a required parameter, the page is invalid and the Finish button is disabled.
4. Work with the following fields on the Destination page:
   - **Location**
     Displays the location that you selected on the Source page. This is the location to which the imported file will be saved. The same file name is used but the file extension will be that of an CA ERwin DM model. If a file by this name already exists, then the import appends a number to the file name. For example, if you already have a file name of test.erwin, the import creates test1.erwin, and so on. You must have a location specified in the Location field, or you will not be able to complete the import process. Click the button to open the Save As dialog to change the location of where the model will be imported and saved.
   - **Open Model**
The Open Model check box is selected by default. You select this check box to open the CA ERwin DM model you specified in the Location field. If you do not select the check box, the model is still saved, but it is not loaded into CA ERwin DM.

**Parameters**

Edit the parameters for creating the *.erwin or *.xml file as needed. You click on a parameter and then enter a value in the Value column. Required parameters have a red flag. If you do not enter a value for a required parameter, the page is invalid and the Finish button is disabled.

5. Click the Finish button to start the conversion process.

**Note:** The tip text area located at the bottom of each page displays helpful information about the active (selected) field.

**Disabled Location Field for Certain Import Bridges**

For certain import bridges, Metadata Integration requires multiple input files to complete the import, rather than a specific location of one source file. When this is the case, the Location field on the Source page of the Metadata Integration Import Wizard is disabled. You must provide a bridge parameter in the Parameters grid that will specify the directory name of where the input files are located.

The import bridges to which this applies are as follows:

- CA COOL:Biz 5.1
- CA COOL:Enterprise (ADW) 2.7
- CA COOL:Xtras Mapper (TerrainMap for DB2)
- CA Gen 4.1a to 7.5
- Meta Integration Repository (MIR) XMI multimodel content
- Microsoft SQL Server Analysis Services 7.0 to 9.0 (via DSO)
- Microsoft SQL Server Reporting Services (File)
- MicroStrategy 7.0 to 8.1
- Telelogic (Popkin) System Architect 10.4 to 11.x (Encyclopedia)
- Telelogic (Popkin) System Architect 7.1 to 11.x (File)
- Visible IE:Advantage 6.1
Set Options for Export to External Format

Set the options and parameters you require in the Export to External Format wizard to convert data in an CA ERwin Data Modeler model to a format supported by another application.

1. Select Export, To External Format on the File menu to open the Export to External Format wizard at the Overview page.

2. Read through the overview information if necessary. You can clear the check box so that when you launch the wizard, it starts at the Source page instead of the Overview page.

3. Edit the parameters for exporting the *.erwin file as needed on the Source page. You click on a parameter and then enter a value in the Value column.
   
   Note: The export process will not complete unless you have saved the model before you start the export process.

4. Work with the following fields on the Destination page:

   **Type**
   Select a destination type to which you want to export from the drop down list. This list is populated with the currently available bridges.

   **Location**
   This is the location to which the exported file will be saved. The same file name is used, however if a file by this name already exists, then the export appends a number to the file name. For example, if you already have a file name of test.dsx, the export creates test1.dsx, and so on. You must have a location specified in the Location field, or you will not be able to complete the export process. Click the button to open the Save As dialog to change the location of where the model will be exported and saved.

   **Parameters**
   Edit the parameter values for the selected destination type within the grid as needed. You click on a parameter and then enter a value in the Value column. Required parameters have a red flag. If you do not enter a value for a required parameter, the page is invalid and the Finish button is disabled.

5. Click the Finish button to start the conversion process.

   **Note:** The tip text area located at the bottom of each page displays helpful information about the active (selected) field.
Disabled Location Field for Certain Export Bridges

For certain export bridges, Metadata Integration requires multiple output files to complete the export, rather than a specific location of one file. When this is the case, the Location field on the Destination page of the Metadata Integration Export Wizard is disabled. You must provide information for the Directory parameter in the Parameters grid that will specify the directory name of the location of the output files.

The export bridges to which this applies is shown in the following list:

- CA Gen 4.1a to 7.5
- IBM DB2 Data Warehouse Edition / Rational Data Architect
- IBM Rational Data Architect (RDA)
- Informatica Metadata Manager
- IRI CoSORT RowGen Data Definition File
- IRI CoSORT SortCL Data Definition File
- Meta Integration Repository (MIR) XMI multimodel content
- Oracle Data Integrator Beta
- Telelogic (Popkin) System Architect 10.4 to 11.x (Encyclopedia)
- Telelogic (Popkin) System Architect 7.1 to 11.x (File)

Complete Compare

One of the most powerful tools CA ERwin DM provides is Complete Compare. It helps you easily compare and synchronize the object properties between a data model and its related database or another data model.

The Complete Compare tool includes these features:

**Work with open models in real time**

When you select a model, database or script file, it opens as a model in the workplace and stays open during the compare process. Changes made to the models during compare are automatically made to the open models. You can save your models when you end the compare session, or use other features to update the database or replace the script file.

**Quickly perform simple or complex comparisons**

Screens in the non-sequential wizard allow you to quickly perform a simple compare, or set up the parameters for a complex compare. You move through the wizard using a navigation tool displayed in a static explorer window. You can use preset defaults and click Compare once to start the compare process.
Save an entire compare session to an external (CCS) file

You can save your compare session in a Complete Compare Session (CCS) file. You can then reload the saved session to instantly restore your previous selections, including model choices, and object and property filters.

Customize Options Sets

Customize the list of objects and properties you want to participate in the compare by creating an Option Set in the Type Selection dialog. You can save the Option Set as an external file, or with one or both of the models that participate in the compare.

Search compare results

Use the Find functionality in the Resolve Differences dialog to search the list of displayed differences.

Create reports

Use the Report functionality in the Resolve Differences dialog to prepare a custom report of your Complete Compare session.

The Complete Compare Wizard

You use the Complete Compare Wizard to perform four basic steps in the Complete Compare process:

- Select the models, script file, or database to compare.
- Select objects and properties to include in the compare process, and choose filter options.
- Resolve differences.
- Save your models.

How Model Selection Works

Select the models, script file, or database for the compare. Some of the typical compare scenarios you can use are:

- Compare your active data model open in the workspace with a model saved as an *.erwin file.
- Compare a data model with a script or database.
- Compare two databases or two scripts.
- Compare two unrelated models.
Click Complete Compare on the Actions menu. The Right Model Selection dialog opens by default.

You can work with models already open in the workplace, or you can use the Complete Compare Wizard to open a model, or reverse engineer a database or script file.

- Select from the “Load From” choices to open a new *.erwin file, or compare to a database or script file. When you select the Database/Script option, the Reverse Engineer dialog opens, which allows you select specific options. If you have a connection to a mart, you can open a model from a library.

- Move the focus in the Open Models in Memory list to choose a model already open in the workspace.

To navigate the panes of the Complete Compare Wizard, click the name of the pane in the static explorer area in the wizard to display that pane.
Since the wizard is non-sequential, you can select as many or as few options as you want, and start the compare process at any time.

After you select the Right Model, click Left Model in the navigation pane to open the Left Model Selection dialog. Select a model, database, or script file for the "Left Model" in the compare.

**Note:** You can use the preset defaults for all the other options in the Complete Compare Wizard. To accept the defaults and start the compare process, click the Compare button after you select the right and left models.

### Load a Model as Read-Only

On either the Right Model Selection or Left Model Selection pane of the Complete Compare Wizard you can select the "Set selected model as read-only" check box.

![Set selected model as read-only](image)

When you select the check box, the model is loaded as read-only. When you work with the model in the Resolve Differences dialog, you cannot make changes to it.

Making one of the models read-only in a compare session creates a "one-way" compare scenario - you can move objects and properties from the model to the other model, but you cannot make changes to the read-only model.

### Allow Demand Loading

When you work with a script file or database in Complete Compare, you can use the Allow Demand Loading check box to load only the names of top-level objects (tables, views, materialized views). This enables Complete Compare to load the database quickly since it is only comparing names at this point.

When the Complete Compare Wizard aligns or performs an action on a partially loaded object in the Resolve Differences pane, the properties are fully loaded in order to complete the compare action.

You suppress this default when you clear the Allow Demand Loading check box. Clear the Allow Demand Loading check box if you plan to work with the model you reverse engineered from the database or script file after using Complete Compare.
If you do not clear Allow Demand Loading, the resulting model will only be partially loaded and will be missing the substructure of various object, tables, views, and so on.

Allow Demand Loading is useful when you compare a small model or a small subject of objects to a large database. When you compare an entire large model to a large database, use of Allow Demand Loading is not appropriate.

**Note:** When working with DB Sync, to optimize performance, demand loading is turned on by default.

### Type Selection Compare Levels

You can refine the compare process by applying filters and selecting the specific objects and properties you want to participate in the compare.

Click Type Selection in the navigation pane to open the Type Selection pane. You use features in this dialog to access type filtering options.
You can choose from three Compare Levels, provided as check boxes near the top of the Type Selection pane. The default selection is based on the kind of models you selected for your left and right models. For example, if are working with a Logical/Physical model, you can select to include both the logical and physical level. If you are working with a logical-only model, all check boxes but Logical Level are grayed out.

**Logical Level**
- Includes objects on the logical level

**Physical Level**
- Includes objects on the physical level.

**Database Level**
- Includes objects on the database level, and excludes some physical modeling properties such as graphic fonts, colors, drawing objects, and so on.

**Note:** Check boxes can appear with a check (selected) or without a check (gray or empty). When a check displays in the box, it indicates that all the objects and properties lower on the tree are also selected. When the box is gray, it indicates that not all of the objects and properties lower on the tree are selected. An empty check box means that nothing is selected.
Refine the Criteria for Object Comparison

You can further refine the criteria for object comparison between the left and right models.

Use the Left Object Selection and Right Object Selection panes of the Complete Compare wizard to filter out specific objects for each model.

In the Choose Objects Using Sets window you can apply preset choices for common filter selections. For example, to filter by subject areas, triggers or ownership criteria. Filter out specific objects by clearing the check box next to the object name. The selected objects displayed in the Selected Object pane changes based on the kind of compare your are performing. For example, if your left model has been reverse engineered for Complete Compare, you can choose from selection sets that allow you to perform a complete compare on new objects, system objects, or matching objects.

Choose from the following options:

Choose Objects Using Sets

Select this check box to use preset options for selecting objects sets, such as Subject Areas, Triggers, or objects by owner. The available sets appear in a tree in the wizard. Clear this check box if you plan to use a customized set of selected options from the object list.

Selected Objects

Displays the tree of model objects for the "Left Model." Select or clear the check box next to the object name.

Hide Unselected Objects

Select this check box to remove unselected objects from the Selected Objects display. This feature makes it easier to display the objects you selected, when you are working with a long object list.
After you have made choices for your left model in the Left Object Selection dialog, click Right Object Selection in the navigation pane to make choices for right model.

Filter By Owner Name

You can select to filter objects by owner in both the Left Object Selection and Right Object Selection panes of the Complete Compare Wizard. When you indicate an owner name, the Selected Objects pane is automatically updated to reflect the appropriate list of owned objects.

To filter by owner name

1. Open the Complete Compare Wizard to either the Left Object Selection or Right Object Selection pane.
   The pane includes a Choose Objects Using sets box, with an Object Tree.
2. In the "Owned By" portion of the Object tree, select the check box for Owner List (case-sensitive) or Owner List (case insensitive), then right-click the text box.
   The Configure button appears.
3. Click the Configure button.
   The DB Owner dialog opens.
4. Enter your owner list and click OK.
   The Owner List is updated with the names you entered, and the Selected Objects tree is updated based on the owner criteria.
Advanced Options

Additional filter options are available in the Advanced Options pane, for example to filter by table owner, or to apply a case-sensitive compare:

![Advanced Options Pane](image)

The advanced options include:

**Auto dispose Database/Script Models**

When working with a database or script file in the Complete Compare Wizard, select this check box to automatically close the model created from the database or script, when you end the compare session. The option to save the model is not displayed.

**Auto resolve missing UDPs**

In some cases, the Type Resolution box appears when Complete Compare detects missing UDPs or property differences for common UDPs. You can select to skip the Type Resolution popup box when all the differences are due to missing UDPs. When you select this check box, all missing UDPs are automatically copied to the target model.

**Case Sensitive Compare**

Perform a case-sensitive compare. This option affects both the alignment of objects in the object tree and the equality of property values in the property pane. When the option is cleared, case is ignored for the purposes of alignment and equality testing of text property values.
Display Unified Attributes
Select this check box to simplify the display of foreign-key attributes in the Resolve Differences dialog. When selected, a Unified Attributes group object is used to display all unified attributes (role-named or not) of the same unified set of attributes.

Any attributes that are aligned to the attributes under the Unified Group object appear as part of the Unified Group object, even if they are not unified attributes.

The Unified Attributes group object carries the unified name if all the attributes under it are part of the same unified set. If not, the name consists of a comma-delimited list of names of all the attributes under it.

Exclude unaligned objects in the left model
Select or clear this check box to exclude or include unaligned model-level objects from the left model in the Resolve Differences dialog. Use this option as a filter to make it easier to distinguish between changes in a model subset you are working with (such as a subject area or submodel) and a larger model of with the subset is a part.

Exclude unaligned objects in the right model
Select or clear this check box to exclude or include unaligned model-level objects from the right model in the Resolve Differences dialog. Use this option as a filter to make it easier to distinguish between changes in a model subset you are working with (such as a subject area or submodel) and a larger model of with the subset is a part.

Ignore Code Comments
Select this option to exclude blocks of comments from the body of a trigger, before including it in the compare process. This enables Complete Compare to recognize that a trigger has not changed, if the only difference is in the comment text attached to the trigger.

Include Only Generated Objects
Each editor for a physical object includes a 'Generate' check box, which is selected by default. The 'Generate' check box indicates that you want to generate SQL for this object during forward engineering. When working with a database-level compare, the 'Include Only Generated Objects' check box is selected by default. If you clear this check box, the compare session will also include those objects for which you cleared the 'Generate' check box in the property editor.

Prefix Owner
Match by prefix table owner. When you select this option, objects are aligned based on both the name and owner name property.
Select Active Subject Area

Specifies that you want to select the active subject area by default in the Object Selection pane. This simplifies the subject area selection, especially in models that contain a large number of subject areas.

Using Database Id Matching

Match by Database ID. This option is available for Informix, Sybase, and SQL Server database servers only. When you select this option, objects are aligned based on the DB ID property if one is present.

Using Name Matching

Match by object name. When you select this option, relationship, index, and index members are aligned based on name, in addition to the normal criteria used to align these objects.

Tablespace in Database

This option is available for the DB2 z/OS database server only. When the option is set, objects are aligned based on both the IN_TABLESPACE and IN_DATABASE properties if present on the object.

Using Object Id Matching

This option is available for the DB2 z/OS database server only. When you select this option, objects are aligned based on the Object ID property if one is present on the object.
Resolve Differences

The most important step in the Complete Compare process is comparing differences and determining how to resolve them. The Resolve Differences dialog is a side-by-side display that shows the:

- Differences between the models, databases, or script files you selected for display in the left and right panes.
- Intended resolution for each difference.

The toolbars give you quick access to all the compare options. You can reposition the five toolbars along the top of the dialog. Hold your mouse over an icon to display a tooltip for that feature. When you select a row in the object or property view area, the relevant toolbar options become active.
Resolve Differences Dialog

Use the options in the Resolve Differences Dialog to compare the model in the left pane with the model in the right pane and resolve the displayed differences. You can view the differences at the object level, or more detailed property level. You can search the text of the comparison lists, and you can generate a report of the differences.

**Standard Toolbar (see page 144)**

Performs a specific action on a selected item in the list of differences. For example, you can copy an item from one model to the other, match or unmatch items, and generate a report.

**Impact Analysis Toolbar (see page 145)**

Invokes additional functionality as you resolve differences. You can view the Impact Analysis dialog and the Message Log, and generate an alter script for either the left or the right model.

**Known Differences Toolbar (see page 146)**

Marks known differences and work with snapshots. You select rows that you do not want to display in the Resolve Differences dialog, and save the list for retrieval in a future Complete Compare session.

**Standard Filters Toolbar (see page 147)**

Filters the display of differences to refine the compare process.

**Navigation Toolbar (see page 148)**

Lets you navigate the list of known differences, search for an item, and expand or collapse the trees.

**Object View**

Displays a list of differences between the models in an object tree. The status of the comparison is illustrated by an icon. For example, icons are displayed to show a conflict between objects, a resolved conflict, and so on.

**Property View**

Displays the properties for the selected object in the Object View pane.

**Status Bar**

Displays the compare status of the current compare row. For example, "The left and right items are not equal."

The following options are displayed in the Object View and Property View sections:

**Expand all**

Expands the lowest branch of the comparison tree. Right-click a row to see the Expand all option.

**Collapse all**
Complete Compare

Collapses the deepest level of the comparison tree. Right-click a row to see the Collapse all option.

**Explain**

Opens the Explanation dialog that displays alignment information for the selected row.

**Resolve Differences Standard Toolbar**

The following lists the buttons that you can use in the Resolve Differences Standard toolbar and describes the purpose for each button.

**Copy item to the left**

Moves any items that do not match, from the right model to the left model.

**Copy item to the right**

Moves any items that do not match, from the left model to the right model.

**Match two items**

Matches two items. Use this feature to override automatic matching. You first select an object, click the match icon, then click an object or property with which to match the first object. The items then appear on the same line in the Object View.

**Unmatch two items**

Unmatches any items that have been matched.

**Undo**

Undoes the last operation.

**Redo**

Redoes a previous undo operation.

**Show Report**

Opens the Report Dialog to generate a report of the differences between the left and right models.

**Help**

Opens online help for the Resolve Differences dialog.
Resolve Differences Impact Analysis Toolbar

The Resolve Differences Impact Analysis and Reporting Toolbar includes shortcuts to the following options:

### Action Log

Displays a read-only version of the Action Log. The two-pane window tracks the actions made in the Resolve Differences dialog. You can use the Find feature to search through long lists of transactions.

### Message Log

Displays advisory messages in the Message Log dialog if you encounter these messages as you work in the Resolve Differences dialog.

### Left Alter Script/Schema Generation

Generates an alter script for the model in the left pane for a compare session that includes a database or script file. The Schema Generation Alter Script dialog opens, which guides you through the alter script generation.

**Note:** Schema generation is not available when you resolve differences between a VSTS Database Edition project and a CA ERwin DM model.

### Right Alter Script/Schema Generation

Generates an alter script for the model in the right pane for a compare session that includes a database or script file. The Schema Generation Alter Script dialog opens, which guides you through the alter script generation.

**Note:** Schema generation is not available when you resolve differences between a VSTS Database Edition project and a CA ERwin DM model.
Resolve Differences - Known Differences Toolbar

Use features on the Known Differences toolbar to mark known differences and work with snapshots. The Known Differences toolbar includes shortcuts to the following options:

- **Save Known Differences Into a Snapshot**
  Saves known differences as a snapshot. The Save Snapshot dialog opens, where you can set options for saving the snapshot.

- **Load Known Differences From a Snapshot**
  Loads a saved snapshot to your current Resolve Differences session. The Load Snapshot dialog opens, where you can select the snapshot you want to load.

- **Mark/Unmark a Row as a Known Difference**
  Marks or unmarks a row as a known difference. When you select a row, and then click Mark Known Difference, you hide the selected rows in the Resolve Differences display. Click a row or press Ctrl+click to select multiple rows, then click the Mark Known Difference icon. You can save marked rows as a snapshot when you click Save Snapshot after you mark known differences.

- **Show Known Difference Items**
  Displays the known differences you hid using the Mark Known Differences option. This option is disabled when a snapshot is not active, or you have not marked rows as a known difference.

- **Show Differences that have changed since the last loaded Snapshot**
  If you have loaded a snapshot, displays the rows (either the left or the right) for which the property value has changed since the snapshot was saved.
Resolve Differences - Standard Filters Toolbar

The standard filter buttons allow you to change the display of differences in order to refine the compare process. You can select any combination of filters. To show only the differences between the models, cancel the selection for the "Show Equal" and "Show Resolved Items" buttons and select the three remaining buttons.

Show Equal Items

Indicates that you want to display objects and properties that are the same in both models.

Show Resolved Items

Indicates that you want to display property and object rows that were resolved into equal rows during your Resolve Differences session. When you click this icon, the rows are marked with the change indicator color and the change indicator symbol in the status column.

Show Not Equal

Indicates that you want to display all of the differences between the objects and properties in both models. This filter is selected by default when the Resolve Differences dialog opens.

Show Unaligned Objects on the Right

Indicates that you want to display objects that do not exist in the right model, but are present in the left model. This filter does not affect property rows. This filter is selected by default when the Resolve Differences dialog opens.

Show Unaligned Objects on the Left

Indicates that you want to display objects that do not exist in the left model, but are present in the right model. This filter does not affect property rows. This filter is selected by default when the Resolve Differences dialog opens.
Complete Compare

Resolve Differences Navigation Toolbar

The following lists the buttons that you can use in the Resolve Differences Navigation toolbar and describes the purpose for each button.

- **Go to Previous Difference**
  Highlights the previous object or property difference.

- **Go to Next Difference**
  Highlights the next object or property difference.

- **Find an Item**
  Searches for an object or property.

- **Find Next Item**
  Searches again, using the search parameters already established.

Comparison Results

The Complete Compare process presents the results of the compare in an object view and property view table. Items that do not match are tagged with the "Not Equal" icon. If a property is missing from one of the models, the cell displays cross hatches. You can scan the table of differences by using the scroll bar on the right of the table, or clicking the "Next Difference" or "Previous Difference" icon on the toolbar.

Resolve Actions

You resolve differences by synchronizing properties in your left and right model. To do this, you simply move objects or properties from one model to the other. When you select the row you want to work with, click the Left or Right button on the main toolbar, or click the smaller version of the same icons in the compare row.

When items in the compare row match, no differences are displayed. The cross hatches disappear when the object properties match.
Save a Complete Compare Snapshot

While you work in the Resolve Differences dialog, you can mark a row as a "known difference" and save your selections as a snapshot. When you mark a row as a known difference, you remove it from the list of differences displayed in the Resolve Differences dialog, effectively filtering it out of the compare scenario.

Before you can save a snapshot of known differences, you first select the rows you want to include in the snapshot, then click the Mark Known Difference icon.

To save a Complete Compare snapshot

1. Click Complete Compare on the Actions menu.
   The Complete Compare Wizard opens.
2. Select objects you want to compare in the left and right models, and then click Compare.
   The Resolve Differences Dialog appears.
3. Select the rows you want to include in the snapshot, and click the Mark Known Difference icon in the Resolve Differences dialog.
   When you mark a row as a known difference the row and all dependent rows disappear from the display.
4. Click the Save Snapshot icon.
   The Save Snapshot dialog opens.
5. Complete the following fields:
   **Left Model/Right Model**
   You can save the snapshot with either or both models. The left model is selected by default.
   **Snapshot Name**
   Displays a name for the snapshot. To overwrite an existing snapshot, select it from the drop-down list.
   **Description**
   Displays an optional description for the snapshot.
6. Click OK.
   The Save Snapshot dialog closes.
**Load a Complete Compare Snapshot**

You can load a snapshot of known differences you saved previously. When you load a snapshot you apply the known differences established in the snapshot to your current compare session. The known differences identified in the snapshot are removed from the Resolve Differences dialog display.

**To load a Complete Compare snapshot**

1. Click Complete Compare on the Actions menu.
   The Complete Compare Wizard opens.
2. Select the right and left model in the Complete Compare wizard and click Compare.
   The Resolve Differences Dialog opens.
3. Click the Load Snapshot icon 📚.
   The Load Snapshot dialog opens.
4. Select a snapshot from the list and click OK.
   The saved snapshot is loaded and the Resolve Differences display refreshes.
Manage Model Snapshots

You use features in the Manage Model Snapshots dialog to work with the snapshots you created during a Complete Compare session.

Note: Since a snapshot is saved with the model, open the model that contains the snapshot before you begin this procedure.

To manage model snapshots

1. Click Manage Snapshots on the Actions menu.
   The Manage Model Snapshots dialog opens.
2. In the Name list, select a snapshot with which you want to work.
   The dialog is populated with information from the saved snapshot. The following features appear in the dialog:
   - **Delete**
     Deletes the selected snapshot.
   - **Left Model/Right Model**
     Displays the path (read-only) for the model with which the snapshot is saved.
   - **Description**
     Displays the description of the snapshot. Use the tools above the text entry area to cut, copy, paste, or edit text.
3. Click OK.
   Your changes are saved and the dialog closes.

Generate an Alter Script

You can generate an alter script based on the changes made during your compare session. For example, if you are working with a database you reverse engineered to a model, you can generate an alter script that includes the changes made during the compare session.

To generate an alter script

1. Click the Left Alter Script or Right Alter Script icon in the Resolve Differences dialog.
   The Alter Script Schema Generation dialog opens.
2. Follow the prompts to preview, print, save, and generate the schema.
Save Your Models

When you start the Complete Compare Wizard, your models remain open in the workplace. As you work in the Resolve Differences dialog, your open models are updated in "real-time."

To save your models

1. Click Finish in the Resolve Differences dialog to end your compare session.
   
   **Note:** You can make additional changes to the options in the wizard and compare again, or you can close the wizard.

2. Click Close in the Complete Compare Wizard to close the wizard.

   **Note:** If the models that you compared were already open in the workplace, the models remain open. Use the standard Save options to save your work before closing the models.

   The Close Models Prompt opens when you work with models loaded from a file, or from a database or script file.

3. Clear the check box for models you want to keep open in the workplace. If you select models to close, when you click OK, the Close dialog displays for each model, allowing you to save your changes.

   **Note:** If you are working with a database or script file reverse engineered using the Complete Compare Wizard, you have several options to save your work. You can save the changes in a new model, you can generate an alter script to update the database, or you can save the changes in a new script file.

Additional Complete Compare Functionality

The power and versatility of the Complete Compare tool includes many additional features. Three important ones are:

- Create a customized Option Set
- Save your Complete Compare session
- Create a Complete Compare report
Manage Complete Compare Option Sets

When you compare models, databases, or script files, a collection of all the objects and properties for your target server is displayed in a default option set on the Type Selection dialog. If you are working with a Logical/Physical model, a separate default option set is available for logical and physical objects.

The option set consists of a hierarchical tree of objects and properties. You can select or clear a check box before each object or property name to create a customized list (for example, to exclude drawing objects from the compare). You can collapse or expand the different nodes of the property tree.

The following default option sets are provided:

**Standard Default Option Set**

This option set filters many objects and properties from the selection tree. It excludes "physical-only" object types, and includes a minimal set of property types. Use this default for standard compares where it is not necessary to include all objects and properties in the compare process.

**Advanced Default Option Set**

This option set includes all objects in the selection tree, except those that are assigned generated values during forward or reverse engineering. Use this default option set for advanced compares, in which you want all objects to participate in the compare process.

You can create a customized option set and save it for future use. The option set can be saved with the left or right model, or as an external XML file.
Save a Complete Compare Option Set

You can save a complete compare option set customized with a different set of objects and properties, so that you can load it the next time you want to compare.

To save a complete compare option set

1. Click Complete Compare on the Actions menu.
   The Complete Compare Wizard opens.
2. Select the models, database, or script file you want to compare. Click Type Selection in the navigation pane.
   The Type Selection pane opens and displays the Standard Default Option Set.
3. Make changes to the displayed option set by selecting or clearing the check boxes in the object property tree.
4. Click the New icon.
   The Save Current Option Set dialog opens.
5. Choose from the following destination options in the Save To box:
   - XML file - Saves the option set to an external XML file.
   - Left Model - Saves the options selected for the left model in the current session.
   - Right Model - Saves the options selected for the right model in the current session.

   Enter a name for the option set in the Location box:
   - For an XML file, click to name the file and select a location for the saved file.
   - For an option set saved with the model, enter the Option Set name in the text box.
6. Click OK.
   Your option set is saved.
Save a Complete Compare Session

You can save all of the selections you make in the Complete Compare Wizard, to a CCS (Complete Compare Session) file. The session file retains all compare criteria made in each pane of the wizard, including exact model names and locations, option sets, and so on. You can open the session at a later time and repeat the compare process using the same selections.

This feature saves you time when you compare the same models, databases, or script files over time. For example, you can track the differences between generated DDL and its related data model over time by reusing a Complete Compare Session each time your model or DDL changes.

To save a Complete Compare session

1. Click Complete Compare on the Actions menu.
   The Complete Compare wizard opens.
2. Use the panes in the Complete Compare wizard to select the compare criteria.
   **Note:** You cannot save a Complete Compare session until you make a selection for at least the right and left pane of the Complete Compare wizard.
3. Click Save Session.
   The Save As dialog opens.
4. Enter a name for your session and click OK.
   Your session is saved as a new file with the *.CCS (Complete Compare Session) extension.

**Note:** If you move or change the name of either model included in a saved Complete Compare session, you cannot load that session again.
Create a Complete Compare Report

You can create a summary report for the differences displayed in the Resolve Differences dialog of the Complete Compare Wizard. You can use the report to track changes to your models over time. The report includes a summary of the differences displayed in the Resolve Differences pane.

**To create a complete compare report**

   
The Report Dialog opens.

2. Choose one of the following formats in which to display the report:
   - Default Internet Browser (*.HTML)
   - Microsoft Word Document (*.doc)
   - Microsoft Excel Workbook (*.xls)

3. Click OK.
   
The report opens in the selected viewer.
Chapter 6: Report on Your Data Model

This section contains the following topics:

The Query Tool (see page 157)
Use Crystal Reports With CA ERwin Data Modeler (see page 161)
Using the Bulk Editor to Create a Report (see page 162)
Generate a Diagram Picture (see page 165)

The Query Tool

The Query Tool provides an easy way to execute SQL SELECT queries against a model in CA ERwin Data Modeler, a model in a mart, or against a database catalog. You can execute a query against the objects and properties in the model, the metadata defining those objects and properties, and the action log that records the changes that are made to your model during the modeling session.

You can create new queries or paste text from another source (such as a *.sql file) into a query.

You can save a query to a *.qry file for later execution. Query results can be saved to a *.csv (comma-separated values) file.

Although the Query Tool provides a built-in query interface in CA ERwin Data Modeler, you can also use any third-party reporting tool that has ODBC capability to query CA ERwin Data Modeler modeling data.

Note: For more information about using the ODBC data sources in CA ERwin Data Modeler with a third party tool, see the ODBC Reporting Guide.
Create a Query

You can create a query (SELECT statement) by entering text directly in the Query box, or by pasting text from another source.

To create a query
1. Click Query Tool on the Tools menu.
   The Query Tool opens.
2. Enter your query in the Query box, or click the paste button on the toolbar to paste a query from another source.
   Your query is ready for execution. Use other features in the Query Tool to execute and save the query.

Note: Before you can execute a query you must be connected to ERwin ODBC or to a database.

Open a Query

You can work with queries you saved to a *.qry file in a previous session, or you can optionally use a *.sql, or Microsoft SQL Server Query file.

To open a query
1. Click Query Tool on the Tools menu.
   The Query Tool opens.
2. Click the Open Query icon on the toolbar.
   The Open dialog opens.
3. Select a *.qry or *.sql file and click open.
   The query text opens the Query box and is ready for execution.

Note: Before you can execute a query you must be connected to ERwin ODBC or to a database.
Save a Query

After you have created a new query or made changes to an existing query in the Query Tool, you can save your query to a *.qry file for future use.

To save a query
1. Click the Save Query icon on the toolbar in the Query Tool.
   The Save As dialog opens.
2. Select a file name and location for your query, then click Save.
   Your query is saved and the Save As dialog closes.
3. Click Close.
   The Query Tool closes.

Execute a Query

You can execute a new or saved query against the model or against a database catalog.

Use the following process to execute a query:

- Open the Query Tool from the Tools menu.
- Create a new query or open an existing query (*.qry) file.
- Connect to ERwin ODBC or to a database.
- (Optional) Select the option to restrict row count and enter a number to indicate the number of rows by which to restrict results.
- Click the Execute icon on the toolbar.

After your query executes, the results display in the Results box. Use other features in the Query Tool to save the query or save your result set.
Execute a Query Against a Database

You can run your query against a database catalog. To do this, you connect to the database from the Query Tool and then execute your query.

Follow this process to run a query against a database:

- Open the Query Tool from the Tools menu.
- Create a new query or open an existing query (*.qry or *.sql) file.
- Click the Connect icon on the toolbar.
- Enter the database-specific connection criteria in the Connect dialog.
- (Optional) Select the Restrict row count to check box and enter a number to limit the number of rows returned.
- Click the Execute icon on the toolbar.

After your query executes, the results display in the Results box. Use other features in the Query Tool to save the query or save your result set.

Note: You cannot be connected to ERwin ODBC and a database at the same time in the Query Tool. If you are connected to ERwin ODBC, the (database) Connect icon is dimmed. Click the Disconnect icon on the toolbar to disconnect your ERwin ODBC connection before you attempt to connect to a database. Also, before you can make a database connection, the appropriate database client software must be installed. See Database Connection Overview (see page 122) for more information.

Execute a Query Against ERwin ODBC

To run a query against the current CA ERwin Data Modeler model, you must first activate the ODBC connection. The connection may already be active, if you selected the option to start the ODBC driver on the Integrations tab in the Options dialog.

To connect to ERwin ODBC

1. Click Query Tool on the Tools menu.
   The Query Tool opens.
2. Open a query (*.qry or *.sql) file or create a new query.
   Query text displays in the Query box and is ready for execution.
3. Click the Connect to ERwin ODBC icon on the toolbar.
   The ODBC connection is established. The Disconnect icon becomes active. Use other features in the Query Tool to execute and save the query and result set.
Use Crystal Reports With CA ERwin Data Modeler

You can use Crystal Reports to query the CA ERwin DM metadata and build reports on an open model. Use this process to create a report:

- Start CA ERwin DM and open the models you want to report on. This ensures that the data source is loaded and available to Crystal Reports when you begin.

- Start Crystal Reports and identify ERwin or ERwin_Current as the current data source. You can do this when you create a Blank Report or work with the Report wizard. A user name and password are not required to access the ERwin data source - you can leave these fields blank and click Finish.

Note: If you see a "Logon failed" message, it is probably because you do not have CA ERwin DM open. When you start CA ERwin DM, it loads the data sources and makes them available to Crystal Reports.

- Build your report from ERwin schema objects. For example, work with modeling data using the M0 Schema, metadata using the M1 schema, the EM0 schema, the EM1 schema, or the AL schema.

Note: For more information about the schemas, see the ODBC Reporting Guide. For detailed information about the CA ERwin DM metadata, see the Metamodel Reference Guide.
Using the Bulk Editor to Create a Report

You can create your own report of objects and properties in your model using the Bulk Editor. After you have selected the objects and properties in the Bulk Editor Wizard, and also defined user settings and the order in which you want them to display in the Bulk Editor, you can select and copy all row data into another program, such as Microsoft Excel or Word. After copying the data, save or print the file for sharing or documentation purposes.

Example: Using the Bulk Editor to Create a Report

The following example describes how you can use the Bulk Editor to create your own customized report.

- In the Bulk Editor, click the Bulk Editor Wizard button on the Bulk Editor toolbar.

  Make your selections in the Bulk Editor Wizard in each of the panes. This is what determines the objects and properties that display in the Bulk Editor. You can choose to report on all model objects and properties, or restrict items to report on, such as only domains, or only attributes. In this example, the objects are restricted to only database roles.

Object Types Selection

![Bulk Editor Wizard Object Type Selection](image)
Property Types Selection

Object Instances Selection
Using the Bulk Editor to Create a Report

Display Order Selection

- Make your selections in the User Settings pane and click the Edit button.
  
  The data displays in the Bulk Editor according to the preferences you set in the Bulk Editor Wizard. Next, select all of the rows in the Bulk Editor and click the Copy selected rows to the clipboard button.

- Paste into another program, such as Microsoft Excel. Work in this program to edit, print, or save this report. The model's database roles, placed into Microsoft Excel for editing, saving, and printing.
In addition to using the integration of Crystal Reports to create a picture report of model diagrams, you can also use the Tools menu in CA ERwin Data Modeler to generate a picture report.

To generate a diagram picture
1. Select the open diagram for which you want to generate a picture.
2. Click Diagram Reports, Generate Current Diagram Picture on the Tools menu.
   The Save As dialog opens.
3. Enter a name and location for the file and click Save.
   The generated file is saved as an .emf (Enhanced Metafiles) image and the Save As dialog closes. To view or print the diagram image, use any image viewer program to open the file.
Chapter 7: Working with Design Layers

This section contains the following topics:
Design Layers (see page 167)

Design Layers

A design layer is a single data model or set of data models used for a particular purpose in the application development processes. Each design layer is part of a hierarchy of two or more design layers.

In the simplest view of design layer hierarchy, the first design layer is a logical data model that captures the business requirements for an application. Then in a second design layer, those business requirements are transformed into database implementation rules in a physical data model. A generic physical model may be created using generic ODBC as the target database. A third design layer may represent different physical implementations of the same data model, but on different target server platforms.
Design Layer Hierarchy

Generally, in a design layer hierarchy, different model types are used for a distinct purpose in the application development lifecycle. However, you must be able to develop and link related models in different design layers. Within each design layer, you must be able to make and record design decisions that transform the structure from one layer to another. Finally, you must be able to maintain the links between the models in different design layers and to synchronize changes made in different layers while maintaining the appropriate structures in each. The combination of linking models in different design layers using model sources and applying transforms within a model provide the capability to create a successful hierarchy.

For example, a logical model may represent business requirements and rules. From that model, a generic physical model may be derived, in which physical constructs are designed for a generic database. Once the generic physical model is considered stable, you can derive from it multiple database specific models. In this way, the generic physical model becomes the standards model.

A variety of features are necessary to support the separation of model types and to keep related models linked and in sync.

Who Creates Design Layers

Typically, the application development process involves many groups in an organization such as Standards Administrators, Business Analysts, Data Modelers, Data Administrators, and Database Administrators (DBA) who create design layers. Your application development requirements and methodology determine how many people or groups are involved in the process in your organization.

The First Design Layer: The Conceptual Logical Data Model

CA ERwin DM delivers a superior approach to visualizing database structures and facilitating the design of Logical and Physical data models. This structured, systematic approach to information management and application development begins with a conceptual Logical model, the first of several design layers to capture your specific business requirements (including generic entities and supertype/subtype structures).

The Second Design Layer: The Generic Physical Model

You use the generic physical model to establish the structure of the tables and columns and to create the generic naming needed to represent your business application. But, in the physical generic data model, the objects and properties are independent of a database. Other database-specific data models can be derived from a generic physical data model.
The Third Design Layer: Database-specific Physical Models

You can create a database-specific physical design layer that will be used for your database implementation. Each application can run on several database platforms; a final design layer is needed for database-specific data models.

Enterprise Model Hierarchy

In another example, the conceptual data model may instead be an enterprise-level data model, which establishes the standards for all applications across the organization. The enterprise-level data model may be Logical and include all of the approved standards for entities and attributes that the organization supports. The next design layer may have multiple Logical data models for multiple business applications, such as an Order Entry application and a Sales Commission application.

While these are very different types of applications, it is likely that they share some common entities such as EMPLOYEE and CUSTOMER. The enterprise-level model may include both of these entities along with others that may not be selected for either of these application-specific models. In this hierarchy, the next design layer may be a generic Physical model for each application. If each application runs on several database platforms, a final design layer is needed for database-specific data models.
Data Warehouse Hierarchy

A data warehouse requires additional layers for models of the entire warehouse and data marts. Options in the physical model for dimensional notation and for features related to data movement (data source information, data transformation rules) are provided that let you optimize for warehouse models.

New Design Layers

Many features support design layer architecture such as Split Model, Derive New Model, Add Model Source, Link Model Source, and Sync with Model Source.

All of the design layer features are wizard-driven, which means that you are guided through a series of dialogs to select the appropriate options and enter the necessary information.

Split a Logical/Physical Data Model

If you want to separate a logical/physical model into two models - a logical-only and a physical-only - you can use the Split Model option.

When you split a model, you are prompted to save the separate logical and physical data models with different names. When you save the new models, the logical model becomes the source of the physical model, which is necessary for synchronizing changes between the two model types. The original logical/physical model is preserved with its original name.

To split a logical/physical data model

1. Open a logical/physical model you saved previously.
2. Click Design Layers, Split Model on the Actions menu.
   The Split Model/Logical Save As dialog opens.
3. Save the logical side of the model with a new name. The Split Model/Physical Save As dialog opens.

4. Save the physical side of the model with a new name.

   **Note:** If you are using CA ERwin Data Modeler Workgroup Edition, and have established a connection to the database, you can choose to save your new models to the mart.

   The new logical and physical models, and the original logical/physical model remain open in the main workplace.

**The Derive New Model Wizard**

Whether you have a logical/physical model or a logical-only or physical-only model, creating a new model is easy. Rather than copying objects from one model to another or create a new one, the Derive New Model wizard takes a step-by-step approach to help you derive a new model from a model source. The original model is used as the source for the new model. When you work on the separate models, the changes to each model can be synchronized at any time.

**Derive a New Model**

Use the Derive Model Wizard to derive a new model from an existing model and transition from one design layer to another.

**Note:** You must save your model before you derive a new model from it.
To derive a new model

1. Open an existing model, then click Design Layers, Derive New Model on the Actions menu.

The Derive Model wizard opens on the Target Model pane, and identifies your current model as the source model for the derive action.

2. Select the following options, and click Next:
   - In the New Model Type group box, select Logical, Physical, or Logical/Physical.
   - In the Create Using Template box, accept the default template, or browse for a template.
   - Select a target database and version from the drop-down lists.

Note: Because the wizard is non-sequential, you can start the derive process at any point when you click Derive. You can also customize the derive process using features on the other panes. For example, you can set the compare level, and select specific objects to derive. You can also use a customized option set of objects and properties. You can apply more object filters in the Object Selection pane, and apply naming standards in the Naming Standards pane.
The Type Selection pane of the wizard opens.

3. Accept or edit the remaining defaults, and click Derive.

Your new derived physical model appears in the main workplace.

The Model Source

A *model source* is the parent model that is linked to another model for the purpose of synchronizing changes. Hidden identifiers are automatically assigned to objects in the model source and the linked model. Changes made to both models are tracked using the object identifier. Then, you can synchronize the changes even if the object’s name changes.

Sometimes building a design layer hierarchy requires linking two models that already exist rather than deriving a new model from an existing model. For example, you may have a generic model that you want to designate as the model source to other database-specific models. In this case, you can add the generic model as the model source to the database specific model. When you add a model source, you designate the objects and properties that you want the model source to contribute to the target model.
Add a Model Source

To add a model source, click Design Layers, Add Model Source on the Actions menu. The Add Model Source wizard uses a step-by-step approach to help you specify the objects that you want to add to the target model. The objects are added to the target model and links the objects so that you can later synchronize any changes.

You can add multiple model sources if you want objects to be contributed by multiple models. After you add a model source, you can use the Model Sources Properties dialog to view and edit information about the model source. Choose Model Sources on the Model menu to open the Model Sources Properties dialog.

The Link Model Source Wizard

If you want to simply match existing objects in two models, creating a link between the objects, use the Link Model Source tool. Unlike the Add Model Source, Derive Model, and Sync with Model Source features, the Link Model Source tool creates no new objects in the target model. However, you can maintain or update linked objects using the Sync with Model Source tool.

To link your current model to a source model, choose the Design Layers, Link Model Source option on the Actions menu. The wizard presents all the options you need for selecting a source model and creating the links.

Regardless of which method you choose to build a design layer hierarchy, the ability to link models and synchronize changes between models is critical.

Model Source Properties

Whether you add a model source by splitting a model, deriving a model, adding a model source, or linking a model, CA ERwin DM keeps track of the model source and manages the links between the model and its source objects.

When you add a model source, a new object is created in the Model Explorer.

Right-click the model source name in the Model Explorer and click Properties to open the Model Sources Properties dialog. Use features in this dialog to view general information, add a description, add user-defined properties, and change the model source naming rules.

Note: You can also access the Model Source Properties dialog when you click Model Sources on the Model menu.
The Sync with Model Source Wizard

A relationship between a model and its source can be created as the result of splitting a logical/physical model, deriving a model, adding a model source, or linking a model. Once a model has a model source, the changes to the objects that were contributed by the model source are automatically tracked. At any time, you can use the Sync with Model Source wizard to import and export changes between a model and its source.

The Sync with Model Source wizard takes you step-by-step through the process of selecting the types of objects and changes that you want to compare and synchronize. You can also define case conversion and maximum length rules for logical and physical model objects, and specify a file to enforce naming standards in the target model. The result is a side-by-side list of changes that were applied to either the source and/or the target model.

Whether you import or export changes, the models and the Model Sources Properties dialog are updated with the date of the synchronization.
Transformations

A *transformation* is a method by which you can apply and maintain a record of a *design decision*, which is a decision to change objects or properties within a design layer. When applied, a transform changes a set of objects from one state to another for the purpose of refining, normalizing, or denormalizing a model.

The creation process of the following transforms types will be reduced to the creation of the target objects of the transforms:

- Supertype-Subtype Roll Up
- Supertype-Subtype Roll Down
- Two Table Roll Up
- Two Table Roll Down
- Vertical Partitioning
- Horizontal Partitioning

The Many-To-Many (MTM) and the Supertype-Subtype (SS) relationships will be automatically transformed at the time of creation of the relationship object.

4. When ERwin will show the physical view the association table and its relationships will be shown and when ERwin will show the logical view the MTM relationship will be shown.

5. When the MTM relationship is deleted the association table and its relationships will be deleted as well. An advisory message will be displayed to inform the user about it. The ESXObjectSemantic_RelationshipDeleteNotification semantic will be used.

6. When the association table is deleted the MTM relationship will be deleted as well. An advisory message will be displayed to inform the user about it. The ESXObjectSemantic_EntityCreateDeleteNotification semantic will be used.

7. When any of the two association table relationships is deleted the MTM relationship will be deleted as well. An advisory message will be displayed to inform the user about it. The ESXObjectSemantic_RelationshipDeleteNotification semantic will be used.
5.2.1.3.2 Automatic Supertype-Subtype transformation

When an SS relationship is created via a supertype-subtype symbol between two entities ERwin will create a subtype relationship between those two entities. The relationship will have two layouts, one for logical view and one for physical view. The one for logical view will be a line linking the subtype symbol to the subtype entity and the one for physical view will be a line linking the supertype entity with the subtype entity. The following rules will apply:

1. To apply the transformation when an Supertype-Subtype relationship is created, the following semantic will be updated on the post edit event to create the second line that links the supertype entity with the subtype:
   - ESXPropertySemantic_RelationshipCreate.cpp.

2. When ERwin shows the physical view, the subtype relationship line that links the supertype table and the subtype table will be shown.

   This is all done by the drawing code. No transform specific code changes are required.

3. When the subtype symbol is deleted, the subtype relationships will be deleted as well. And when the last subtype relationship is deleted the subtype symbol will be deleted as well. From the transforms perspective no changes are required in order to support this functionality.

   Link Object:

   The functionality previously implemented via the Column Denormalization transform will now be implemented via a completely new concept, the Link object.

Transformation Wizards

For each transformation, a wizard is used to perform the transformation steps. As you go through the wizard, you select options and respond to prompts.

Before applying the transformation, the wizard shows you the results that you get when the transformation is complete.

When you click Finish on the last page of the wizard, the participating objects are transformed into their new state.
The Transformations Toolbar

The Transformations toolbar provides a set of tools to apply transformations. The model type and the objects that you want to participate in the transformation determine the tools that are available on this toolbar.

Supported transformations include:
- Resolve Many-to-Many Relationship
- Resolve to Supertype-Subtype Identity
- Supertype-Subtype RollUp
- Supertype-Subtype RollDown
- Vertical Partition
- Horizontal Partition
- Two Table RollDown
- Two Table RollUp
- Resolve All Transformations

Resolving all transformations triggers a process for all supertypes/subtypes and many-to-many relationships. Many-to-many relationships are removed and for supertypes/subtypes it replaces all subtype relationships with identifying relationships.

To display or hide the Transformations toolbar, click Toolbars, Transformations on the View menu.

How a Transformation Works

The Many-to-Many transformation is probably the best example to demonstrate the transformation process. To use this transformation, you must have two entities connected by a many-to-many relationship. Often, to resolve this type of relationship, an association entity is added between the two original entities and connected to each with an identifying relationship. By using the Many-to-Many transformation, the many-to-many relationship is automatically dissolved and replaced with an association entity and two identifying relationships.
After selecting the many-to-many relationship line for the objects you want to transform, click the toolbar button to open the Many-to-Many Transformation Wizard. Then, you simply respond to a series of questions that determine how the transformation is applied. The wizard clearly lays out the post-transformation results. When the transformation is finished, the participating objects are transformed.

**Transform Default Options**

You can change the transformation default options. In the example of the Many-to-Many Transformation Wizard described above, by default the association table is named by combining the name of the two tables participating in the transformation. As you work with the wizard, you have the option to change the default name of the association table that replaces the many-to-many relationship.
Overview of Transformations in r8

One of the most important differences between the live transforms support in previous releases and the non-live transforms support in r8 is that property data will no longer be kept in synch between the source and target objects of any given transform.

Elimination of live transforms from the model removes the following functionality:

- Creation and maintenance of transform objects.
- Creation and maintenance of source and target objects.
- Live update of source objects based on target objects and live update of target objects based on source objects.
- Ability to toggle the view to show source or target objects except for many-to-many and supertype-subtype constructs that are toggled by drawing only.
- Elimination of the transforms Reverse functionality for all transform types and the Resolve functionality for some transform types.
- Removal of the transforms editor and the entries in the Model Explorer tree for transform objects.

When you open a r7.x file, if the file has transforms, then the Model Upgrade Wizard has options to specify how to convert the transforms. You will have the option to either resolve or reverse all of the transforms, convert transforms into their current state, and convert the Column Denormalization transform into a Link object. For each many-to-many relationship an association table will be added. For each subtype relationship a second graphic layout will be added to provide a line between the supertype table and the subtype table. Every Column Denormalization transform will be converted into a Link object. All of the properties will be selected for synch and the direction of the synch will be set based on the setting of the Reflect Changes Back To Source Object property of the Column Denormalization transform.

When you save a r8 model to an older version, no transforms will be created. The association table and its relationships will be deleted for all of the many-to-many constructs. The supertype-subtype construct will be reduced to the subtype relationships and one set of line layouts for each one of those subtype relationships. The column level Link objects will be removed leaving the columns in place.
Support for non-live transformations in r8

The same type of constructs that were supported by transforms in r7.x will be supported by transformations in r8, but the transformation will only apply to create the target objects, except for the Many-to-Many, Supertype-Subtype Identity, and Column Denormalization transforms. The following transforms continue to be supported in r8 as transformations:

- Two Table Roll Up
- Two Table Roll Down
- Supertype-Subtype Roll Up
- Supertype-Subtype Roll Down
- Vertical Partitioning
- Horizontal Partitioning
Impact of the r8 Transformations Functionality

Both the many-to-many and supertype-subtype relationships are automatically transformed at the time of creation of the relationship object.

**Automatic Many-To-Many Transformation**

When a many-to-many relationship is created, CA ERwin Data Modeler automatically creates the association table and its relationships. The following rules apply to this transformation:

- When the model is in the physical view, the association table and its relationships are displayed, but when the model is in the logical view, the many-to-many relationship is displayed.
- When a many-to-many relationship is deleted, the association table and its relationships are also deleted.
- When an association table is deleted, the many-to-many relationship is also deleted.
- When any of the two association table relationships is deleted the many-to-many relationship is also deleted.
- Many-to-many relationships are excluded from FE/ALTER script generation based on the relationship object type.

**Automatic Supertype-Subtype Identity Transformation**

When a supertype-subtype relationship is created using a supertype-subtype symbol between two entities CA ERwin Data Modeler creates a subtype relationship between those two entities. The following rules apply to this transformation:

- The relationship will have two layouts, one for the logical view and one for the physical view. The one for the logical view will be a line linking the subtype symbol to the subtype entity, and the one for the physical view will be a line linking the supertype entity with the subtype entity.
- When the subtype symbol is deleted, the subtype relationships are also deleted.
- When the last subtype relationship is deleted, the subtype symbol is also deleted.
Column Denormalization Transformation

The column denormalization transform is implemented differently in r8, using the Link object. A Link object will be automatically created to link an existing source attribute/column to a new or existing target attribute/column. You can create new Link objects and specify Link object properties using the Link Wizard. The Link Wizard is accessed from the Link tab of either the Attribute Editor or the Column Editor.

The Link Wizard lets you:

- Specify Link object properties such as:
  - Name
  - Definition
  - Synch Direction (From-this, To-this, None, Two-way)
  - Target Column Reference
  - Synch Properties List
- View the list of existing Link objects created for an attribute/column.
- Delete Link objects. You can delete Link objects individually, or choose to delete all link objects in the model that are owned by attributes/columns.

The following rules apply to Link objects:

- The target column can be created as new by the wizard or be selected from the existing columns on any table in the model.
- Two Link objects are created for every link, one owned by the source column and one owned by the target column. For unidirectional synch, the synch direction on the source column is set to “From-this” and on the target column, to “To-this.”
- Link objects are excluded from FE/ALTER script generation.
- Complete Compare will show the Link objects in a model-level compare.
Changes to the Supertype-Subtype Roll Up Transform Relationship Roll Up Rule

An enhancement was made to the supertype-subtype roll up transform relationship roll up rule for r8. All of the relationships coming to subtype tables from another table are merged into one by the roll up transformation unless rolenames are applied on any of the migrated attributes. This is the case where one table contributes its non-identifying relationships to more than one subtype table of the same supertype-subtype construct.

In previous versions, the old rule specified that each relationship associated with subtype tables had a correspondent target relationship in the supertype-subtype roll up transform.

For example, if E/4 has one non-identifying relationship coming into the subtype E/2 and one coming into the subtype E/3, then after the roll up, each of the non-identifying relationships had a corresponding target relationship going from E/4 to the supertype table E/1, as shown here:
For r8, the new rule specifies that if the incoming relationships to subtype tables have the same parent table, then merge them into one target relationship except for those relationships that are carrying rolenamed FK attributes.

Example 1: No rolenames are applied. All of the relationships coming from the parent table E/4 into subtype tables E/2 and E/3 are merged into one target relationship from E/4 to E/1:
Example 2: Some migrated FK attributes have rolenames. Attribute \( a \) migrated from E/4 to E/3 is rolenamed to \( RoleName \). When the transformation is applied, every relationship that carries at least one rolenamed attribute will be represented in the target, so besides the relationship from E/4 to E/2, the relationship from E/4 to E/3 will also be represented in the target because it carries the rolenamed attribute \( RoleName \).
Changes to the User Interface

The following changes were made to the user interface to handle the new r8 transformation functionality:

**Transforms wizards**
- Areas for entering the transform name and definition were removed in addition to any references to the transform name throughout the wizard.
- The option to *Reflect Changes Back To Source Objects* was removed.
- The Many-To-Many, Supertype-Subtype Identity, and Column Denormalization transform wizards were removed.

**Transforms editors**

All transforms property editors were removed.

**Transforms toolbar**
- The Column Denormalization, Show Transforms Source Objects, Show Transforms Target Objects, and Reverse All Transforms buttons were removed from the toolbar.
- The Many-To-Many Transform and Supertype-Subtype Identity buttons’ functionality was changed to Resolve Many-To-Many relationships and Resolve Supertype-Subtype relationships, respectively.

**Context menus**

The *Create Association Entity* item was removed from the relationship context menu.

**Menu items**

The Show Transforms Source Objects, Show Transforms Target Objects, and the Reverse All Transforms options were removed from the Edit menu.

**Model Editor**

In the Model Editor (formerly the Model Properties dialog), all options related to transforms was removed.

**Complete Compare Wizard**

The *Transform show as Target (uncheck for Source)* check box was removed from the Advanced Options pane.
Sync with Model Source Wizard

The Transform show as Target (uncheck for Source) check box was removed from the Advanced Options pane.

Design layers wizards

The Auto-Transform Logical Objects group box was removed from the Options pane of the following wizards:

- Add Model Source
- Link Model Source
- Derive Model

Model Explorer

The transforms nodes no longer display in the Model Explorer tree.
Migrating r7.x Models to r8 Models

Because of the nature of the transforms conversion between r7 and r8, the r8 model will no longer have the transform objects and the source or target objects of all transforms. So a Complete Compare between an r7 model and the same model that was round tripped to r8 and back will show significant differences in r7.

On the other hand, a model originated in r8 will lose all the Link objects in the process of being converted to r7. So a Complete Compare between an r8 model and the same model that was round tripped to r7 and back will show significant differences in r8 because of the missing Link objects.

Converting models created by a previous version of the product to a form readable by r8

When opening a r7.x file in r8 all pre-existing transforms will be reversed or resolved based on the options you specify. During the file open process you will be prompted to select the option you want, either Resolve All Transforms, Reverse All Transforms, or Convert Transforms into Current State.
This rule applies to the following r7.x transforms:

- Supertype-Subtype Roll Up
- Supertype-Subtype Roll Down
- Two Table Roll Up
- Two Table Roll Down
- Vertical Partitioning
- Horizontal Partitioning
- Many-to-Many
- Supertype-Subtype Identity

**Note:** If corruptions are identified and the transforms cannot be resolved because the switch to target view fails (assuming the transform was in source mode) then the transform will be reversed.

**Column Denormalization transform conversion**

The Column Denormalization transform will be converted into column level Link objects as follows:

- A Link object will be created for each Column Denormalization transform to link the two columns. Since all the properties were synched by the Column Denormalization transform (except for some reference properties), by default, the new Link object will be set to synch all properties except for the same reference properties excluded in Column Denormalization.

- The transform definition will be copied from the Column Denormalization transform to the new Link object. The transform name will be copied to the new Link object.

- The Link object direction property will be set based on the setting of the **Reflect Changes Back To Source Object** property of the Column Denormalization transform so it will be either **From-this** on the source column’s Link object and **To-this** on the target column’s Link object, or **Two-way** on both.
Saving a r8 Model with Transformations to a Previous Version

When you save a r8 model to a previous version, no transforms will be created. Many-To-Many and Supertype-Subtype transformations will be converted by going through a "reverse" process using the following rules:

- For Many-To-Many relationships the association table and its relationships are deleted for all of the Many-To-Many constructs in the model.
- For the Supertype-Subtype relationships the lines that link the subtype symbol to the subtype entities are preserved, and the lines that link the supertype table to the subtype tables are removed.

Preserve Model History

Using history options, you can track meaningful changes to derived and transformed models, as well as routine information about the creation and revision dates of your models.

You can define the historical information to save at the model level, and at the object level for entities, attributes, tables, columns, views, and cached views.
Set Model History Options

You can specify the event history to track for a model using the History Options tab of the Model Editor. You can save history information for a model and its entities, attributes, tables, columns, views, and cached views when the object is:

- Created
- Derived
- Linked
- Transformed
- Migrated
- Reverse engineered
- Imported from a previous version
- Split
- Transformation resolved
- Imported by Complete Compare
- Imported from a model
- Imported from a script
- Imported using the API

To set model history options

1. Click Model Properties on the Model menu.
   The Model Editor opens.
2. Click the History Options Tab.
3. Select or clear the history options for the model objects whose history you want to preserve.
4. Click Close.
   Model history options are set and the Model Editor closes.
View Object History

The Notes tab in the property editor for entities, attributes, tables, columns, views, and cached views lets you view the object’s history information. In this tab, you can enter text for documentation purposes in the Notes area; the History area tracks changes made to the object on various events in the model.

To view object history

1. Open the property editor for the object for which you want to view history, and select the object in the Navigation Grid.
2. Click the Notes tab and work with the following options:

   ![Sort]

   Let you sort the events by Creation Date Ascending, Creation Date Descending, Modification Date Ascending, Modification Date Descending, or Note Order. You select the method you want using the drop-down list that opens after you click the Sort button. The Sort button image changes to indicate how the list is currently sorted.

   ![Filter]

   Let you specify how to filter the list using the following options:

   ![All]

   Specifies to show all events.

   ![History Only]

   Specifies to show only history events.

   ![Notes Only]

   Specifies to show only notes.

   ![New]

   Opens the Notes editor for the object so you can enter a new user note.

   ![Move to top]

   Moves the selected item to the top of the list.

   ![Move up]

   Moves the selected item up one position in the list.

   ![Move down]

   Moves the selected item down one position in the list.

   ![Move to bottom]

   Moves the selected item to the bottom of the list.

   ![Edit]
Opens the Notes editor so you can edit note text for an event or existing user note.

**Event**
Displays the event for the object.

**Comment**
Displays the text of the user note.

**Date Created**
Displays when the event was created.

**Created By**
Displays the user that created the event.

**Modified By**
Displays the user that last modified the event.

3. Click Close.
   The property editor closes.
Chapter 8: Naming and Datatype Standards

This section contains the following topics:

- **The Model Naming Options Dialog** (see page 195)
- **The Naming Standards Editor** (see page 196)
- **Check Name Compliance in a Model** (see page 198)
- **Name Hardening Wizard** (see page 199)
- **Data Type Standards** (see page 202)

The Model Naming Options Dialog

There are a wide-range of naming standard features that can help you develop new standards or implement existing standards in your modeling environment. To manage naming standards, use the features available in the Model Naming Options dialog, and the Naming Standards Editor.

Click Model Naming Options on the Actions menu to open the Model Naming Options dialog.

You use the features in this dialog to define the naming standards for the current data model. Some of the available features are described below.

**Specifying Case and Length Rules**

You specify the case and length rules for each model type on both the Logical and Physical tabs in the Model Naming Options dialog.

Default settings are applied. However if you do specify the case and length for an object, when you close the Model Naming Options dialog, all object names are immediately changed to match your preferences.

**Mapping Logical and Physical Names**

You set name mapping preferences on the Name Mapping tab. By default, a macro is applied to define the object name, but you can replace the default macro by opening the macro toolbox. You can also specify that the attached glossary file (.nsm) be the source of the name and abbreviation for some objects.

You can also supply a Prefix and/or a Suffix to the default object name and define how special characters and spaces in a logical name map to a physical name.

**Specifying Duplicate Name Rules**

On the Duplicate Names tab, you can specify your preferences for how duplicate entity and table names are handled in a model. The preference options include:
Allow
Permits duplicate names.

Rename
Renames the duplicate name by appending to the end of the name a forward-slash to indicate that the name has been used in the model and a number to indicate how many times (for example, MOVIE_COPY/2).

Ask
Gives you the opportunity to keep the duplicate name or enter another name.

Disallow
Requires you to change the duplicate name to a unique name.

Attaching a Naming Standards File
On the General tab, you can specify the name of the Naming Standards file that you want to attach to this model.

When you attach a naming standards file to a data model, the standards and conventions defined in the file are automatically applied. You can also use the file to check compliance of the names of objects in the model, which is similar to a spell checker in a word processing application. The naming standards file is used as a dictionary and compares the names in the data model to the names in the dictionary. When it finds a discrepancy, you decide whether to ignore or replace the non-compliant name.

The Naming Standards Editor
Click Standards, Naming Standards on the Tools menu to open the Naming Standards Editor.

You use the features in the Naming Standards Editor to specify separate naming standards for logical and physical objects.

In the Glossary tab on the Naming Standards Editor, you can either import an existing names glossary or build one from scratch. You can define how these standards are implemented, and create entries including business terms, and abbreviations, that are relevant to your business. Naming standards information is saved in a naming standards file (*.nsm). For each model in which you use naming standards, you must attach a naming standards file. You can apply a naming standards file to multiple models.
Object Name Syntax

The syntax of logical and physical object names can be classified into the following parts:

**Prime Word**
- Describes the subject area of the data such as Account, Employee, and Customer.

**Class Word**
- Designates the major classification of data that is associated with a model object such as Date, Amount, Rate, Number, Code, or Name.

**Modifier (or qualifier)**
- A word that further defines or distinguishes the prime and class words. For example, you can use the modifier Last to further define the Name class word or the modifier Corporation to further define the Employer prime word. You can specify up to two modifiers.

When you click the Logical or Physical tab in the Naming Standards Editor, you see a list of pre-defined objects in the first column. For each object type, you can use the additional columns to specify the syntax for each part of the object's name. For example:

- For Entities, the first part is typically a Prime Word, such as EMPLOYEE.
- For Attributes, the first part is typically a Prime Word followed by at least one Modifier such as Employee Address.
- For Domains, the first part is typically a Class Word, such as Number.

Object Names Glossary

The Glossary consists of logical and physical object names. You can import an existing glossary or create one from scratch by typing object names and abbreviations directly into the editor. You can also specify the syntax parts associated with a particular object type (such as prime, modifier, and class).

Save a Naming Standards File

After you define the naming standards, you need to save it in the Naming Standards Editor to attach it to models. To save a naming standards file (.nsm) in the Naming Standards Editor, click Save on the File menu.
Check Name Compliance in a Model

After you attach a naming standards file, you can use it to check the names in the data model. It works like a spell checker in a word processor.

**To check name compliance in a model**

1. Click Standards, Check Naming Standards Compliance on the Tools menu.
   
   The Check Name Standards Compliance dialog opens.

2. Select the objects whose names you want to check for conformance. Select the check box if you want to check word order and position conformance.

3. Click Start.
   
   The name checking process begins, and when it finds a non-conforming name, it presents the name in the Non-conforming Name box.

4. Select to either ignore or replace the non-conforming words.
Name Hardening Wizard

The Name Hardening Wizard provides a way to override inheritance of names and block name changes or resets within a model. Using the wizard, you can select the object types and object instances for which you must harden logical names or physical names, or both, within the model instead of using the inherited name values.

To run the Name Hardening Wizard, click Manage Name Hardening on the Actions menu.

You can harden names in this wizard for the following object types:

- Attributes/Columns
- Default value
- Domains
- ER Diagrams
- Key groups/Indexes
- Models
- Relationships
- Entities/Tables
- Shapes
- Themes
- Validation rules

The wizard also includes the flexibility to specify whether to override name inheritance for all object instances of the selected object types, a subset of those object instances, or a specific object instance using the various pages of the wizard. The wizard contains four pages:

Overview

Contains an overview of the Name Hardening Wizard.

Type Selection

Displays the available object types that you can select for which you want to override inheritance such as Attributes, Default Values, and Domains. To make object type selection easier, you can right-click anywhere on this page to display a context menu where you can select either the Select All or Select None option. The options you select on this page are reflected in the next page of the wizard, the Object Selection page.

Note: While you are able to select the Entity check box in the Type Selection page in a logical model, name hardening can only be enabled in the physical model. Logical entity names are not inherited names; they are set on the entity object. Therefore, they do not change and there is no need to harden them.
Object Selection

Specifies the model objects or groups of model objects (collection nodes) for which you want to override inheritance. When you transition to this page from the Type Selection page, all the selections that you made on the Type Selection page are listed and selected on this page.

The collection nodes have check boxes that summarize the state of the objects under that node (subordinate objects). The check boxes for the collection nodes have three states. If none of the subordinate objects are selected, the check box for that collection node is not selected. If all the subordinate objects are selected, then the check box for that collection node is selected. If some of the subordinate objects are selected, then the check box for that collection node is selected, and is also shaded. Clicking the collection node check box allows toggling of the selection of the entire set of subordinate objects. In addition, you can right-click anywhere on this page to display a context menu where you can select either the Select All or Select None option. Any selections you make to the Selection Sets section on this page are immediately reflected in the Selected Objects section.

Action

Reflects the current name hardening settings for the selected objects. The Logical and Physical columns indicate the status of the objects and the Selected Objects column lists their fully qualified names, for example, instead of simply 'a,' an attribute name would be 'OwnerName.E/1.a.' Also, each object has a check box for selection; if you want to override inheritance, or harden, select a check box for the object; clear a check box for an object for which you want to unharden the name. When you unharden an object name, the same name you used in the hardening process remains, however, now you can edit or reset that name (editing or resetting of hardened names is not allowed).

**Note:** Unhardening an object name does not automatically restore inheritance, it only allows the names to be reset or changed.

**Note:** If you prefer, you can select all the objects directly on the diagram, launch the wizard, and go directly to the Action page. The objects you select on the diagram populate the Type Selection and Object Selection pages.
Override Name Inheritance

You can select the object types and object instances for which you need to set logical and physical names within the model instead of using the inherited name value, or for which you need to block name changes.

To override name inheritance
1. Click Manage Name Hardening on the Actions menu.
   The Name Hardening Wizard opens.
2. Click Type Selection.
   The Type Selection page opens.
3. Select the object types for which you want to override inheritance, then click Object Selection.
   The Object Selection page opens.
4. Select the model objects for which you want to override inheritance, then click Action.
   The Action page opens.
5. Select the check box for each item for which you want to override inheritance, then click Finish.
   Inheritance is overridden for each item you selected, and the Name Hardening Wizard closes.
Unharden Object Names

If you used the Name Hardening Wizard to set the names of selected object types or object instances (or both) in order to remove inheritance, you can unharden the names of those selected object types and object instances using the Name Hardening Wizard as well. When you unharden an object name, the same name you used in the hardening process remains, however, once the unharden process is complete, you will have the ability to edit or reset that name (editing or resetting of hardened names is not allowed).

**Note:** Unhardening an object name will not automatically restore inheritance, it only allows the names to be reset or changed.

**To unharden object names**

1. Click Manage Name Hardening on the Actions menu.
   - The Name Hardening Wizard opens.
2. Click Type Selection.
   - The Type Selection page opens.
3. Select the object types that you want to unharden, then click Object Selection.
   - The Object Selection page opens.
4. Select the model objects that you want to unharden, then click Action.
   - The Action page opens.
5. Select the check box for each item for which you want to unharden the names, then click Finish.
   - The name for each object that you selected is unhardened, and the Name Hardening Wizard closes.

Data Type Standards

A *data type* is a predefined set of characteristics for an attribute or column that specifies field length, acceptable characters, and optional and required parameters. For example, the data type `char(18)` specifies that the column can store up to 18 alpha and numeric characters.

By default, a data type is applied to every attribute in a logical model and to every column in a physical model. In the logical model, the data type is determined by the domain from which the attribute inherits its properties or from the data type that you assign. In the physical model, the data type is determined by the default value specified by the target server or the data type that you assign. Considering the large quantity of attributes or columns a data model usually has, it can be quite tedious to manually assign and maintain consistency of data types. For this reason, there are several tools that help you with this task.
The Datatype Standards Editor

Use the Datatype Standards Editor to edit the default data type mapping for your logical and physical models. For physical models, you can edit the default data type that is automatically attached to each column. For logical models, you can add logical data types and assign the data types to the attributes in the logical model.

To open the Datatype Standards Editor, click Standards, Datatype Standards on the Tools menu.

You define the data type mapping standards by specifying how logical data types map to the available data types for your target server. If you have database applications running on multiple server platforms, you can map data types for all of the target servers. Data type mapping information is saved in a data type standards file (*.dsm). For each model in which you use data type standards, you must attach a data type standards file. If you open a model and you have not attached a data type standards file, the default data type mapping is used.

Create a Data Type Mapping List

You use the Insert New Mapping feature in the Datatype Standards Editor to map a data type from one target server to another. You also use this feature to add a new data type.

To create a data type mapping list

1. In the Datatype Standards Editor, click Insert New Mapping on the Mapping menu.
2. Click the down arrow on the From list, and select the target server from which you want to map.
3. Click the down arrow on the To list and select a target server to which you want to map.
   
   The From and To columns are populated with the default mappings for the selected target servers. Notice that the data type row at the bottom of the list is blank.
4. Click in the blank cell at the bottom of the From list and enter a new data type name.
5. Click the blank cell at the bottom of the To list and select the data type that you want to assign from the drop-down list.
Save a Data Type Mapping File (.dsm)

After you define the data type standards, you need to save it in the Datatype Standards Editor to attach it to models.

To save a data type mapping file (.dsm)
1. Click Save on the File menu.
2. Enter the file name, select DSM from the file type list, and click Save.
   The file is saved and the dialog closes.

The Model Datatype Options Dialog

You can define your data type mapping standards once and apply them to multiple data models. When you click Model Datatype Options on the Actions menu, you can specify the data type mapping file that you want to apply to the current model.
Attach a Data Type Standards File to a Model

To activate data type mapping in your model, you open a data model and attach the data type standards file to the model.

To attach a data type standards file to a model
1. Click Model Datatype Options on the Actions menu.
   The Model Datatype Options dialog opens.
2. Click Use File, then click the Browse button to locate the file that you want to attach.
   The Set Location dialog opens.
3. Select the file to attach, and click Set.
   The Set Location dialog closes.
4. Click OK.
   The Model Datatype Options dialog closes and the data type standards file is attached and applied to the current model and all models derived from the current model.

Data Type Standards Reuse

After you define and save your data type standards, you can reuse the files by attaching them to other models.

While it may take some time to establish and implement these standards across your enterprise, CA ERwin DM helps you take the initial steps and supports your ongoing efforts to maintain standards.

You can enforce consistency in all of your data models, databases, and applications.
Appendix A: Third-Party Acknowledgements

CA ERwin Data Modeler’s metadata import/export capabilities are powered by Meta Integration® Model Bridge (MIMB), copyright 1997-2006.

Meta Integration is a registered trademark of Meta Integration Technologies, Inc. in the United States.

Portions of this product include software developed by the Apache Software Foundation. The Apache software is distributed in accordance with the following license agreement.

Apache License

Version 2.0, January 2004

http://www.apache.org/licenses/

TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION

1. Definitions.

"License" shall mean the terms and conditions for use, reproduction, and distribution as defined by Sections 1 through 9 of this document.

"Licensor" shall mean the copyright owner or entity authorized by the copyright owner that is granting the License.

"Legal Entity" shall mean the union of the acting entity and all other entities that control, are controlled by, or are under common control with that entity. For the purposes of this definition, "control" means (i) the power, direct or indirect, to cause the direction or management of such entity, whether by contract or otherwise, or (ii) ownership of fifty percent (50%) or more of the outstanding shares, or (iii) beneficial ownership of such entity.
"You" (or "Your") shall mean an individual or Legal Entity exercising permissions granted by this License.

"Source" form shall mean the preferred form for making modifications, including but not limited to software source code, documentation source, and configuration files.

"Object" form shall mean any form resulting from mechanical transformation or translation of a Source form, including but not limited to compiled object code, generated documentation, and conversions to other media types.

"Work" shall mean the work of authorship, whether in Source or Object form, made available under the License, as indicated by a copyright notice that is included in or attached to the work (an example is provided in the Appendix below).

"Derivative Works" shall mean any work, whether in Source or Object form, that is based on (or derived from) the Work and for which the editorial revisions, annotations, elaborations, or other modifications represent, as a whole, an original work of authorship. For the purposes of this License, Derivative Works shall not include works that remain separable from, or merely link (or bind by name) to the interfaces of, the Work and Derivative Works thereof.

"Contribution" shall mean any work of authorship, including the original version of the Work and any modifications or additions to that Work or Derivative Works thereof, that is intentionally submitted to Licensor for inclusion in the Work by the copyright owner or by an individual or Legal Entity authorized to submit on behalf of the copyright owner. For the purposes of this definition, "submitted" means any form of electronic, verbal, or written communication sent to the Licensor or its representatives, including but not limited to communication on electronic mailing lists, source code control systems, and issue tracking systems that are managed by, or on behalf of, the Licensor for the purpose of discussing and improving the Work, but excluding communication that is conspicuously marked or otherwise designated in writing by the copyright owner as "Not a Contribution."

"Contributor" shall mean Licensor and any individual or Legal Entity on behalf of whom a Contribution has been received by Licensor and subsequently incorporated within the Work.

2. Grant of Copyright License. Subject to the terms and conditions of this License, each Contributor hereby grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable copyright license to reproduce, prepare Derivative Works of, publicly display, publicly perform, sublicense, and distribute the Work and such Derivative Works in Source or Object form.
3. Grant of Patent License. Subject to the terms and conditions of this License, each Contributor hereby grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable (except as stated in this section) patent license to make, have made, use, offer to sell, sell, import, and otherwise transfer the Work, where such license applies only to those patent claims licensable by such Contributor that are necessarily infringed by their Contribution(s) alone or by combination of their Contribution(s) with the Work to which such Contribution(s) was submitted. If You institute patent litigation against any entity (including a cross-claim or counterclaim in a lawsuit) alleging that the Work or a Contribution incorporated within the Work constitutes direct or contributory patent infringement, then any patent licenses granted to You under this License for that Work shall terminate as of the date such litigation is filed.

4. Redistribution. You may reproduce and distribute copies of the Work or Derivative Works thereof in any medium, with or without modifications, and in Source or Object form, provided that You meet the following conditions:

(a) You must give any other recipients of the Work or Derivative Works a copy of this License; and

(b) You must cause any modified files to carry prominent notices stating that You changed the files; and

(c) You must retain, in the Source form of any Derivative Works that You distribute, all copyright, patent, trademark, and attribution notices from the Source form of the Work, excluding those notices that do not pertain to any part of the Derivative Works; and

(d) If the Work includes a "NOTICE" text file as part of its distribution, then any Derivative Works that You distribute must include a readable copy of the attribution notices contained within such NOTICE file, excluding those notices that do not pertain to any part of the Derivative Works, in at least one of the following places: within a NOTICE text file distributed as part of the Derivative Works; within the Source form or documentation, if provided along with the Derivative Works; or, within a display generated by the Derivative Works, if and wherever such third-party notices normally appear. The contents of the NOTICE file are for informational purposes only and do not modify the License. You may add Your own attribution notices within Derivative Works that You distribute, alongside or as an addendum to the NOTICE text from the Work, provided that such additional attribution notices cannot be construed as modifying the License.

You may add Your own copyright statement to Your modifications and may provide additional or different license terms and conditions for use, reproduction, or distribution of Your modifications, or for any such Derivative Works as a whole, provided Your use, reproduction, and distribution of the Work otherwise complies with the conditions stated in this License.
5. Submission of Contributions. Unless You explicitly state otherwise, any Contribution intentionally submitted for inclusion in the Work by You to the Licensor shall be under the terms and conditions of this License, without any additional terms or conditions. Notwithstanding the above, nothing herein shall supersede or modify the terms of any separate license agreement you may have executed with Licensor regarding such Contributions.

6. Trademarks. This License does not grant permission to use the trade names, trademarks, service marks, or product names of the Licensor, except as required for reasonable and customary use in describing the origin of the Work and reproducing the content of the NOTICE file.

7. Disclaimer of Warranty. Unless required by applicable law or agreed to in writing, Licensor provides the Work (and each Contributor provides its Contributions) on an "AS IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied, including, without limitation, any warranties or conditions of TITLE, NON-INFRINGEMENT, MERCHANTABILITY, or FITNESS FOR A PARTICULAR PURPOSE. You are solely responsible for determining the appropriateness of using or redistributing the Work and assume any risks associated with Your exercise of permissions under this License.

8. Limitation of Liability. In no event and under no legal theory, whether in tort (including negligence), contract, or otherwise, unless required by applicable law (such as deliberate and grossly negligent acts) or agreed to in writing, shall any Contributor be liable to You for damages, including any direct, indirect, special, incidental, or consequential damages of any character arising as a result of this License or out of the use or inability to use the Work (including but not limited to damages for loss of goodwill, work stoppage, computer failure or malfunction, or any and all other commercial damages or losses), even if such Contributor has been advised of the possibility of such damages.

9. Accepting Warranty or Additional Liability. While redistributing the Work or Derivative Works thereof, You may choose to offer, and charge a fee for, acceptance of support, warranty, indemnity, or other liability obligations and/or rights consistent with this License. However, in accepting such obligations, You may act only on Your own behalf and on Your sole responsibility, not on behalf of any other Contributor, and only if You agree to indemnify, defend, and hold each Contributor harmless for any liability incurred by, or claims asserted against, such Contributor by reason of Your accepting any such warranty or additional liability.
## Table of Supported Bridges

The following table lists the Meta Integration Technology, Inc. (6.2.0) bridges that are currently available in CA ERwin Data Modeler (as of r8):

<table>
<thead>
<tr>
<th>Application</th>
<th>Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>Altova XMLSpy</td>
<td>Export</td>
</tr>
<tr>
<td>Borland Together (via UML 1.x XMI)</td>
<td>Export</td>
</tr>
<tr>
<td>Borland Together (via UML 2.x XMI)</td>
<td>Import</td>
</tr>
<tr>
<td>CA Component Modeler 3.52 (ParadigmPlus)</td>
<td>Import/Export</td>
</tr>
<tr>
<td>CA Component Modeler 4.x (via UML 1.x XMI)</td>
<td>Import/Export</td>
</tr>
<tr>
<td>CA Cool:Biz 5.1</td>
<td>Import</td>
</tr>
<tr>
<td>CA Cool:BusinessTeam (GroundWorks) 2.2.1</td>
<td>Import</td>
</tr>
<tr>
<td>CA Cool:DBA (Terrain for DB2) 5.3.2</td>
<td>Import</td>
</tr>
<tr>
<td>CA Cool:Enterprise (ADW) 2.7</td>
<td>Import</td>
</tr>
<tr>
<td>CA Cool:Xtras Mapper (TerrainMap for DB2)</td>
<td>Import</td>
</tr>
<tr>
<td>CA ERwin 3.x (ERX)</td>
<td>Import/Export</td>
</tr>
<tr>
<td>CA ERwin 4.x Data Modeler</td>
<td>Import</td>
</tr>
<tr>
<td>CA Gen 4.1a to 7.6</td>
<td>Import/Export</td>
</tr>
<tr>
<td>CA Repository for Distributed Systems</td>
<td>Import/Export</td>
</tr>
<tr>
<td>CA Repository for z/OS</td>
<td>Import/Export</td>
</tr>
<tr>
<td>Cobol Copybook Flat Files</td>
<td>Import</td>
</tr>
<tr>
<td>Database Data Definition Language (DDL)</td>
<td>Export</td>
</tr>
<tr>
<td>Embarcadero Describe (via UML 1.x XMI)</td>
<td>Import/Export</td>
</tr>
<tr>
<td>Embarcadero ER/Studio Business Architect (via DM1)</td>
<td>Import/Export</td>
</tr>
<tr>
<td>Embarcadero ER/Studio Data Architect</td>
<td>Import/Export</td>
</tr>
<tr>
<td>EMC ProActivity 3.x &amp; 4.0</td>
<td>Import</td>
</tr>
</tbody>
</table>
# Table of Supported Bridges

<table>
<thead>
<tr>
<th>Application</th>
<th>Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gentleware Poseidon (via UML 1.x XMI)</td>
<td>Import/Export</td>
</tr>
<tr>
<td>Grandite Silverrun-RDM 2.4.4 to 2.8.4</td>
<td>Import</td>
</tr>
<tr>
<td>HP Knightsbridge CDMA</td>
<td>Export</td>
</tr>
<tr>
<td>IBM Cognos BI Reporting - Framework Manager</td>
<td>Import/Export</td>
</tr>
<tr>
<td>IBM Cognos BI Reporting - Framework Manager for ReportNet</td>
<td>Import/Export</td>
</tr>
<tr>
<td>IBM Cognos BI Reporting - QueryStudio</td>
<td>Import</td>
</tr>
<tr>
<td>IBM Cognos BI Reporting - ReportStudio</td>
<td>Import</td>
</tr>
<tr>
<td>IBM Cognos Series 7 Impromptu</td>
<td>Export</td>
</tr>
<tr>
<td>IBM DB2 Warehouse Manager (via CWM XMI)</td>
<td>Import/Export</td>
</tr>
<tr>
<td>IBM InfoSphere Data Architect</td>
<td>Import/Export</td>
</tr>
<tr>
<td>IBM InfoSphere DataStage</td>
<td>Import/Export</td>
</tr>
<tr>
<td>IBM InfoSphere Discovery - Beta bridge</td>
<td>Import</td>
</tr>
<tr>
<td>IBM InfoSphere Discovery (via CWM XMI)</td>
<td>Import</td>
</tr>
<tr>
<td>IBM InfoSphere Warehouse / Cubing Services for OLAP</td>
<td>Import/Export</td>
</tr>
<tr>
<td>IBM InfoSphere Warehouse / InfoSphere Data Architect</td>
<td>Import/Export</td>
</tr>
<tr>
<td>IBM Rational Rose 4.0</td>
<td>Import/Export</td>
</tr>
<tr>
<td>IBM Rational Rose 6.0 (98i) to 6.5 (2000)</td>
<td>Import/Export</td>
</tr>
<tr>
<td>IBM Rational Rose 7.x (2000e and newer)</td>
<td>Import/Export</td>
</tr>
<tr>
<td>IBM Rational Rose XDE Developer (Rose MDL)</td>
<td>Export</td>
</tr>
<tr>
<td>IBM Rational Software Architect RSA (Rose MDL)</td>
<td>Export</td>
</tr>
<tr>
<td>IBM Rational Software Architect RSA (via UML 2.x XMI)</td>
<td>Import</td>
</tr>
<tr>
<td>IBM Rational Software Modeler RSM (Rose MDL)</td>
<td>Export</td>
</tr>
<tr>
<td>IBM Rational System Architect 7.1 to 11.x (File)</td>
<td>Import/Export</td>
</tr>
<tr>
<td>IBM Rational System Architect 10.4 to 11.x (Encyclopedia)</td>
<td>Import/Export</td>
</tr>
<tr>
<td>IBM Telelogic Tau (via UML 1.x XMI)</td>
<td>Import/Export</td>
</tr>
<tr>
<td>Informatica Data Analyzer</td>
<td>Export</td>
</tr>
<tr>
<td>Informatica Developer - Beta bridge</td>
<td>Import/Export</td>
</tr>
<tr>
<td>Informatica Metadata Manager</td>
<td>Export</td>
</tr>
<tr>
<td>Informatica Metadata Manager (MIR XMI)</td>
<td>Export</td>
</tr>
<tr>
<td>Informatica PowerCenter</td>
<td>Export</td>
</tr>
<tr>
<td>Application</td>
<td>Mode</td>
</tr>
<tr>
<td>-----------------------------------------------------</td>
<td>--------------</td>
</tr>
<tr>
<td>Informatica PowerCenter (File)</td>
<td>Import</td>
</tr>
<tr>
<td>IRI CoSORT (RowGen) Data Definition File</td>
<td>Export</td>
</tr>
<tr>
<td>IRI CoSORT (SortCL) Data Definition File</td>
<td>Export</td>
</tr>
<tr>
<td>Kalido DIW</td>
<td>Import</td>
</tr>
<tr>
<td>Meta Integration Business Rules</td>
<td>Export</td>
</tr>
<tr>
<td>Meta Integration Repository (MIR) XMI Business Glossary</td>
<td>Export</td>
</tr>
<tr>
<td>Meta Integration Repository (MIR) XMI file</td>
<td>Import/Export</td>
</tr>
<tr>
<td>Meta Integration Repository (MIR) XMI multimodel content</td>
<td>Import/Export</td>
</tr>
<tr>
<td>Microsoft Office Excel</td>
<td>Import/Export</td>
</tr>
<tr>
<td>Microsoft Office Excel (multi-model)</td>
<td>Import</td>
</tr>
<tr>
<td>Microsoft Office Visio Database (via ERX)</td>
<td>Import/Export</td>
</tr>
<tr>
<td>Microsoft Office Visio UML (via UML XMI)</td>
<td>Import</td>
</tr>
<tr>
<td>Microsoft SQL Server Analysis Services (via DSV File)</td>
<td>Import/Export</td>
</tr>
<tr>
<td>Microsoft SQL Server Analysis Services 2005 to 2008 (File)</td>
<td>Import</td>
</tr>
<tr>
<td>Microsoft SQL Server Data Source View</td>
<td>Import/Export</td>
</tr>
<tr>
<td>Microsoft SQL Server Integration Services</td>
<td>Export</td>
</tr>
<tr>
<td>Microsoft SQL Server Integration Services (via DSV File)</td>
<td>Import/Export</td>
</tr>
<tr>
<td>Microsoft SQL Server Integration Services (Project)</td>
<td>Export</td>
</tr>
<tr>
<td>Microsoft SQL Server Integration Services (File)</td>
<td>Import</td>
</tr>
<tr>
<td>Microsoft SQL Server Reporting Services (File)</td>
<td>Import</td>
</tr>
<tr>
<td>Microsoft SQL Server Repository 2.1b (via XIF)</td>
<td>Import/Export</td>
</tr>
<tr>
<td>Microsoft SQL Server Repository 3.x (via MDC)</td>
<td>Import/Export</td>
</tr>
<tr>
<td>Microsoft SQL Server XML Data Reduced (XDR) Schema</td>
<td>Import</td>
</tr>
<tr>
<td>Microsoft Visual Studio/Modeler 2.0 (via MDL)</td>
<td>Import/Export</td>
</tr>
<tr>
<td>MicroStrategy 7.0 to 9.0</td>
<td>Import</td>
</tr>
<tr>
<td>NoMagic MagicDraw (via UML 1.x XMI)</td>
<td>Import/Export</td>
</tr>
<tr>
<td>OMG CWM 1.x XMI 1.x</td>
<td>Import/Export</td>
</tr>
<tr>
<td>OMG CWM Pre-1.0 XMI 1.1</td>
<td>Import/Export</td>
</tr>
<tr>
<td>OMG UML 1.x XMI 1.x</td>
<td>Import/Export</td>
</tr>
<tr>
<td>OMG UML 2.x XMI 2.x</td>
<td>Import</td>
</tr>
</tbody>
</table>
## Table of Supported Bridges

<table>
<thead>
<tr>
<th>Application</th>
<th>Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Text eDOCS Data Integration (Hummingbird) Genio</td>
<td>Import/Export</td>
</tr>
<tr>
<td>Oracle Business Intelligence Answers</td>
<td>Import</td>
</tr>
<tr>
<td>Oracle Business Intelligence Server</td>
<td>Import</td>
</tr>
<tr>
<td>Oracle Data Integrator</td>
<td>Import/Export</td>
</tr>
<tr>
<td>Oracle Designer</td>
<td>Import/Export</td>
</tr>
<tr>
<td>Oracle Hyperion Application Builder (via CWM XMI)</td>
<td>Import/Export</td>
</tr>
<tr>
<td>Oracle Hyperion Essbase Integration Services</td>
<td>Import/Export</td>
</tr>
<tr>
<td>Oracle Warehouse Builder</td>
<td>Import/Export</td>
</tr>
<tr>
<td>Oracle Warehouse Builder (via CWM XMI)</td>
<td>Import/Export</td>
</tr>
<tr>
<td>SAP Business Objects Crystal Reports XI (File)</td>
<td>Import</td>
</tr>
<tr>
<td>SAP Business Objects Data Integrator</td>
<td>Import/Export</td>
</tr>
<tr>
<td>SAP Business Objects Designer (File)</td>
<td>Import/Export</td>
</tr>
<tr>
<td>SAP Business Objects Desktop Intelligence (File)</td>
<td>Import</td>
</tr>
<tr>
<td>SAP Business Objects Metadata Manager (via MIR XMI)</td>
<td>Export</td>
</tr>
<tr>
<td>SAP NetWeaver Master Data Management (MDM)</td>
<td>Import/Export</td>
</tr>
<tr>
<td>SAS Data Integration Studio (via CWM XMI)</td>
<td>Import/Export</td>
</tr>
<tr>
<td>SAS Data Integration Studio (via MIR XMI)</td>
<td>Import/Export</td>
</tr>
<tr>
<td>SAS Information Map Studio (via MIR XMI)</td>
<td>Import/Export</td>
</tr>
<tr>
<td>SAS Management Console (via MIR XMI)</td>
<td>Import/Export</td>
</tr>
<tr>
<td>SAS Metadata Management (via MIR XMI)</td>
<td>Import</td>
</tr>
<tr>
<td>Select SE</td>
<td>Import</td>
</tr>
<tr>
<td>Sparx Enterprise Architect (EA) (via UML 1.x XMI)</td>
<td>Import/Export</td>
</tr>
<tr>
<td>Sparx Enterprise Architect (EA) (via UML 2.x XMI)</td>
<td>Import</td>
</tr>
<tr>
<td>Sybase PowerDesigner 7.0 (ERX)</td>
<td>Export</td>
</tr>
<tr>
<td>Sybase PowerDesigner CDM 6.x</td>
<td>Import</td>
</tr>
<tr>
<td>Sybase PowerDesigner CDM 7.5 to 15.x</td>
<td>Import</td>
</tr>
<tr>
<td>Sybase PowerDesigner CDM 8.0 to 15.x</td>
<td>Export</td>
</tr>
<tr>
<td>Sybase PowerDesigner OOM 9.x to 15.x (via UML 1.x XMI)</td>
<td>Import/Export</td>
</tr>
<tr>
<td>Sybase PowerDesigner PDM 6.1.x</td>
<td>Import</td>
</tr>
<tr>
<td>Sybase PowerDesigner PDM 7.5 to 15.x</td>
<td>Import</td>
</tr>
<tr>
<td>Application</td>
<td>Mode</td>
</tr>
<tr>
<td>-------------</td>
<td>---------</td>
</tr>
<tr>
<td>Sybase PowerDesigner PDM 8.x to 15.x</td>
<td>Export</td>
</tr>
<tr>
<td>Sybase PowerDesigner XSM 10.x to 15.x</td>
<td>Export</td>
</tr>
<tr>
<td>Tigris ArgoUML (via UML 1.x XMI)</td>
<td>Import/Export</td>
</tr>
<tr>
<td>Visible IE:Advantage 6.1</td>
<td>Import</td>
</tr>
<tr>
<td>W3C XML DTD 1.0</td>
<td>Import</td>
</tr>
<tr>
<td>W3C XML Schema 1.0 (XSD)</td>
<td>Import/Export</td>
</tr>
</tbody>
</table>

**Note:** For information about how to use the metadata integration wizards, see the CA ERwin Data Modeler online help.
Index

A
action log
  action summary reports • 76
details pane • 66
find text • 69
metamodel filter • 70
overview • 66
redo a transaction • 73
redo to a selected transaction • 73
report • 76
reverse a transaction • 73
shortcut menu • 68
summary pane • 67
tasks • 68
undo a transaction • 72
undo to a selected transaction • 73
use extended find and filter • 70
view property details • 72
action summary reports
  action log • 76
advisories pane • 77
alter scripts
  schema generation • 120
alter scripts, complete compare • 151
alternate key index • 110
attributes
  add • 25
defined • 19
C
columns, defined • 19
complete compare
  alter scripts • 151
  filter selection • 137
  identify differences • 148
  identify matches • 148
  known differences snapshot • 149
  model saving • 152
  model selection • 132
  object selection • 137
  option set customization • 153
  overview • 131
  properties selection • 137
  report • 156
  resolve differences • 142, 148
session save • 155
wizard • 132
D
data warehouse hierarchy • 170
datatype
  assign • 94
datatype mapping file (.dsm) • 204
datatype mapping list • 203
datatype mapping standards
  attach file to a model • 205
define • 204
reuse • 205
datatype standards editor
  datatype mapping list • 203
overview • 202
datatype standards editor
data type
  mapping list • 203, 204
save datatype mapping file • 204
dependent entities • 18
derive new model
  process • 171
wizard • 171
design layer
  conceptual logical data model • 168
create, overview • 170
database-specific physical data model • 169
first design layer • 168
generic physical data model • 168
overview • 167
second design layer • 168
third design layer • 169
working with • 168
details pane
  action log • 66
differences, identify in complete compare • 148
display levels
  logical display • 102
overview • 102
physical display • 104
domain
  create • 91
datatype • 94
icons • 95
inheritable properties • 91
non-inheritable properties • 91
overview • 89
domain dictionary
overview • 90

E
enterprise model hierarchy • 169
entities
add • 24
defined • 17
dependent • 18
independent • 18
name • 24
entity relationships • 96
export to external format • 130
extended find and filter
action log • 70

F
find and replace • 114
find, extended and filter • 70
first design layer • 168
footers and headers, customize • 45
foreign key • 20
foreign key index • 110
forward engineering
change schema generation • 117
generate the schema • 119
overview • 115
preview schema generation • 116
schema generation options • 118

H
headers and footers, customize • 45
hierarchy
data warehouse • 170
toolbar • 59
toolbar • 59
enterprise model • 169
history, preserving model • 191

I
import from external format • 128
independence entities • 18
index types
alternate key • 110
foreign key • 110
inversion entry key • 110
primary key • 110
indexes
create • 112
editor • 112
non-unique • 110
overview • 109
unique • 110
inheritable properties, domains • 91
Installation
license agreement • 13
prerequisites • 12
procedure • 13
inversion entry key index • 110

K
key
foreign • 20
non-key • 20
primary • 20

L
license agreement • 13
logical model • 16
logical/physical model • 16

M
matches, identify in complete compare • 148
metadata integration • 127
model
create • 23
name • 23
save • 26
model datatype options dialog • 204
model explorer
add domain, overview • 61
add model source, overview • 61
copy objects • 61
create a new object • 59
delete objects • 61
go to an object • 60
model view • 62
move objects • 61
overview • 57
property editor • 60
rename an object • 59
shortcut menu • 58
subject view • 62
toolbar • 59
model history, preserving • 191
model naming options dialog • 195
model selection, complete compare • 132
model source
  add, overview • 61, 173
  defined • 173
  link • 174
  properties • 174
  sync with model source wizard • 175
model types
  logical • 16
  logical/physical • 16
  physical • 16
model view
  model explorer • 62

naming standards
  define • 195
  editor • 196
  name compliance • 198
  name hardening • 199
  object name syntax • 197
  overview • 195
non-inheritable properties, domains • 91
non-key • 20
non-unique index • 110

option set, customize in complete compare • 153

physical model • 16
primary key • 20
primary key index • 110
print
  customize headers and footers • 45
property details
  action log • 72
property editor • 60

redo a transaction
  action log • 73
redo to a selected transaction
  action log • 73
  exercise • 75
redo to this point
  exercise • 75

relationship types
  identifying • 22
  non-identifying • 22
  other • 97
relationships • 21, 96
  create • 25
  create, overview • 98
  entity • 96
  foreign key • 99
  lines, overview • 98
  rolenames • 100
  unification • 99
report
  action log • 76
  action summary • 76
  complete compare • 156
  with Crystal Reports • 161
resolve differences
  complete compare • 148
  dialog • 142
reverse a transaction
  action log • 73
reverse engineering
  overview • 121
  set options • 123
  templates • 123
  rolenames • 100

schema generation
  change • 117
  generate alter scripts • 120
  options • 118
  preview • 116
  procedure • 119
  script file, save • 120
second design layer • 168
select tool • 37
shortcut menu
  action log • 68
  model explorer • 58
spanning neighborhoods, subject area • 108
split logical/physical model
  procedure • 170
standards
  datatype • 202
subject areas
  create, overview • 106
overview • 105
spanning neighborhoods • 108
subject view
  model explorer • 62
summary pane
  action log • 67

T

tables • 18
third design layer • 169
toolbar
  alignment • 37, 50
  drawing • 39, 51
  hide • 49
  model explorer • 59
  services • 53
  show • 49
  transform • 178
toolbox • 54
transform
  default options • 179
  design decision, defined • 176
  overview • 176
  toolbar • 178
  wizard, overview • 177

U

undo a transaction
  action log • 72
undo to a selected transaction
  action log • 73
  exercise • 74
undo/reverse comparison table • 75
unification • 20
unique index • 110
unique name rules • 60

V

views
  adding • 102
  overview • 101

W

workplace panes • 55